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Overview
This guide describes the features and capabilities of the Reporting module in Security Analytics.
The Reporting module pulls Security Analytics rules into a single view to define, schedule and
view reports.

The Reporting module enables you to create, manage and view the following:

l Rules

l Reports

l Charts

l Alerts

l Lists

l Warehouse Analytics

Note: The Reporting Engine (RE) will automatically check for the available disk space before
you execute a Rule, Report, Chart and Alert. If the RE disk space (in percentage) is less than
the minimum disk space threshold (default value is 5), the RE will stop the current execution
and an error message 'Available disk space of Reporting engine home is <5%, please clean up
the space to proceed further' is displayed. Additionally, you may also configure the minimum
disk space threshold by using the following path:
RE>Explore>com.rsa.soc.re>Configuration>CommonConfig>minDiskSpaceThreshold.

You can navigate to different sections (labeled in the figure below) from the Reporting UI. 
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It uses the Tabbed UI approach where each of the tasks (create, edit, schedule, view) when
clicked loads a new tab without having to open multiple windows for each of the different
tasks. You can report and alert on the log and packet data collected, and customize the reports
and charts to enhance the visual appearance. You can create real-time reports for historical
data. You can create charts and dashlets, that can be added in the real-time
chart dashlets aswell.

The Reporting module relies on the Reporting Engine to provide data for the reports, alerts and
charts. Hence, you must configure the Reporting Engine before you can generate the reports.
You must also specify the data source in the Reporting Engine from which the data is extracted.

The following table points to the tasks that must be performed on the Reporting module, in the
order you must perform them:

Note: Make sure you have access to the components in the Reporting module. See Add a Role
and Assign Permissions for Reporting Module.

Step Description

1 Define a Rule.

2 Test a Rule.

3 Define Rule Groups and Rules based on how to Create a Report Using a Rule.

4 Prerequisites.

5 Prerequisites.

6 Create a Chart Using a Rule.

7 Create an Alert Using a Rule.

8 Investigate a Report, Investigate a Chart, or Investigate an Alert.

9 Add a List.

10 Define a Job. For details, see the Define a Warehouse Analytics Job in the
Warehouse Analytics Guide.

The data that you can report or alert depends on the configuration of Reporting Engine and the
data sources that you specify as part of the rule definition.
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Note: Make sure you have access to the required data sources. Only privileged users
with access to sensitive information have the permission to certain data sources. To manage
access control to data sources, see the Add a Role and Assign Permissions for Warehouse
Analytics topic in the Warehouse Analytics Guide. However, for the existing reports, alerts
and charts, if the user role or permissions are modified for the data sources, then it is not
applicable unless you manually update the permissions.

The Reporting Engine is a key component that provides data to the Reporting module. You must
add the Reporting Engine as a service to Security Analytics before you generate reports or
alerts. When you run the reports, the results are stored in Reporting Engine.

After you generate a report, you can perform the following:

l Send the reports by email to other users by configuring the output actions. You can also
configure the output actions before generating a report.

l  Download the reports as PDF or Comma-Separated Values (CSV) format files.

Once an alert is created, Security Analytics Incident Management collects this data from the
Reporting Engine and displays these alerts on the Security Analytics User Interface. 

Note: By default, this option is not enabled. If you want to enable this option, you must enable
it from the Reporting Engine Config page.

Note: This module is accessible based on the role based access, defined for the user.

Manage Access for Reporting Module
This section covers the access permissions the user can specify for the different objects in the
Reporting module. The Reporting Module provides you the option to set up access control for all
the components in the module. In Security Analytics, you can define different roles and specify
the access control for each of the role from the System Security module. You can define the
access control to be provided for the Reporting module for each role. For more information, see
Step 1: Review Five Pre-Configured Roles and Step 2: (Optional) Add a Role and Assign
Permission in the System Security and User Management Guide.

In the Reports module, you can modify the role permissions or access the following Reporting
objects:

Following is an example of the hierarchy of the object groups, objects, and dependents. This is
an illustration of the Report Groups and Reports hierarchy.
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Report Groups and Reports Hierarchy

Applying Permission for Object Groups

l You must have the Read & Write permission to set the permissions for the Object Group,
Objects, or Dependents. The dependents with “No Access” permission are grayed out and
dependents with “Read-Only” permission are indicated with an icon.

l When you set the permission for the Object Group, the Objects and Dependents in the Object
Group do not inherit the permission automatically. You must select the "Apply these
permissions to sub-groups and <Objects> in this group" option to achieve this. For example, if
you do not want Operators roles to access reports in Report Group A, then you must set the
permission on Group A to No access for the Operator role and select the "Apply these
permissions to sub-groups and Reports in this group" option.

l When you set the permissions for the Object Group and select the "Apply these permissions
to sub-groups and <Objects> in this group" option, the dependents such as rules or schedules
in the objects do not inherit the permissions automatically. You must use the "Apply Read-
only permission to Rules in the <Object>" option to apply the permission to the rules.

l When you set the permissions for the Objects, you must ensure that the Objects in hierarchy
should always have a permission that is less than or equal to the one above in the hierarchy
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for the permission to be applied. For example, if the reports in a Report Group have Read &
Write permission and you apply a Read-Only or No Access permission at the Report Group
level and select the "Apply these permissions to sub-groups and Reports in this group" option,
then the permission on the rules will remain unchanged. 

l The permissions are cascaded from top to down in the hierarchy and not vice-versa. For
example, if you apply a permission to a rule, it does not change the permission of the Report
that contains the rule. 

Applying Permission for Objects or Dependents

l You must have the Read & Write permission to set the permissions for the Objects or
Dependents.

l You can specify the permission for multiple objects at once instead of setting the permission
for each object.

l When you set the permission for the Object, the dependents in the Object do not inherit the
permission automatically. You must select the "Apply Read-only permission to Rules in the
<Object>" option to achieve this.

When you apply the permission to dependents the permission is applied based on the existing
permission for the role. For example, consider an Analyst and a Operator with the following
permissions for the different dependents (Report A object has Rule AA, Rule AB, and Rule AC
as dependents). 

Object or Dependent Analyst Operator

Report A Read & Write No Access

Rule AA Read & Write No Access

Rule AB Read and Write Read and Write

Rule AC Read-only No Access

When the Analyst applies a Read & Write permission for the Operator role and selects the
option "Apply Read-only permission to Rules in the <Object>", then the permissions will be set
for the different dependents as follows: 

Modifying the Permissions

l Group Level: Set the permissions at the Object Group level and for all the object and entities
in the Group. For example, if you have 80 reports in the Administrators Reports group and you
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do not want anyone except the Administrator to add or modify these reports, you can set the
permission for all the other roles at the group level to Read-Only and select the option to
apply it to all the reports and sub-groups in the report group. 

l Multiple Objects: Select multiple objects and specify the access for all the selected objects.
For example, if you have 10 reports in the Network Traffic sub group with sensitive 
information that you do not want anyone to access, select the 10 reports and then set the
permission for all the roles as "No Access".

l Single Object: Select only the object and specify the permission. For example, select the
Network Traffic Report and specify the Read-Write permission for the Security Analyst role
or select the Login Failure Alert and specify the Read-Write permission for a Security
Analyst role.

Object or Depend-

ent

Operator (Before Permission is

applied)

Operator (After Permission is

applied)

Report A No Access Read & Write

Rule AA No Access Read-only

Rule AB Read and Write Read & Write

Rule AC No Access Read-only

Topics

Add a Role and Assign Permissions for Reporting Module

Add a Role and Assign Permissions for Reporting Module
This topic explains how to add a role and assign permissions to the role. Although Security
Analytics has five pre-configured roles, you can add custom roles. For example, in addition to
the pre-configured Analysts role, you can add custom roles
for AnalystsEurope and AnalystsAsia.

Role Permission

Administrators Full system access

Operators Access to configurations but not to data
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Role Permission

Analysts Access to data but not to configurations

SOC_Managers Same access as Analysts and an additional permission to handle incidents

Malware_Analysts Access to malware events only

Depending on the user role, you can set the following access permissions to access the
Reporting module components (Rules, Reports, Charts, Alerts, Lists):

l Define 

l Delete

l Export

l Manage 

l View 

Note: You must enable all these permissions for a user role to be able to define, delete,
manage and view each of the Reporting modules. You must also have appropriate permissions
for the data source to be listed, while defining the reports, charts, or alerts. For more
information, see Configure Permissions for Data sources topic in the Host and Service
Configuration Guide.

For a detailed list of permissions, see Role Permissions topic in the System Security and User
Management Guide. 

Navigate to the Roles Tab

Each of the following procedures starts on the Rolestab. Perform the following steps to navigate
to the Rolestab:

1. In the Security Analytic menu, select Administration > Security.

The System Security panel is displayed with the Users tab highlighted.

2. Click the Role tab.

23 Overview



Reporting Guide

The Roles panel is displayed:

Add a Role and Assign Permissions

1. In the Roles tab, click  in the toolbar.

The Add Role screen is displayed:
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2. In the Role Info section, provide the role information for the following:

l Name

l (Optional) Description

3. In the Permissions section:

l Click   and   to scroll through the modules.

l Select the Reports module the role accesses.

l Select each permission the role has.

4. Repeat the previous step until you select all permissions to assign to the role.

5. Click Saveto add the new role, which is effective immediately. You can now assign the new
role to users.

Reporting Guidelines
This topic lists the RSA recommended guidelines to enhance the execution time of your
reporting entities. This topic lists the RSA recommended guidelines to enhance the execution
time of your reporting entities such as rules, reports, alerts, charts, and lists. The guidelines are
provided for the following:
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l NWDB Rules

l Timeout Configuration for NWDB Rules

l Lookup and Add rule action

l List value Reports

NWDB Rules

If the reporting entities such as report, alert, or chart contain NWDB rules (in most cases where
the query contains Group By) takes a long time to execute, you may do the following: 

1. Refine the WHERE Clause: 
You may limit the number of sessions scanned by using or refining the WHERE clause
(especially when you use the Group By option). For example, consider the following rule.
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If you use a WHERE clause as mentioned above, the number of sessions aggregated is
huge. To avoid this, you can filter only required sessions by specifying the list of IP
addresses or creating a List (List of IP Address) that contains relevant IP addresses.
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2. Using indexed META keys in the WHERE clause:
To understand if the META is indexed or not, mouse hover the META key. If the Value
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Type is INDEX_VALUE, then the META is indexed. The Value Type is INDEX_KEY or
INDEX_NONE if the META is not indexed. 

Below is a snapshot of a META key that is indexed.

3. Configure the Timeout option:
If the query is taking a long time and fails due to timeout issues, you can configure the
timeout for the NWDB rule executions. For more information, see below section Timeout
Configuration for NWDB Rules.

4. Schedule the queries to run at different times:
If multiple query aggregates are concurrently executed and timeout occurs, you may
schedule the queries to run at different times without much overlap. 

Timeout Configuration for NWDB Rules

Note: It is a good practice to check the statistics of the Reporting Engine and the NWDB data
sources before you make any changes to the configuration. For more information, see the
Monitor Appliances and Services topic for Reporting Engine and Monitor System Statistics
topic in the in the System Maintenance Guide. 
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If NWDB rule execution fails due to timeout, you may get the following errors on the View a
Report page: 

l Reporting Engine timeout error

l “Data source ‘10.31.x.x Concentrator' did not respond within the configured time 30
minutes for the ‘/sdk/values' request.” 

l NWDB timeout error

l "Error occurred while fetching data from source '10.31.x.x Concentrator'.
{Timeout message from NWDB}”.

l In such cases, you may do the following:

l l Reporting Engine timeout 
In case of Reporting Engine timeout, you may set the timeout to a longer duration so the
long running queries can be executed. For more information on setting the NWDB Queries

Time Out and NWDB Info Queries Time Out option for the Reporting Engine, see
Configure Reporting Engine Settings topic in the Host and Services Configuration Guide.
RSA recommends you set the NWDB Query Time Out to zero minutes (implies no
timeout) and NWDB Info Queries Time Out to 60 minutes. 

l NWDB timeout 
In case of NWDB timeout, you may need to configure the query.level.timeout and
max.concurrent.queries parameters for the NWDB data source based on the
recommendations in the Database Tuning topic in the Host and Services Configuration
Guide to fine tune the queries.

Following is the snapshot of the Explorer view where you can set the parameters for
NWDB data source. 

Overview 30



Reporting Guide

31 Overview



Reporting Guide

l Schedule Reports at different times
If the NWDB core devices are heavily utilized, you may schedule the reports to run at
different times without overlap. 

l Split the Report
If you have many rules in a Report, split the report into multiple reports with each report
containing logical set of rules. If you have multiple rules, all rules will begin to execute at
the same time based on available threads, therefore you may group the rules logically into
separate reports. 

LookupAndAdd Rule Action

If a rule that consists of single or multiple lookup_and_add rule actions, takes a long time to
execute the report, it is because each of the rule action triggers multiple lookup queries on the
NWDB data source resulting in longer execution time.

To improve the report execution time, you may do the following:  

l Refine the WHERE clause in the following:

l Rule that contains the lookup_and_add rule action

l lookup_and_add rule action

l Set Limits
You must set appropriate limits for the rule and rule actions. If the limit is high it will result
in many queries being triggered and hence the report will take a long time to execute. 

l Set the boolean aggregate parameter

If you do not want the aggregate value such as sum(meta), count(meta) etc. for the
lookup values, set the boolean aggregate parameter to false in the lookup_and_add rule
action. For more information, see the NWDB Rule Syntax.

lookup_and_add(string select, string field, int limit, boolean
inherit, string extraWhere, boolean aggregate)

Consider the rule with lookup_and_add rule action:
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The output is displayed:
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l Each lookup_and_add rule action triggers by default two concurrent lookup queries on the
data source. RSA recommends that you retain the default setting, however if you want to
increase the value you may want to ensure the value of Max # of Concurrent

LookupAndAdd Queries parameter in Reporting Engine is less than the Max Concurrent

Queries value in the NWDB data source configuration.
If the NWDB data source is shared across other services, then you may retain a low value
for the Max # of Concurrent LookupAndAdd Queries parameter in Reporting Engine
as increasing it will impact the queries from other services. For more information, see
Reporting Engine General Tab topic in Host and Services Configuration Guide. 

l If you are interested only in unique values and not accurate aggregates, then set the Session
Threshold to a non-zero value for the NWDB rule. For more information,
see Prerequisites. The higher the value, the longer is the rule execution. If the value is set to
zero it will take a longer time but will provide accurate aggregates. 
Consider a rule with lookup_and_add rule action and Session Threshold set to 10.
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The output is displayed:

35 Overview



Reporting Guide

List Value Reports

Use a Refined List:

In case of List value reports (for any data source type), individual reports will be generated for
each value in the list. Therefore, more the number of values in the list the longer the reports will
take to execute. Hence, you must use a refined list to generate such reports. 

Search Reporting Details

This topic provides instructions on how to perform a keyword search on name and content for
each of the Reporting components. You can perform a keyword search on name and content for
each of the Reporting components (Rule/Report/Chart/Alert/List) on the Reporting UI. 

Note: You cannot search based on date and numeric values. 

The following figure shows the search parameters available in the Reporting Module:
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The following are the search parameters available on the Reporting UI:

1. Search for entities (rule, report, chart, alert, list).

2. Search for the entities based on either the name or content.

Note: Searches are case insensitive. For example, Completed is equivalent to completed.

Prerequisites

In the Reporting Module, you can perform a keyword search based on the name and content
(definition). In this context, content implies definition of each of the reporting components. For
instance, the value defined in the rule, report, report schedule, chart, and alert panel. You can
also prioritize your search by selecting either or all of the components: Rule, Report, Chart,
Alert, or List.

Note: You cannot search based on the List values and list path stored in schedule definition
panel.

For example, to search for the rule name (ExpertRule), you must select Rule, Name, and
Content in the filtering options drop-down to view all the rule names that matched the search.
You can similarly search for a report, chart, alert, or list definition. 

Procedure

Perform the following steps to search for reporting details from the Manage tab:

1. In the Security Analytics menu, click Administration > Reports.

The Manage tab is displayed.

2. Click  and select the appropriate criteria to search.
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3. In the Search field, enter the text to be searched.
The search drop-down list is displayed:

Search Syntax and Different Types of Search 

The following table explains the search syntax and the possible searches that can be performed
on the Reporting UI.
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Search Types Description

Word or phrase based

search

Word Based Search:

To search for a word such as "action" or "meta", you must enter
the word in the search box.

The following figure shows the search results for the text action.

Phrase based search:

A Phrase is a group of words surrounded by double quotes such as
"action meta". To search for a phrase, you must enclose phrases in
double-quotes in the search box.

The following figure shows the search results for the phrase
"action meta".
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Search Types Description

Wildcard Search (Single/

Multiple/ Special Char-

acter Search)

The question mark

"?" symbol is used to per-

form a single character

wild card search and

asterisk "*" symbol is

used to perform multiple

character wildcard

search.

Single character search:

The single character wildcard search looks for terms that match

with the single character replaced. For example, to search for

"Expert" or "Export" you can use the search syntax: 

Exp?rt

The following figure shows the search results for the wildcard

character Exp?rt.

Multiple character search:

Multiple character wildcard search looks for 0 or more characters.

For example, to search for Expert, or Experts, you can use the

search syntax: 

Expert*

The following figure shows the search results for the wildcard mul-
tiple character Expert*.
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Search Types Description

Special character search:

Certain punctuation and special characters are ignored during

search (@#$%^&*(){}"~=+-[]\?|!:,.). For example, a search for

action-login will be interpreted during search as "action" "login",

that is, if rules exist with name "action-login" and "action@login"

and search string is "action-login", the search result will return

both the rules.
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Search Types Description

Search based on name or

content

Search based on name:
When you want to search based on the name of a report,
select Reportand Namebox from the filtering options drop-down.
For example, to search for the report name "Report With Multiple
Rules", you can use the search syntax:

"Access to Compliance Data"

Note:When you search for a report, it implies you can search
for the report schedules as well.

The search result will return the report containing the specific
name.

Search based on content:

When you want to search for the content within an alert, say alert
description, select Alert and Content box from the filtering
options drop-down. For example, to search for the alert description
"Device IP Got Detected", you can use the search syntax:

"Device IP Got Detected"

The search will return the result having the specific content.
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Search Types Description

Next steps

Perform one of the following tasks:

1. You can edit a rule, report, chart, alert and list from the appropriate panels.

2. You can schedule a report from the Prerequisites view.

3. You can test a chart from the Test a Chart view.

Troubleshooting
This topic provides troubleshooting instructions for issues faced when using the Reporting
module in Security Analytics.

Troubleshooting Issues Before Configuring SFTP Server.

This section provides troubleshooting instructions for issues faced before configuring SFTP
server.

Procedure

Try the following steps if you face any issues with configured Linux SFTP server:

1. If the Report Output Action for the configured SFTP fails, you must SSH to the SFTP server
and try to connect locally to check if SFTP is working fine.

Connect to SFTP server:

2. If the Local connection fails, open the file sshd_config> vi /etc/ssh/sshd_config.
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3. Check for the entry in the file:

# override default of no subsystems
Subsystem sftp /usr/libexec/openssh/sftp-server

4. If this entry does not exist, add the two lines mentioned in Step 3 at the bottom of the file and
Save it.

5. Restart service from SSH > service sshd restart.

6. Retry the SFTP connection now.

7. Make sure SFTP port is not blocked by SA server appliance firewall. Update iptables rules
to allow sftp port

Definitions:

Strict parser: Strict parser (non-deprecated) expects the query syntax to be type correct.
For all text meta type use quotes for example, username = ‘user1’.
For all IP Addresses, Ethernet Addresses, and Numeric meta types do not use quotes for
example, service = 80 &&
ip.src = 192.168.1.1.
For date and time meta types,
If the date and time format is 'YYYY-MM-DD HH:MM:SS‘, use quotes.
If the date and time format is 1448034064 (number of seconds since EPOCH (Jan 1, 1970)), do
no use quotes.
The reporting queries will be parsed using the strict parser when the configuration value of
/sdk/config/query.parse is strictin NWDB core services. 

Non Strict parser:Non strict parser (deprecated) does not expect the query syntax to be type
correct .i.e the values for text and numeric meta types can be quoted or unquoted regardless of
the meta type.

For example, username is a string meta type, hence its values can be quoted or unquoted. So,
both the syntax username = ‘user1’ and username = user are valid. 

The reporting queries will be parsed using the non strict parser when the configuration value of
/sdk/config/query.parse is deprecatedin NWDB core services.

Note: The troubleshooting procedure for strict parser mode is applicable for Reporting Engine
10.6 and later.

Troubleshooting NWDB Rule Syntax On Fresh Installation

On fresh installation of Security Analytics 10.6, NWDB core services use strict parser (non-
deprecated mode) by default for reporting queries. Hence, RSA recommends that you create
rules that adhere to strict parser (non-deprecated mode) syntax. For more information on NWDB
query syntax, see NWDB Rule Syntax.
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Troubleshooting NWDB Rule Syntax On Upgrade

In case of upgrade from Security Analytics 10.4.x or 10.5.x to Security Analytics 10.6.x, the
NWDB core services continue to use non strict parser (deprecated mode) for reporting engine
queries. Hence, the existing queries continue to execute successfully even if they do not adhere
to strict parser syntax and give results similar to previous versions. RSA recommends that you
create rules that adhere to strict parser syntax.

The use of strict (non-deprecated mode) or non strict (deprecated mode) parser by NWDB core
services for reporting queries is controlled by /sdk/config/query.parse (Administration > Services
> Select a service (NWDB core service) and in the Actions menu, select View > Explore).

If you plan to add a new NWDB core appliance on which Reporting Engine query
is executed, to an existing infrastructure running in non strict (deprecated mode), you can update
the config /sdk/config/query.parse (Administration > Services > Select a service (NWDB core
service) and in the Actions menu, select View > Explore) to non strict mode (deprecated
mode) for the new appliance, until the whole instance of Security Analytics and associated
services has moved to strict mode.

Troubleshooting Import Rules

This section provide troubleshooting instructions for issues faced while importing
rules, report, chart, and alerts which are exported from 10.4.x or 10.5.x and imported in 10.6.

Procedure

1. Log in to Security Analytics.

2. Navigate to Administration >Reports>Manage > Rules

3. Click Rule Operations> Import
The Import Rule window is displayed.

When Reporting Engine 10.4.x or 10.5.x rules are imported to Reporting Engine 10.6.x or when
live rules are deployed, the rules may contain syntax errors. The execution of such rules fail
with an error message, for example, "Error occured while fetching data from source
"Concentrator - Concentrator [10.0.0.0]'. Error details: rule syntax error: expecting
<IPv4 address> here: "'172.15.0.0'|| eth.src=00:13:C3:3B:BE:00)".
You have to correct the rule syntax based on the error message displayed or switch the core
device to work in non strict mode (deprecated mode).
For example, 
For all text meta type use quotes for example, username = ‘user1’.
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Rule Overview
This topic provides a brief description about a rule. A rule is the basic and essential building
block in the Reporting module. You must create a rule which can be used in a Report, Chart or
Alert.

Building Blocks of a Rule

A rule represents a unique query that detects and summarizes the requested information within a
collection of network data. For example, you can write a rule to view the top 20 web addresses
your users visit daily or a rule to detect the presence of clear text authentication to their high
valued assets.

The rule syntax is very similar to that of Standard Query Language (SQL) where you can use the
SELECT clause, WHERE clause, sort and group options and limits for the result set. A rule
consists of the following:

Property Description Example

Name The name of the rule. Windows System Account Activity

Select List of meta types that are returned in the

result set. The list of meta types is

provided in the Meta Library. Meta

Library in the Rule Builder is continually

synchronized with the index con-

figuration of the Security Analytics host

to which {SA}} is connected. The num-

ber of meta types that this property can

represent depends on how the rule is to

be sorted. If the Sort by property is

'None' or non-aggregate, a rule can have

more than one select field, for example,

for each match, include the ip.src, ip.dst,

size, time in the rule result. If a rule is

set to be sorted, either by session count,

session size, or packet size, then there

can only be one field on which to select.
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Property Description Example

Where A clause that is the base query for the

rule.

alert='cleartext_ftp_pass-

words'

Then

(Rule

Actions)

A series of functions that manipulate the

original result set of a rule in order to

make the output in a report more mean-

ingful or add additional functionality

other than querying and displaying data.

lookup_and_add ('user-

name','ip.src',10);

Sort By Determines how the data in the result set
is sorted. The various possibilities are:

l Total

l Value

Total

Limit Designates how large a result set can be

for the given rule. Users must note that if

a result set is sorted by count or size, the

limit represents the top (or bottom) N val-

ues to be returned. If the result set is not

sorted, the first N values are returned.

20

Note: In the User Interface (UI), the date or time displayed depends on the time zone selected
by the user.

IPDB Rule Syntax

This topic describes the supported rule syntax for the IPDB Extractor service through
descriptions and examples of supported and unsupported syntax. There is a finite set of syntax
that you can use to construct rules for reports using the IPDB Extractor service in this release.
This topic contains:

l Descriptions of supported and unsupported syntax with examples.

l Supported aggregate functions.

l Supported operators.

l Sample supported queries. 
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Supported and Unsupported Syntax

When you construct rules that contain SQL queries against the IPDB database in this release,
you must adhere to the descriptions and syntax examples described in the following tables.

Supported Literal (Data) Values Syntax

Description
Examples of Sup-
ported Syntax

For TEXT or string type data, enclose the string or text in single

quote marks. If there is any special character such as apostrophe

(for example 'data'), use two single quotes, ''data'', to enclose the

data value. 

select msg.id where

msg='(Primary) Link

status ''Down'' on inter-

face INTNAME.'

For Date and Time (date/timestamp data type columns), use the

‘yyyy-mmm-dd hh:mm:ss’ syntax.

select time where time =

‘2012-sep-04 13:09:03’

The system supports literal IP addresses.  It treats columns that

contain IP Addresses as strings/text so it uses the string com-

parison operator to evaluate the expressions.

Use the following operators to ensure accurate processing:

l =  (equals)

l !=  (does not equal)

l in (is contained in)

l not in (is not contained in)

Unsupported IN Syntax

Description Examples of Unsupported Syntax

Security Analytics does not support inusage in

IP addresses

select ip.src where ip.src in between 'n.n.n.n'

and 'n.n.n.n'
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Unsupported LIKE Syntax

Description Examples of Unsupported Syntax

Security analytics does not support () for like user.dst not like ('%')

Supported LIST Syntax

Description
Examples of Supported
Syntax

Enclose a list within parentheses in the Whereclause field.

Use the IN operator.

You must enclose values in a list within single quotes except

for the  following values:

l alphanumeric characters

l : (colon)

l _ (underscore)

l . (period)

select ip.src,ip.dst where ip.dst

IN ($[LIST])

Unsupported LIST Syntax

Description Examples of Unsupported Syntax

Do not omit parentheses. select ip.src,ip.dst where ip.dst IN $[LIST]

Do not omit the IN operator. select ip.src,ip.dst where ip.dst =($[LIST])

Supported Variable Syntax

When you assign the value of the variable in a run configuration, you must enclose the value
within single quotes: 'value'.
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Description Examples of Supported Syntax

Insert $ before a variable.

Enclose a variable within braces.

columnname=${variable}

Unsupported Variable Syntax

Description Examples of Unsupported Syntax

Do not omit the $. columnname={variable}

Do not omit braces. columnname=$variable        

Do not substitute brackets for braces. columnname=$[variable]

Supported select Clause Syntax

You must include order by and group by columns in select clauses.

Description
Examples of
Supported
Syntax

Select all columns for an IPDB data source. select *

Select specific columns from an IPDB Data Source (You must separate

each column with a comma.). 

select 

column1

,

column2

,

column3

,...,columnN

Use distinct in a select clause. You must enclose the column within par-

entheses when you use distinct.

select distinct

(column1)
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Description
Examples of
Supported
Syntax

Use aggregate functions in select clause. Refer to "Supported Aggregate

Functions,"  below, for a complete list of aggregate functions supported in

this release contained in this article.

select count

(msg.id)

select count(dis-

tinct(msg.id))

Unsupported select Clause Syntax

Description
Examples of
Unsupported
Syntax

Do not enclose column names in parentheses unless you are specifying

an aggregation. The following example illustrates an unsupported use of

parentheses.

select (msg.id),

(ip.src)

Do not use computed columns. The following example illustrates an

unsupported use of computed columns.

select msg.id+100,

ip.src

Do not use column aliases (with or without AS). The following example

illustrates an unsupported use of column aliases.

select msg.id as

ID, ip.src SRC

Security Analytics does not support the Lower function in select clauses.

Supported where Clause Syntax

You must include order by and group by columns in where clauses.
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Description
Examples of Supported Syn-
tax

Enclose a value within single quotes if the value

includes a space. The following syntax is incorrect:

where msg = Auth start for user USERNAME from

20.20.20.2/20 to 10.10.10.1/10.

where msg = 'Auth start for user

USERNAME from 20.20.20.2/20 to

10.10.10.1/10'

Enclose a value within single quotes if the value

includes special characters. You do not need to

enclose the following characters within single quotes:

l alphanumeric characters

l : (colon)

l _ (underscore)

l . (period)

The following syntax does not work:

select url,size
device spec: device-specifications
where url = http://1.1.1.1//tsweb/images
/clear.gif

The following syntax does not work:

where url = some/urls/string

The following syntax does not work:

where msg = Failover cable OK.

The following syntax works:

where msg.id = 101001:10

The following syntax works:

select url,size

device spec: device-specifications

where url = 'http://1.1.1.1//t-

sweb/images/clear.gif'

The following syntax works:

where url = 'some/urls/string'

The following syntax works:

where msg = ‘Failover cable OK.’

Use this syntax to express a filter condition. column1 <operator> 'value'

Use this syntax for Boolean and or

Boolean or operators.Refer to "Supported Operators," 

below, for a complete list of operators supported in this

release.

column1 <operator> 'value' and

column2<

operator> 'value' or column1 <oper-

ator> 'value' 
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Description
Examples of Supported Syn-
tax

Use this syntax for to check for null. column1 is null

column1 is not null

Use this syntax check for membership using

the in operator.

column1 in

('value1','value2',...,'valueN')

column1 not in

('value1','value2',...,'valueN')

Use this syntax to specify a range using

the between operator.

column1 between 'value1' and

'value2'

column1 not between 'value1' and

'value2'

Use this syntax to compare a string using

the like operator.

column1 like 'value'

column1 not like 'value'

Use this syntax to look for patterns using

the % wildcard with the like operator.

select msg.id where msg like 'ip%'
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Description
Examples of Supported Syn-
tax

Use the Lower function to ignore upper and lower case

in where clause searches.

You can associate the Lower function in a where

clause with the TEXT Column type exclusively.  If

you specifyLower with Column type other than TEXT,

Security Analytics displays an error message.

Security Analytics does not support

the Lower function for the  BETWEEN, IN and NOT

NULL Operators.

Lower(columnName) like ‘some%’

Lower(columnName) like lower

(‘some%’)

 Unsupported where Clause Syntax

Description Examples of Unsupported Syntax

Do not use nested queries. select msg.id where msg.id in (select msg.id

from table where ip.src = '1.1.1.1')

Do not use the Lower function for

the  BETWEEN, IN and NOT

NULL Operators.

Supported order by Clause Syntax

Order by functionality is not case-sensitive.
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Description
Examples of Supported Syn-
tax

Use this syntax to perform ascending (asc) and
descending (desc) sorts with order by.

l order by size asc

l order by msg desc

l order by size asc, msg desc

l order by count(size) asc

Only enclose column names in parentheses if you are
applying an aggregate function to the column. The
following example illustrates an invalid use of
parentheses in an order by clause:

order by (count(size)) asc

order by count(size) asc

Supported group by Clause Syntax

Description
Examples of
Supported Syn-
tax

Use this syntax to group one or more columns. Do not use parentheses
to enclose column names. Group by functionality is case sensitive.

For example, when you run the following query, you will get a result
set with the grouped filename( which is case sensitive) and ip.dst
values.

SELECT filename, ip.dst WHERE filename exists GROUP BY
filename, ip.dst;

Filename Destination IP Address

ADOBEARM.exe 10.10.10.10

AdObEaRM.exe 10.10.10.10

adobearm.exe                    10.10.10.10

l group by size

l group by msg

Supported Aggregate Functions

The IPDB Extractor service supports the following aggregate functions and syntax in this
release.
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l count

l max

l min

l sum

l avg

You can use distinct with aggregation functions as shown in the following syntax:

l count(distinct)

l max(distinct)

l min(distinct)

l sum(distinct)

l avg(distinct)

Supported Operators

Operator Syntax

= (equals) column1 = 'value'

!= (does not equal) column1 != 'value'

<= (less than or equal to) column1 <= 'value'

>=  (greater than or equal to) column1 >= 'value'

< (less than) column1 < 'value'

> (greater than) column1 > 'value'

IN column1 NOT ('value1','value2',...,'valueN')

column1 not in ('value1','value2',...,'valueN')

between (range between two values) column1 between 'value1' and 'value2'

column1 NOT between 'value1' and 'value2'
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Operator Syntax

and, or, NOT (Boolean) condition1 and condition2

condition1 or condition2

condition1 not in ('value1','value2',...,'valueN')

like column1 like 'value'

column1 not like 'value'

Sample Supported Queries

select msg.id, ip.src, ip.dst, user.dst where size is not null

select msg.id, size, ip.srcport where msg.id='109007' and size not between '10' and '20'

select max(distinct(size)) where msg.id in ('109007','109001')

select * where size != '99' and ip.src = '20.20.20.2'

select ip.srcport,ip.dstport where ip.dst != '225.31.125.90' order by ip.dstport asc

select ip.srcport,ip.dstport where ip.dst != '225.31.125.90' order by ip.dstport asc,ip.srcport desc

select ip.srcport,ip.dstport   where ip.dst != '225.31.125.90' group by ip.srcport,ip.dstport order by
min(distinct(ip.dstport)) asc, sum(distinct(ip.srcport)) desc

select time where time = ‘2012-sep-04 13:09:03’

select * where ip.src = '20.20.20.2' and ip.dst != '10.31.125.90' or ip.dst!= '225.31.125.90'

Sample Unsupported Queries

Unsupported Query Reason

select (msg.id), (ip.src), ip.dst, user-

.dst where size is not null.

You cannot enclose columns in parentheses.

select msg.id where msg.id IN (select

msg.id from table where ip.src =

‘1.1.1.1’)

You cannot use a nested select (sub-query) to get

the msg.idfield on some other condition.
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Unsupported Query Reason

select ip.src where ip.src in between

’10.10.10.1’ and ’10.10.9.1’

You can only use the between operator for numeric

and date and time data types.

select ip.srcport,ip.dstport where ip.dst

!= '225.31.125.90' order by count

(distinct  ip.dstport) asc

When you use  distinct or any other aggregate func-

tion, you must enclose the column name in par-

entheses.

select ip.srcport,ip.dstport where ip.dst

!= '225.31.125.90' order by (ip.dstport)

asc,(ip.srcport) desc

You cannot enclose column names in parentheses.

select ip.srcport,ip.dstport   where

ip.dst != '225.31.125.90' group by ip.s-

rcport,ip.dstport order by COUNT

((ipsrcport))

You can only use one pair of parentheses to enclose

column names. The system treats multiple sets of

parentheses as nested expressions, which are not sup-

ported.

select time where time = ‘1999-

NOVEMBER-01 10:10:10’

Timestamp format is incorrect.

select time where time = ‘2012-11-11

10:10:10’

Timestamp format is incorrect.

NWDB Rule Syntax

This topic describes the rule syntax supported by NWDB rule syntax in the Reporting
Engine. To enhance the execution time of your reporting entities, see Reporting Guidelines.

A Rule is a function that manipulates the result set of a rule in order to make the output in a
report more meaningful or add additional functionality to a rule other than querying data and
displaying it. Any combination of these rule actions can be used to create unique and interesting
representations of the information collected by Security Analytics.

The Reporting Engine supports the following categories of NWDB data source rule syntax:

l select clause

l Non-Aggregate Rule

l Aggregate Rule
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l alias

l where clause

l where clause Operators

l then clause

l Limit field

l Rule Actions

l Rule Operators

Select Clause

The select clause is a comma separated list of values. For example: select
sessionid,time,service.

There are two types of select clause for NWDB Rule:

l Non-aggregate rule

l Aggregate rule

Non-Aggregate Rule

When you want to define a rule without any grouping, choose 'None' in the Summarize field. In a
non-aggregate rule, you can select any number of metas in the Select clause. For example, select
service, sessionid, time. 
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Aggregate Rule

When you want to query for a specific meta and its associated aggregate value then you must
use the Aggregate rule. To get an aggregate, you must choose either of the three metas (Event
Count, Packet Count, Session Size) or choose 'Custom' in the Summarize field to include an
aggregate function in the Select clause. For example, select ip.src, sum (ip.dst). When
Custom aggregate rule is enabled, the following fields are populated in the user interface:

l Group By

l Order By

l Session Threshold

The following figure shows the Build Rule view for Aggregate Rule.
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There are two types of aggregate values that can be queried:

l Collection aggregation

l Meta aggregation

Collection Aggregation

With collection aggregation, you can get aggregates related to Event, Session or Packets. The
following values can be queried in a collection aggregation:

l Event Count: The total count of events.

l Packet Count: The total count of packets.

l Session Size: The total session size.
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These options are listed in 'Summarize' field and any one of them can be selected in a rule. 
For example,  choose any of the Collection aggregates (Event Count or Packet Count or Session
Size) in the 'Summarize' field and select ip.src.

Meta aggregation

With meta aggregation, you can get aggregates of meta values. The following are the supported
meta aggregate functions:

l sum(meta)

l count(meta)

l countdistinct(meta)

l min(meta)

l max(meta)

l avg(meta)
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l first(meta)

l last(meta)

l len(meta)

l distinct(meta)

Supported Meta Aggregate Functions

The NWDB service supports the following meta aggregate functions and syntax in this release.

Syntax Function

sum

(<meta>)

The sum of all meta values.

For example, if you provide the field sum(payload) in the select clause, the
resultset is the sum of payload size.

Note: The meta field chosen for the sum aggregate function must be of
numeric data type.

count

(<meta>)

The total number of meta fields that would be returned.

For example, if you provide the field count(ip.dst) in the select clause,
the resultset is the number of times an ip.dst value is returned. 

countdistinct

(<meta>)

The total number of distinct meta fields that would be returned.For example,
if you provide the field countdistinct(ip.dst) in the select clause, the resultset is
the number of times a distinct ip.dst value is returned.

min

(<meta>)

The minimum of all meta values.

For example, if you provide the field min(payload) in the select clause, the
resultset is the min of payload size.

max

(<meta>)

The maximum of all meta values.

For example, if you provide the field max(payload) in the select clause, the
resultset is the max of payload size.

avg

(<meta>)

The average of all meta values.

For example, if you provide the field avg(payload) in the select clause, the
resultset is the avg of payload size.

Note: The meta field chosen for the avg aggregate function must be of
numeric data type.
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Syntax Function

first

(<meta>)

The first occurrence of the meta value.

For example, if you provide the field first(ip.src) in the select clause, the
resultset is the first occurrence of ip.src for that group.

last

(<meta>)

The last occurrence of the meta value.

For example, if you provide the field last(ip.src) in the select clause, the
resultset is the last occurrence of ip.src for that group.

len(<meta>) Converts all field values to a UInt32 length instead of returning the actual
value. This length is the number of bytes to store the actual value, not the length
of the structure stored in the meta database.

For instance, the meta value "NetWitness" returns a length of 10. All IPv4
fields, like ip.src, returns 4 bytes.

distinct

(<meta>)

The distinct values of the meta.

For example, if you provide the field distinct(ip.src) in the select clause, the
resultset is all the distinct ip.src for that group.

You must select 'Custom' in 'Summarize' field and provide the meta and the meta aggregate
functions in the select clause.
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Note: Meta aggregate functions cannot be used in a WHERE clause and the rule actions like
min_threshold/max_threshold can be used to filter aggregate functions. It is advised to use a
more refined WHERE clause to get a better rule performance while using 'group by'.

Aggregate Query for Multiple Meta

To execute aggregate query for multiple Meta, follow these steps:

1. In the Security Analytics menu, click Administration > Reports.

The Manage tab is highlighted and the Rulesview is displayed.

2. In the Rule toolbar, click   > NetWitnessDB.

For example, enter the following meta in the fields highlighted below:

SELECT: ip.src, service, count(alias.host)
ALIAS: Source IP Address, Service Type, count(alias.host)
WHERE: ip.src = 59.96.136.142
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Note: In the alias field you can enter a name for columns used in the select clause. If you
do not specify the alias for one of the field in the select clause, then the default description
will be used. For example, if the select clause has Field1,Field2,Field3,Field4, and alias
has only Field1, ,Field3,Field4, then for Field2 a default description is used.

3. Click the Test Rulebutton at the bottom of the screen.

The Test Rule page is displayed.

Summarize 

Summarize determines the type of summarization or aggregation for the rule.
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Name Config Value

Summarize To query metas without any custom grouping, select:

l None: The data is grouped by session in this case.

To get collection (sessions/events/packets) related aggregates, select either of
the following:

l EventCount: The total count of events.

l Packet Count: The total count of packets.

l Session size: The total session size.

To get meta based aggregates, select:

l Custom: This indicates that expected meta aggregate function is defined in
rule select clause.

Order By 

Order By determines how to sort the result set.

Name Configuration Value

Column

Name

The Column Name is the name of the columns by which you want to sort

the results. By default, the value is empty. When you click on a column, the value

gets populated based on the Summarize field.

l For 'None' and 'Custom', the value gets populated based on the entries made in
the Select field. You can select from this list or add custom name. 

l For Event Count, Packet Count and Session size, accepted values are Total and
Value. 

l Total - sort by aggregate value

l Value - sort by group by meta

Sort By Sort By determines the order in which you want to sort the results. The following

are the values:

l Ascending Order

l Descending Order
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Session Threshold

The session threshold is the optimization setting to stop scanning the matching sessions for each
possible
unique value for the selected meta.The threshold is an integer between 0 (default) and
2147483647. The threshold 0 scans for all matching sessions.

Note: If you provide a non-zero value (a value higher than zero), the aggregate results are
inaccurate. This can be used only when you are interested in unique values and not aggregate
values.

Supported where Clause

Syntax Description

where <field1> [<field-

operator>] <value1>,<-

value2>,<value3-value4>

<logic-operator>

<field2>,and so on

The where clause is a comma separated list of language field val-

ues and ranges that is used by NwValues function. In the where

clause, string values have to be enclosed within single quotes.

For example, where username = 'admin' && service = 22.

where <field1> [<field-

operator>] <List1>

You can use a list in the where clause if you have multiple val-

ues to report on. For example, where ip.src exists && alias.host

exists && alias.host contains $[User Reports/List of Alias Host].

When you use the list you must specify in the format

$[<path>/<List name>].

In the where clause, make sure the syntax is correct based on the meta type.
For example, 
For all text meta type use quotes for example, username = ‘user1’.
For all IP Addresses, Ethernet Addresses, and Numeric meta types do not use quotes for
example, service = 80 && ip.src = 192.168.1.1.
For date and time meta types, if the date and time format is 'YYYY-MM-DD HH:MM:SS‘, use
quotes.
If the date and time format is 1448034064 (number of seconds since EPOCH (Jan 1, 1970)), do
no use quotes.

Note: If list is used in the rule, make sure that the list values are quoted or unquoted based on
the type of the meta used. Checking the Quotes will be inserted for all the values checkbox
in list definition page (for more information see, Add a List section) would quote all the list
values. 
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Supported where Clause Operators

Syntax Description

= Returns results where the field is equal to any provided value. For

example, tcp.dstport = 21-25,110 returns session with TCP destination ports

of 21, 22, 23, 24, 25, or 110.

!= Returns results for fields that do not match the values specified.  For

example, eth.type !=0x0800 returns sessions outside of hex value (decimal value of

2048) that is all non-IP based protocols.

begins Checks for a value at the beginning of a text or binary field.

contains Searches a text  or binary value for a partial match.

ends Checks for a value at the end of a text or binary field.

exists If the field value exists, regardless of value, the operation evaluates to true.

!exists If the field value does not exist, the operation evaluates to true.

length Evaluates the length of the field. For example, username length 20-u returns any

username that is 20 or more characters long.

regex Performs a regular expression search against text or binary values.

not Not operator is used to negate a clause or condition. For example, (not(user.dst

ends "$")) will not display values for user destination.

Supported then Clause

Syntax Description

then <rule

action>

The then clause contains a rule action that manipulates the ori-

ginal result set of a rule in order to make the output in a

report more concrete or add additional functionality other than

querying data and displaying it. For example, dedup (filename).
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Limit field

This indicates the limit to be put on the query while fetching data from the database. If a result
set is sorted by event
count, packet count, or session size, the limit represents the top (or bottom) N values to be
returned. If the result set is not sorted, the first N values are returned.

Rule Actions

The NWDB data source rule syntax supports the following rule actions:

l dedup

l filter_on

l filter_out

l lookup_and_add

l max_threshold

l min_threshold

l regex

l sum_count

l sum_values

l show_whats_new

dedup (string field)

dedup removes the duplicate entries in an unsorted result set and displays only pertinent data.
The dedup rule action removes duplicate entries of a specific field in the report, so that only the
first occurrence of that value is listed in the report.

Note: The dedup rule action cannot be used with an aggregate rule.

For example, the meta data generated by an individual session is often repetitive, especially
when you have sessions with a lot of DNS lookups or web sessions that access the same host
multiple times for various resources (such as, javascript, css). To remove the duplicate entries of
the host, you can use the dedup rule action.

Example:

The following example is a lengthy result set that can be trimmed by removing the duplicate
values in the same session.
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The following figure shows the use of dedup rule action to remove the duplicate entries from the
result set.
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The duplicate value for each entry in the rule result set is reduced to one value.
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filter_on (string filter, string field, bool matchExact)

filter_on removes values that do not contain the filter criteria from the result set. If the
result set contains multiple fields, you must select a specific field to which the filter is applied.
To add additional results to a single result set, include function such as lookup_and_add.

The matchExact parameter determines if the match is an exact match or contains a match.

l If matchExact is set to false, any value that contains the filter text is considered a match.

l If matchExact is set to true, only values that match the provided filter text is included in the
result set.

Note: Unless the matchExact parameter is specified, the default behavior of the rule action is
to match exactly the text specified in the filter parameter. To specify that results containing
the filter text must be kept in the result set, users must set the matchExact parameter to false.

Example:

The following figure displays the list of countries and their event count.
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The following figure shows a filter_on rule action to filter out countries except Spain, China,
United States and United Kingdom from the result set.
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The following figure shows the output with the filter_on rule action.

75 Overview



Reporting Guide

Another way of filtering out the entries from the result set is to create a list of variables which
you want to filter out. For example, you can create a list with United Kingdom, France and
Germany as values in the list. You can use this list in the rule action to get the same result set.
For example, if you create a list called COUNTRY_LIST, you can use the list as follows:
filter_on ('$COUNTRY_LIST', 'country.src', 'false');

filter_out (string filter, string field)

filter_out (string filter, string field, bool matchExact)

filter_out removes the values that contain the filter criteria from the result set. If the result set
contains multiple fields, you must select a specific field to which the filter is applied (for
example, you can use a lookup_and_add to add results to a single result set).

The matchExact parameter determines if the match is an exact match or contains a match.

l If matchExact is set to false, any value that contains the filter text is considered a match.

l If matchExact is set to true, only values that match the provided filter text is excluded from
the result set.

Note: Unless the matchExact parameter is specified, the default behavior of the rule action
is to match exactly the text specified in the filter parameter. To specify that results containing
the filter text must be removed from the result set, users must set the matchExact parameter
to false.

Example:
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The following figure displays the list of countries and their event count.

The following figure shows the filter_out rule action to remove the event count for Spain, China,
United States and United Kingdom from the result set.
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The following figure shows the output with the filter_out rule action.
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lookup_and_add (string select, string field)

lookup_and_add (string select, string field, int limit)

lookup_and_add (string select, string field, int limit, boolean inherit)

lookup_and_add (string select, string field, int limit, boolean inherit,
string extraWhere) 

lookup_and_add(string select, string field, int limit, boolean inherit,
string extraWhere, boolean aggregate)

This rule action iterates through a list of values in a result set and lookup additional meta data to
further describe the relationships between various elements in a result set.

Note: The lookup_and_add rule action can be used only with an aggregate rule.

The first parameter, select, designates the type of meta data that must be added to elements of
the result set. The second parameter, field, specifies where in the result set the append must
apply to. Also, a limit can be applied to avoid crowding the result set with a large result set.

By default, subsequent queries to the SDK will inherit the where clause of the parent rule. To
use a unique where clause, you can specify a boolean value in the fourth parameter as false and
in the fifth parameter you can specify a different where clause.

Note: If you are using a unique where clause in your query, make sure that you use a single
quote (') for enclosing arguments and double quotes (") for string values.
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Now, with the addition of Custom summarization and Group By feature, the result can be
achieved even without having lookup_and_add rule action. The new rule syntax with groupby
displays the result in a flat structure which is better than the earlier rule syntax without
groupby Hence it is recommended to manually edit/update rules with lookup_and_add rule action
and use groupby clause wherever it is applicable.

Note: Lookup_And_Add rule action is supported only if the SELECT clause has one meta and
aggregate function.

For example, see below scenarios: In Example 2a, lookup_and_add rule action is used. Instead
of using lookup_and_add rule action, the same result can be achieved by using Custom
summarization and Group By feature. See Example 2b below.

But, lookup_and_add rule action is still supported for NWDB rules on the following conditions:

l All versions of NWDB rules with Summarization as Event Count, Packet Count, or Session
Size.

l For Custom summarization, the lookup_and_add rule must have only one group by meta with
only one aggregate function where the aggregate function must be either sum() or count().

Note: It is not supported for “Summarize-None”.

For example, lookup_and_add rule action can be used for the following rules:

l select ip.src, sum(size) group by ip.src

l select ip.src, count(filename) group by ip.src

It cannot be used for the following rules:

l select ip.src, sum(size),count(filename) group by ip.src

l select ip.src, sum(size),avg(size) group by ip.src

l select ip.src,ip.dst count(filename) group by ip.src,ip.dst

Examples:

1. lookup_and_add('ip.dst','ip.src', 2);

This rule action would iterate through each ip.src in the initial result set and lookup the top two
destination IP addresses with each ip.src.

The following figure shows the rule definition.
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The following figure shows the result set containing the source IP addresses and the top two
destination IP addresses with each ip.src.

81 Overview



Reporting Guide

2a. lookup_and_add('ip.dst','ip.src', 2); lookup_and_add('service','ip.src', 3);

This rule action would iterate through each ip.src in the initial result set and lookup the top two
destination IP addresses with each ip.src and the top three ports used by each ip.src.

The following figure shows the rule definition.
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The following figure shows the result set containing the source IP addresses and the top two
destination IP addresses with each ip.src and the top three ports used by each ip.src.
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You can make the query as complex as you want by selecting different fields in the result set
and by appending to different parts. For example, you may want to know what files each source
IP had touched. However, because the parent rule has a WHERE clause of service =
6667 and the default behavior of this rule action is to append to the original WHERE clause, it
becomes necessary to override the parent WHERE clause. The easiest way to understand this
concept is to look at the previous lookup_and_add call lookup_and_add('ip.dst','ip.src',2). The
actual query that is sent to the server is SELECT ip.dst WHERE service = 6667 &&ip.src =
206.42.199.194. In order to force the WHERE clause to override the service = 6667 portion of
the WHERE clause (inherited from the parent rule), the user can specify a 4th parameter of
false as shown in example 3.

2b. Without Lookup_and_add Rule

This rule uses the Custom summarization and Group By feature to sort the results.

The following figure shows the rule definition.
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The following figure shows the result set containing the source IP addresses and the top two
destination IP addresses with each ip.src and the top three ports used by each ip.src.
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3. lookup_and_add('filename', 'ip.src', 2, false);

This call would issue a query to the server, like SELECT filename WHERE ip.src =
90.0.0.142 rather than SELECT filename WHERE service = 6667' && ip.src =
90.0.0.142 because you have specified the rule action to ignore the initial WHERE clause of the
parent rule.

The following figure shows the rule definition.
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The following figure shows the result set.
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The test list is in a group name netwitness, you can access that list with the following syntax.

You can even narrow down these appended results even further to only include filenames that
have .gif as filename extension by using the fifth parameter in the rule action. The fifth
parameter allows you to specify additional WHERE clause criteria. The files with .gif filename
extension would be stored in the test list within a group named DocTeamList. You can access
this list with the following syntax: threat.source = $[DocTeamList/test] 
This can be referenced in the extra where clause parameter in the following manner:

4. lookup_and_add('filename', 'ip.src', 5, false, 'filename
CONTAINS $[DocTeamList/test]');

The following figure shows the rule definition.
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The following figure shows the result set.
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5. lookup_and_add('ip.dst','ip.src', 2,true,,false);

This rule action would iterate through each ip.src in the initial result set and lookup the top two
destination IP addresses with each ip.src. The 'aggregate' parameter is set to 'false', this implies
that aggregates would be skipped for lookup values and hence the lookup query executions will
complete faster.

Note:
The default value for 'aggregate' is 'true'. When 'aggregate' is set to 'false', Reporting Engine
passes threshold=1, Sort by='value' and Order=Ascending to NWDB to make lookup queries
run faster. 
. You must set the 'aggregate' to false, when rule contains aggregate functions or when the
rule is run against a wide time range. This helps the rule to complete the execution faster.

The following figure shows the rule definition.
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The following figure shows the result set.
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max_threshold (string quantity)

max_threshold (string quantity, string field)

max_threshold removes any results with a quantity that is larger than the maximum threshold
quantity from a result set. The quantity can either be in terms of count or size and it is relative to
the sorting options of the parent rule. This means that if you sort a rule by size, the rule action
expects you to specify the parameter in bytes (you can append KB, MB, GB, TB to the
parameter to make size conversion easier). 

max_threshold rule can also be used to filter values based on the aggregate function values. Use
the syntax based on the type of summarization used in the rule as below:

l max_threshold(String quantity): Can be used to filter Event Count, Packet Count, and Session
Size.

l max_threshold(String quantity, String field): Can be used to filter values of Custom
aggregates or any metas.

Examples:

1. max_threshold(200);

The following figure shows the result without the max_threshold argument. The output results
have event counts exceeding 200.
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The following figure shows a the max_threshold rule action that puts a limit of 200 bytes on the
output. Any output having more than 200 bytes of data are not listed.
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The following figure shows the result when the max_threshold rule action is applied. The result
numbered 1 in the above screen capture is removed from the result.
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2. max_threshold(5,count(alias.host));

The following figure shows the result without the max_threshold argument. The output results
have count of alias.host exceeding 5.
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The following figure shows a the max_threshold rule action that puts a limit of 5 on the output.
Any output having value more than 5 is not listed.

The following figure shows the result when the max_threshold rule action is applied. Any output
having value more than 5 is removed from the result.
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min_threshold (string quantity)

min_threshold removes results with a quantity that is smaller than the minimum threshold
quantity from a result set. The quantity can either be in terms of count or size and it is relative to
the sorting options of the parent rule. This means that if you sort a rule by size, the rule action
expects you to specify the parameter in bytes (you can append KB, MB, GB, TB to the
parameter to make size conversion easier).

min_threshold rule can also be used to filter values based on the aggregate function values. Use
the syntax based on the type of summarization used in the rule as below:

l min_threshold(String quantity): Can be used to filter Event Count, Packet Count, and Session
Size.

l min_threshold(String quantity, String field): Can be used to filter values of Custom aggregates
or any metas.

Examples:

1. min_threshold(200);

The following figure shows a sample of the min_threshold query.
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The above figure puts a limit of 200 bytes on the output. Any output having less than 200 bytes of
data is not listed. The output with the min_threshold rule action is applied.
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As shown, all the values are greater than 200 bytes.

2. min_threshold(100,count(alias.host));

The following figure shows the result without the min_threshold argument. The output results
have count of alias.host below 100.
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The following figure shows a the min_threshold rule action that sets the minimum limit of 100 on
the output. Any output having data less than 100 is not listed.
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The following figure shows the result when the min_threshold rule action is applied. Any output
having data less than 100 is removed from the result.
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regex (string regex, string field)

The  regex rule action applies regular expression to the result set. The following is the format of
the regex rule action:

regex(regular_expression, meta_name)

Where:

l regular_expression - Regular expression to match the value of the meta.

l meta_name - Meta or field name on which the regex has to be applied.

For a comprehensive list of supported regex patterns, refer to
http://docs.oracle.com/javase/7/docs/api/java/util/regex/Pattern.html.

Sample regex rule action:

If you want to list filenames of all the PNG and JPEG format files from various sessions, you
can write a rule with the following regex rule action:

regex(".+.(png|jpg)", filename);

The following figure shows the rule.
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The output with the regex rule action applied is shown in the following figure.
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sum_count()

Totals the quantifiers for a given result set. For example, calling a sum_count() for a rule that is
sorted by event count totals the size of all values in the result set and displays the total in place
of the result set.

Example: 

The following figure shows the sum_count() rule action.
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With sum_count() rule action, the output shows the total size of all the event counts.
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sum_values()

Totals the number of values for a given result set. Use this action to display how many matches
exists for a given rule.

Example:

The following figure shows the sum_values() rule action.
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The following figure shows the result with sum_values rule action.

107 Overview



Reporting Guide

show_whats_new()

The show_whats_new() rule action takes any result in a result set and filters out any value that
is available in the NetWitness meta database prior to the time frame of the currently running
report. When a report is run, Security Analytics determines the ID of the first session in the time
range of the report. If a value in a result set has a first session id that is greater than the first
session id of the report time frame, it did not exist in the NetWitness meta database prior to the
report being run and so is new to the NetWitness system relative to the time frame of the report.

The show_whats_new() rule action is also supported for Custom Aggregate Rule. When multiple
meta's are selected in the Custom rule, the first meta is considered for filtering out the old
values. See Example 2 below to understand how this rule action is used for Custom Aggregate
Rule.

Note: The show_whats_new() rule action can be used only with an aggregate rule.

Examples:

1. show_whats_new() for aggregate rule with Event Count

In the following example, all the Source IP Addresses available for the past two weeks are
listed.
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The following figure shows the use of the show_whats_new rule action to list only the new
entries for the past two weeks.
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The following figure lists the new entries for the past two weeks.
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2. show_whats_new() for Custom aggregate rule

In the following example, all the Source IP Addresses available for the past two weeks are
listed.
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The following figure shows the use of the show_whats_new rule action to list only the new
entries for the past two weeks.
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The following figure lists the new entries of Source IP Addresses for the past two weeks.
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The power of this feature is that it doesn't matter when the report is run in identifying values that
are new to NetWitness. The caveat with this feature is that if a data reset occurs, you will lose
your data. However, it is easy to baseline a system and identify changes and new items without
a tremendous amount of strain on the system (depending on the size of your result set).

Supported Rule Operators

The NWDB Reporting Engine data source rule syntax supports a subset of rule operators that
are supported by Security Analytics.

Syntax Description

* Use an asterisk (*) as the sole operator in a rule to select all traffic.

= Equals operator

!= Does not equal operator

&& Logical AND operator

|| Logical OR operator

Overview 114



Reporting Guide

Syntax Description

-u Upper boundary. For example, tcp.port = 40000-u selects all TCP ports above

40000.

l- Lower boundary. For example, tcp.port = l-40000 selects all TCP ports below

40000.

- The dash (-) operator only applies to numeric values. Separate the lower and upper

boundaries of the range with a dash (-).  For example, tcp.port = 25-443 selects all

TCP ports between 25 and 443.

IMDB Rule Syntax

This topic describes the supported rule syntax for the IMDB service through descriptions and
examples of supported and unsupported syntax. There is a finite set of syntax that you can use to
construct rules for reports using the IMDB service in this release. This topic contains:

l Descriptions of supported and unsupported syntax with examples.

l Supported aggregate functions.

l Supported operators.

l Sample supported queries. 

Supported and Unsupported Syntax

When you construct rules that contain SQL queries against the IMDB database in this release,
you must adhere to the descriptions and syntax examples described in the following tables.
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Supported Literal (Data) Values Syntax

Description
Examples of
Supported Syn-
tax

For TEXT or string type data, enclose the string or text in single quote

marks. If there is any special character such as apostrophe (for

example 'data'), use two single quotes, ''data'', to enclose the data value. 

select msg.id

where msg='

(Primary) Link

status ''Down'' on

interface

INTNAME.'

For Date and Time (date/timestamp data type columns), use the

EPOCH syntax.

alert.timestamp >=

1475658011

All string values must have single quote. In case of integer type, do not

use quotes

Use the following operators to ensure accurate processing:

l =  (equals)

l !=  (does not equal)

l exists (exists)

l !exists(not exists)

1. select
alert.name
where
alert.numEvents
= 4

2. select priority
where status =
'NEW'

Supported select Clause Syntax

You must include order by and group by columns in select clauses.

Description
Examples of
Supported
Syntax

Select all columns for an IMDB data source. select *
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Description
Examples of
Supported
Syntax

Select specific columns from an IMDB Data Source (You must separate

each column with a comma.). 

select 

column1

,

column2

,

column3

,...,columnN

Use aggregate functions in select clause. Refer to "Supported Aggregate

Functions,"  below, for a complete list of aggregate functions supported in

this release contained in this article.

Categories

Use column aliases (with or without AS). The following example illus-

trates an unsupported use of column aliases.

select msg.id as

ID, ip.src SRC

Unsupported select Clause Syntax

Description
Examples of
Unsupported
Syntax

Do not enclose column names in parentheses unless you are specifying

an aggregation. The following example illustrates an unsupported use of

parentheses.

select (msg.id),

(ip.src)

Do not use computed columns. The following example illustrates an

unsupported use of computed columns.

select msg.id+100,

ip.src

Security Analytics does not support the Lower function in select clauses.

Supported where Clause Syntax

You must include order by and group by columns in where clauses.
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Description Examples of Supported Syntax

All timestamp values are sup-

ported.

alert.timestamp >= 1475658011 or alert.timestamp <=

1475658011

 Unsupported where Clause Syntax

Description Examples of Unsupported Syntax

Do not use nested quer-

ies.

select msg.id where msg.id in (select msg.id from table where ip.src

= '1.1.1.1')

In where clause, adding lists is not supported.

Supported order by Clause Syntax

Order by functionality is not case-sensitive.

Description
Examples of Supported Syn-
tax

Use this syntax to perform ascending (asc) and
descending (desc) sorts with order by.

l order by alert.name asc

l order by incidentCreated desc

l order by count(numEvents)

l order by status

Only enclose column names in parentheses if you are
applying an aggregate function to the column. The
following example illustrates an invalid use of
parentheses in an order by clause:

order by count(riskScore)

Note: For all queries, it is
mandatory for you to select the
order by field.
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Supported group by Clause Syntax

Description
Examples of Supported
Syntax

Security Analytics picks the metas for Group By field

from the selected Select clause automatically but outside

any function.

group by : alert.severity,
alert.timestamp, incidentCreated

Note: Group by field is enabled
for Aggregate queries and are
not editable.

Supported Aggregate Functions

The IMDB Extractor service supports the following aggregate functions and syntax in this
release.

l count

l max

l min

l sum

l avg

You can use distinct with aggregation functions as shown in the following syntax:

l count(distinct)

l max(distinct)

l min(distinct)

l sum(distinct)

l avg(distinct)

Supported Operators

Operator Syntax

= (equals) column1 

= 'value'
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Operator Syntax

!= (does not equal) column1 

!= 'value'

begins column1 

<= 'value'

contains column1 

>= 'value'

ends column1 

< 'value'

exists column1 

> 'value'

!exists (does not exist) column1 

NOT

('

value1

','

value2

',...,'

valueN')

length column1 

between

'value1'

and

'value2'
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Operator Syntax

regex (regular expression) condition1

 and con-

dition2

condition1

or con-

dition2

condition1

not in 

('

value1

','

value2

',...,'

valueN')

Sample Supported Queries

select alert.name, alert.numEvents, alert.severity where alert.severity exists

select alert.host_summary, alert.name where alert.host_summary contains '10.30.94.34'

select alert.name, alert.numEvents, count(alert.numEvents)

select alert.severity, avg(alert.severity)

select alert.timestamp, incidentCreated where alert.timestamp >= 1475658011

Sample Unsupported Queries

You cannot use timestamp meta values in where clause other than EPOCH format. For example,
where : incidentCreated = "Tue Oct 25 07:15:38 UTC 2016".

You cannot use a nested select (sub-query) to get the msg.idfield on some other condition. For
example,

Ex :- select incidentId where incidentid IN (select incidentId from table where alert.source =
‘ESA’)
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You cannot enclose columns in parentheses. For example, select (alert.name), (alert.source),
incidentId, receivedTime where alert.severity is not null.

Rule Types

This topic describes the different rule types in the Reporting module. Rule types designate the
source of data for the report rule. Following are the rule types:

Rule Type Description

NetWitness

Database (

NetWitness DB

)

The NetWitness database extracts the meta from a Reporting Engine con-

figured to use a Concentrator, Broker and Archiver as the data sources and

provides the meta for rules.

Internet Protocol

Database

(IPDB)

The Internet Protocol Database (IPDB) provides normalized and raw event

messages that can cover significant historical time periods. You need to con-

figure the IPDB Extractor service and associate it with a Reporting Engine

as described in the Reporting Engine Configuration Checklist. You can

have a number of IPDB deployments including a multi-site IPDB deploy-

ment. The IPDB Extractor can also be deployed on virtual environments.

For more information, see Supported IPDB Extractor Service Deployments on

Virtual Environments.

Warehouse

Database

(Warehouse

DB)

The Warehouse database, also referred to as the RSA Analytics Ware-

house, warehouses large volumes of data. The Warehouse is designed so

that you can retrieve large volumes of data easily and efficiently. The Ware-

house also extracts the meta from the Reporting Engine.

Topics

Supported IPDB Extractor Service Deployments on Virtual Environments

Supported IPDB Extractor Service Deployments on Virtual Environments

This topic describes the supported IPDB Extractor deployments on virtual environments.
Security Analytics supports the deployment of Internet Protocol Database (IPDB)Extractor
service on virtual environments. The following table lists the virtual deployment specifications
that RSA recommends for IPDB Extractor service. Note that these recommendations are based
on the tests conducted at RSA.
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Item Specification

Processor 4 vCPU

Memory 8 GB RAM

HDD 320 GB

Supported VMware Platforms

Platforms Versions

VMware ESX Server 5.0

VMware vSphere Client 5.0

IPDB Extractor Service Virtual Deployment

The following table lists the IPDB Extractor Service Virtual deployment for the different IPDB
deployments.

IPDB Deployment
Connection to IPDB Extractor
Service on VM

Secure Con-
nection Modes

IPDB on NAS Through LAN SSH/VPN/IPSEC

Through Private Switch Physical Switch

Through Virtual Dis-

tributed Switch

Virtual Switch

IPDB on Single site Hard-

ware Host

Using CIFS mount SSH/VPN/IPSEC

IPDB on Single site  Vir-

tual Host

Using CIFS mount SSH/VPN/IPSEC

Note: In case of IPDB on Single Site Virtual Host, the IPDB Extractor service is assumed to
be installed on the same ESX server as the single site.

123 Overview



Reporting Guide

IPDB on NAS Through LAN

If you deploy the IPDB residing on Network attached Storage (NAS) through a Local Area
Network (LAN), you must establish the VPN/SSH/IPSEC tunnel between the NAS and the
IPDB Extractor service host.  You can host the IPDB Extractor service on a Security Analytics
Host, R710 Host or Virtual Machine.

IPDB on NAS Through Private Switch

In the following deployment, IPDB Extractor service is hosted on a Virtual Machine (VM), you
must connect the ESX Server using the same switch as you use to connect an enVision Host to
the NAS.
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IPDB on NAS Through Virtual Distributed Switch

In the following deployment, multiple IPDB Extractor services hosted on a multiple VMs, you
must connect the ESX Servers using the a virtual distributed switch. In this deployment:

l An IPDB Extractor service hosted on a VM has a dedicated nic card/Ethernet port on the
ESX server on which the VM runs.

l This Ethernet port is not shared by any other virtual machine on that ESX.

l Each Ethernet port is connected to a virtual distributed switch which in turn is connected to
the private switch of the NAS (IPDB resides on NAS).

l Apart from the VMs that host the IPDB Extractor service, no other VM shares the same
network, so they are not able to access data from NAS.
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Define Rule Groups and Rules
This topic is a collection of tasks for configuring Reports Group and Reports. You can define,
delete, edit, import and export report groups and lists in Security Analytics. Individual topics
describe the relevant procedures.

Topics:

l Add a Rule Group

l Define a Rule

l Test a Rule

l Tune IPDB Rules

l Use Meta Aliases for Reporting Engine

Add a Rule Group

This topic provides instructions to define a rule group or a rule sub-group.

Prerequisites

Make sure that you understand the Rule view components. For more information, see Rule View.

Procedure

Perform the following steps to add rule groups or rule sub-groups.
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To add a rule group or rule sub-group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Do one of the following.

l To define a rule group:

a. In the Rule Groups Panel, click  .

A new rule group is added to the Rule Groups panel.

b. Type the name for the rule group and press ENTER.

l To add a rule sub-group:

a. In the Rule Groups panel, select the rule group to which you want to add a sub-group.

b. Click  .

A new rule sub-group is added to the rule group.

c. Type the name for the rule sub-group and press ENTER.

Define a Rule

This topic describes the types of rules you can define or add using different data sources. Rules
can be defined to fetch data or events from a NetWitness, IPDB or Warehouse data source.
Based on your requirements you can select any of the following options to define a rule:

l Prerequisites

l Prerequisites

l Prerequisites

Define a Rule Using IPDB Data Source

This topic provides instructions to define a rule to fetch data or events from an IPDB data
source.

Prerequisites

Make sure that you:

l Understand which rule type needs to be used in the rule. For more information on rule types,
see Rule Types.

l Understand the IPDB rule syntax. For more information, see IPDB Rule Syntax.
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l Understand the Rule view components. For more information, see Rule View.

l Understand the Build Rule view components. For more information, see Build Rule View.

Procedure

Perform the following steps to define a rule to fetch data or events from an IPDB data source:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rule toolbar, click   > IPDB.
The Build Rule view is displayed.

3. In the Rule Type field, IPDB is selected by default.

4. In the Name field, enter a name that is used to Identify or label the rule in alerts and reports.

5. In the Select field, enter a meta or select a meta from the list of available meta types
provided in the Meta Panel. For more information, see the topic Meta Panel in Build Rule
View.

6. In the Event Source field, you can configure the Event Source Specification to assign
devices dynamically to the same rule. For more information, see IPDB Event Source
Specification. You can also insert a list in this field by selecting a list and navigating
to Insert > Event Source in the Lists Panel.

7. In the Where field, enter a meta or select a meta from the list of available meta types
provided in the Meta Panel. The Where clause provides the base query criteria for the
rule. You can also insert a list in this field by selecting a list and navigating to Insert >
Where in the Lists Panel.

8. In the Group By field, enter the meta selected in the Select clause, so that the result set is
grouped based on the meta.

9. In the Order By field, perform the following:

a. In the Column Name column, enter the name of the columns by which you want to group
the results.

b. In the Sort by column, select one of the following ways to sort the results:

l Ascending Order

l Descending Order

10. In theLimitfield, enter the limit to be put on the query while fetching data from the database.
If a result set is sorted by session count, packet count, or session size, the limit represents
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the top (or bottom) N values to be returned. If the result set is not sorted, the first N values
are returned.

11. Click Save.

Next steps

You can test the correctness of the rule created by clicking Test Rule. For instructions, see Test
a Rule.

Define a Rule Using NetWitness Data Source

This topic provides instructions to define a rule to fetch data or events from a NetWitness data
source. You can define rules to fetch data or events from a NetWitness data source. The same
procedure is used to define a rule to fetch data or events from an Archiver data source.

The Archiver data source can be added in the Services Config View of the Reporting Engine.
For more information, see(Optional) Add Archiver as Data Source to Reporting Engine topic in
Host and Services Configuration Guide.

Prerequisites

Make sure that you:

l Understand which rule type needs to be used in the rule. For more information on rule types,
see Rule Types.

l Understand the NWDB rule syntax. For more information, see NWDB Rule Syntax. 

l Understand the Rule view components. For more information, see Rule View.

l Understand the Build Rule view components. For more information, see Build Rule View.

l Understand how custom meta keys are created using custom feeds. For more information, see
Create Custom Meta Keys using Custom Feed topic in Host and Services Configuration
Guide.

Procedure

Perform the following steps to define a rule to fetch data or events from a NetWitness Data
Source:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rule toolbar, click   >NetWitnessDB.
The Build Rule view tab is displayed.
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3. In the Rule Type field, NetWitness DB is selected by default.

4. In the Name field, enter a name that is used to Identify or label the rule in alerts and reports.

5. The Summarize field determines the type of summarization or aggregation for the rule.
Based on the type of rule to be defined, you must select one of the following:

l To define a Non-Aggregate rule without any grouping, select: None

l To define an Aggregate rule with special aggregation like the collection
(sessions/events/packets) related aggregates, select one of the following:

l Event Count

l Packet Count

l Session Size

l To define an Aggregate rule with meta values and custom aggregates like sum(), count(),
and so on, select: Custom
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Choosing 'Custom' in the Summarize field enables you to define aggregate function of
your choice in the Select clause. For example, select ip.src, countdistinct(ip.dst), distinct
(ip.dst). The supported aggregate functions are:

l sum (<meta>) 

l count(<meta>)

l countdistinct(<meta>)

l min(<meta>)

l max(<meta>)

l avg(<meta>)

l first(<meta>)

l last(<meta>)

l len(<meta>)

l distinct(<meta>)

For more detailed information about Aggregate and Non-aggregate rule, see NWDB Rule
Syntax.

6. In the Select field, enter a meta or select a meta from the list of available meta types
provided in the Meta Library. For more information, see the topic Meta Panel in Build Rule
View. The meta name to fetch raw log is raw. raw can only be used in the Select field. It
cannot be used in the Where and Then fields. Multiple aggregate functions are supported for
Custom aggregate rule in the Select field.

Note: In earlier versions of Security Analytics, only one aggregate function was supported
for Custom aggregate rule in the Select clause. From now, multiple aggregate functions
are supported in the Select clause. For example, Select: ip.src, username, service, distinct
(country.src), sum(payload).

7. In the Where field, enter a meta or select a meta from the list of available meta types and
use the operators to construct the Where clause for the base query criteria.

8. The Group By field is a read-only field which gets populated with meta that are defined in
the Select clause. For a Non-Aggregate function, this field is not visible. A maximum of
six meta are supported in the Group By field.

Note: In earlier versions of Security Analytics, only one meta was supported for Custom
aggregate rule in the Group By clause. From now, a maximum of six meta are supported
in the Group By clause.

9. In the Then field, enter the rule actions that manipulate the original result set of a rule in

131 Overview



Reporting Guide

order to make the output in a report more concrete or add additional functionality other than
querying data and displaying it, for example, creating a feed from the results. For a complete
list of available rule actions, see NWDB Rule Syntax.

Note:When a rule is executed for an Archiver data source, it is recommended not to use
query intensive rule actions such as lookup_and_add() and show_whats_new().

10. In the Order By field, perform the following:

a. In the Column Name column, enter the name of the columns by which you want to
sort the results. By default, the value is empty. The value gets populated based on the
value selected in the Summarize field.

l For Summarize 'None', if no Order By is selected, then by default it is ordered by
session or collection time.

l For other Summarize values, the default sorting is based on the first 'group by' meta
selected when no 'order by' is defined. For Event Count, Packet Count, and Session
size, the accepted values are Total and Value.

b. In the Sort by column, select one of the following ways to sort the results:

l Ascending Order

l Descending Order

11. In the Session Threshold field, enter the optimization setting to stop scanning the matching
sessions for each possible unique value for the selected meta. The threshold is an integer
between 0 (default) and 2147483647.

Note: This is applicable to only NWDB Aggregate rules. If the default value is specified,
all the matching sessions will be scanned and the accurate value will be returned. A higher
session threshold allows accurate counts for a value. However, this causes longer rule
execution time. For example, consider you set the Session Threshold as 1000 for ip.src. If
there are 5000 matching sessions then for a particular ip.src value which is present in more
than 1000 sessions, NWDB stops the scan after 1000 sessions and returns the extrapolated
aggregate value. This optimizes the query execution time. If the value is present in less
than 1000 sessions, then the actual value is returned.

12. In the Limit field, enter the limit to be put on the query while fetching data from the
database. If a result set is sorted by event count, packet count, or session size, the limit
represents the top (or bottom) N values to be returned. If the result set is not sorted, the first
N values are returned.

13. Click Save.
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Note: Unlike parsed meta, raw logs are fetched from decoders. When both raw log and
parsed meta are queried in a single rule, due to different retention periods, parsed meta
might be available and raw logs missing in the same session. So the result will have parsed
meta values and empty raw value for those sessions. For example, for the rule "Select
ip.src, ip.dst, service, username, raw", the parsed meta might be populated and the raw
meta remains empty for a few sessions.

Next steps

You can test the correctness of the rule created by clicking Test Rule. For instructions, see Test
a Rule.

Define a Rule Using Warehouse Data Source

This topic provides instructions on how to define a rule to fetch data or events from a Warehouse
event source. You can define the rules in two modes:

l Default Mode

l Expert Mode

For more information on the modes, see Warehouse Database Rule Definition Modes.

Prerequisites

Make sure that you:

l Understand which rule type needs to be used in the rule. For more information on rule
types, see Rule Types.

l Understand the Rule view components. For more information, see Rule View.

l Understand the Build Rule view components. For more information, see Build Rule View.

l Understand how custom meta keys are created using custom feeds. For more information, see
Create Custom Meta Keys usong Custom Feed topic in Host and Services Configuration
Guide.

Procedure

Perform the following steps to define a rule to fetch data or events from a Warehouse data
source:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rule toolbar, click   > Warehouse DB.

3. The Build Rule view tab is displayed.
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4. In the Rule Type field, Warehouse DB is selected by default.
If you are defining the rule in Default mode, perform the following:

a. In the Name field, enter a name that is used to Identify or label the rule in alerts and
reports.

b. In the Select field, enter a meta or select the meta from the drop-down or select a meta
from the list of available meta types provided in the Meta Panel. For more information,
see the topic Meta Panel in Build Rule View. 

c. In the From drop-down menu, Select one of the following:

l Session

l Logs

d. In the Alias field, enter the alias name for columns used in the Select clause.

e. In the Where field, enter a meta or select a meta from the list of available meta types
provided in the Meta Panel. The Where clause provides the base query criteria for the
rule.

f. In the Group By field, enter the meta selected in the Select clause, so that the result set
is grouped based on the meta.

g. In the Having field, enter the criteria to filter the result set for aggregated queries.

h. In the Order By field, perform the following:

1. In the Column Name column, enter the name of the columns by which you want to
group the results.

2. In the Sort by column, select one of the following ways to sort the results:

l Ascending Order 

l Descending Order

i. In the Limit field, enter the limit to be put on the query while fetching data from the
database. If a result set is sorted by session count, packet count, or session size, the limit
represents the top (or bottom) N values to be returned. If the result set is not sorted, the
first N values are returned.

j. Click Save.

5. If you are defining the rule in Expert mode, select the Expert Mode checkbox and perform
the following:
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a. In the Name field, enter a name that is used to Identify or label the rule in alerts and
reports.

b. In the Query field, enter the Hive query statement to query the data source.

c. In the Alias field, enter the alias name for columns used in the Select clause.

d. Click Save.

Next steps

You can test the correctness of the rule created by clicking Test Rule. For instructions, see Test
a Rule.

Define a Rule Using Incident Management Data Source

This topic provides instructions to define a rule to generate incidents or alerts from an Incident
Management data source.

Prerequisites

Make sure that you:

l You add the Incident Management service in the Services Config View of the Reporting
Engine. For more information, see Step 1. Add Incident Management Service topic in Host
and Services Configuration Guide.

l Understand which rule type needs to be used in the rule. For more information on rule types,
see Rule Types.

l Understand the IMDB rule syntax. For more information, see IMDB Rule Syntax. 

l Understand the Rule view components. For more information, see Rule View.

l Understand the Build Rule view components. For more information, see Build Rule View.

l Understand how custom meta keys are created using custom feeds. For more information, see
Create Custom Meta Keys using Custom Feed topic in Host and Services Configuration
Guide.

l Ensure Reporting Engine service is up and running.

l Ensure the Incident Management service is up and running. For more information, see Step 2.
Configure a Database for the Incident Management Service topic in Host and Services
Configuration Guide.

l (Optional) Ensure the ESA service is up and running. For more information, see Step 3.
Configure Advanced Settings for an ESA Service topic in Host and Services Configuration
Guide.
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l (Optional) Ensure the Malware Analysis service is up and running. For more information, see
(Optional) Configure Auditing on Malware Analysis Host topic in Host and Services
Configuration Guide

Note: You need to configure any one of the services (ESA,Reporting Engine, Malware
Analysis, or ECAT) based on the type of alerts or incidents you want to generate.

Procedure

Perform the following steps to define a rule to fetch data or events from a Incident Management
Data Source:

1. In the Security Analytics menu, click Administration> Reports.
The Manage tab is displayed.

2. In the Rule toolbar, click  >IMDB.
The Build Rule view tab is displayed.

3. In the Rule Type field, IMDB is selected by default.

4. In the Name field, enter a name that is used to identify or label the rule in alerts and incident
reports.

5. The Summarize field determines the type of summarization or aggregation for the rule.
Based on the type of rule to be defined, you must select one of the following:
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l To define a Non-Aggregate rule without any grouping, select None

l To define an Aggregate rule with meta values and custom aggregates select Custom

If you select 'Custom' in the Summarize field you can define aggregate function of your
choice in the Select clause based on the report type you have selected.

For more detailed information about Aggregate and Non-aggregate rule, see IMDB Rule
Syntax.

6. In the From field, based on the type of report output to be displayed, you must select one of
the following:

l Alert

l Incident

7. In the Select field, enter a meta or select a meta from the list of available meta types
provided in the Meta Library. For more information, see the topic Meta Panel in Build Rule
View. Metas cannot be used in the Where field. Multiple aggregate functions are supported
for Custom aggregate rule in the Select field.

For example, the supported aggregate functions for alert are:

l alert_host_summary

l alert.name

l alert.numEvents

l alert.severity

l alert.source

l alert.timestamp

l incidentCreated

l incidentId

l receivedTime

For example, the supported aggregate functions for incident are:

l categories

l created

l priority

l riskScore
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l sealed

l status

For more detailed information about Aggregate and Non-aggregate rule, see IMDB Rule
Syntax.

8. In the Where field, enter a meta or select a meta from the list of available meta types and
use the operators to construct the Where clause for the base query criteria.

9. The Group By field is a read-only field which gets populated with meta that are defined in
the Select clause. For a Non-Aggregate function, this field is not visible. A maximum of six
meta are supported in the Group By field.

10. In the Order By field, perform the following:

a. In the Column Name column, enter the name of the columns by which you want to
sort the results. By default, the value is empty.

b. In the Sort by column, select one of the following ways to sort the results:

l Ascending Order

l Descending Order

11. In the Limit field, enter the limit to be put on the query while fetching data from the
database. If a result set is sorted by the limit represents the top (or bottom) N values to be
returned. If the result set is not sorted, the first N values are returned.

12. Click Save.

Next steps

You can test the correctness of the rule created by clicking Test Rule. For instructions, see Test
a Rule.

Test a Rule

This topic provides instructions to test a rule based on the time range and the data source
selected.

Prerequisites

Make sure that you:

l Understand the Rule view components. For more information, see Rule View.

l Understand the Build Rule view components. For more information, see Build Rule View.

Procedure

Perform the following steps to test a rule:
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1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rule List panel, do one of the following:

l Select a rule and click   in the Rules toolbar.

l Click   > Edit.

The Build Rule view tab is displayed.

3. Click Test Rule.
The Test Rule view is displayed:

Note:When you click Test Rule, the rule is not saved. You have to click Savein the
Build Rule view to save the rule.

4. From the Data Sourcedrop-down list, select a data source.
You must select the appropriate data source for the rule defined.

5. From the Format drop-down list, select the format in which you want the result displayed.
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6. From the Time Rangedrop-down list, select one of the following.

l Past -To specify number of years, days, weeks, months, days or hours.

l Range - To specify a date range and time period.

Note: In the User Interface (UI), the date or time displayed depends on the time zone
profile selected by the user.

7. X-Axis and Y-Axis are used to specify the meta to be plotted in charts.
In X-Axis, the Meta for the 'Group by' rule is displayed. In Y-Axis, the aggregate functions
used in the rule are displayed.

Note: Sum, Count, Countdistinct and Average are the supported aggregate functions for rule.
By default, for Custom Rules with multiple 'Group by', you can select only the first meta in X-
Axis.

8. Click Run Test to execute the rule.
The rule data (if any) for the selected time range is displayed.

Tune IPDB Rules

This topic describes how you can create rule definitions to enhance performance of reports. You
can create rule definitions to enhance the performance of the reports. The following lists how
you define the rules to achieve performance gains:

l Performance gains are realized if the variables in the WHERE clause contain IPDB index
variables with exact match clauses (‘=’, ‘IN).

l Performance improvements are NOT seen when exact match clauses such as ‘LIKE’,
GREATER THAN ‘>’, and LESS THAN ‘<’ operators are used with the IPDB index
variables.

The sample queries in the following table help you understand the impact of the query on the
performance of the reports.
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Case
No

Where
Clause

Performance
gain expec-
ted

Remarks

1 IndexedVar1 =

‘value1’ AND

UnIn-

dexedVar2 =

‘value2’

Yes IPDB filter index for the IndexedVar1 is

checked to verify if ‘value1’ exists or not. If

‘value1’’ exists, the data file is read, else it is

skipped. 

2 UnIndexedVar2

= ‘value2’

AND

IndexedVar1 =

‘value1’

Yes IPDB filter index is applied only on IndexedVar1

to check if ‘value1’ exists or not. If ‘value1’

exists, the data file is read, else it is skipped.

The order of  indexed and

unindexed variable is irrelevant.

3 IndexedVar1 =

‘value1’ OR

UnIn-

dexedVar2 =

‘value2’

No IPDB filter index cannot decide the availability

of data due to ‘OR’

operator between indexed and unindexed vari-

able.

4 IndexedVar1 =

‘value1’ OR

IndexedVar2 =

‘value2’

Yes IPDB filter index will be applied on both

IndexedVar1 and IndexedVar2 to

check for ‘value1’ and ‘value2’ respectively. If

any of the values exist, then the data file is read,

else it is skipped.

5 IndexedVar1 =

‘value1’ AND

UnIn-

dexedVar2

LIKE ‘value%’

Yes IPDB filter index is applied only on IndexedVar1

to check if ‘value1’ exists or not. If the ‘value1’

exists, the data file is read, else it is skipped.
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Case
No

Where
Clause

Performance
gain expec-
ted

Remarks

6 IndexedVar1

LIKE

‘value1%’

AND UnIn-

dexedVar2

LIKE

‘value2%’

No No IPDB filter index works only with

exact match clauses.

7 IndexedVar1

LIKE

‘value1%’

AND UnIn-

dexedVar2

LIKE

‘value2%’

AND

IndexedVar3 =

‘value3’

Yes IPDB filter index is applied only on IndexedVar3

to check if ‘value3’ exists or not. If the ‘value1’

exists, the data file is read, else it is skipped.

Some examples of the rule definitions with indexed variables are provided in this section.

Case 1 Example: Indexed variable with AND operator 

The following is an example of a query for Case 1: 
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Case
No

Where
Clause

Performance
gain expec-
ted

Remarks

1. IndexedVar1 =

‘value1’ AND

UnIn-

dexedVar2 =

‘value2’

Yes IPDB filter index for the IndexedVar1 is

checked to verify if ‘value1’ exists or not. If

‘value1’’ exists, the data file is read, else it is

skipped. 

The query is defined to view the Destination IP addresses with a specific level value. Note that
the where clause contains the indexed variable ip.dst and unindexed variable level with AND
operator. 
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Though the records are in millions, the report is rendered quickly using with the help of the
indexed variable: 

Case 5 Example: Indexed variable with LIKE function 

The following is an example of a query for Case 5:

Case
No

Where Clause
Performance
gain expected

Remarks

5. IndexedVar1 =

‘value1’ AND

UnIndexedVar2

LIKE ‘value%’

Yes IPDB filter index is applied only on

IndexedVar1 to check if ‘value1’

exists or not. If the ‘value1’ exists, the

data file is read, else it is skipped.

 The following is an example of a query to view the Source IP addresses for specific user. Note
that the where clause contains the indexed variable ip.src and unindexed variable user.dst with
LIKE option as mentioned in Case 5 in the table. 
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Case 3 Example: Indexed variable with OR operator 

The following is an example of a query for Case 3: 

Case
No

Where Clause
Performance gain
expected

Remarks

3. <IndexedVar1 =

‘value1’ OR

UnIndexedVar2 =

‘value2’

No IPDB filter index cannot

decide the

availability of data due to

‘OR’

operator between indexed

and

unindexed variable.
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The below query is defined to view the Destination IP addresses with a specific level value.
Note that the where clause contains the indexed variable ip.dst and unindexed variable level
with OR operator. There will be no performance gain with the below query. 

Use Meta Aliases for Reporting Engine

This topic covers all the different meta aliases supported by the Reporting Engine. When you
refer to meta data in Reports and Charts, you can only view aliases for the meta names. These
aliases makes them more understandable to a broader audience.

You can only use the pre-defined aliases for the meta but cannot modify these values.

You cannot provide alias values for any meta in the WHERE clause because Security Analytics
uses the WHERE clause to fetch data from the data source (for example, in the Concentrator)
and data sources do not support aliases. In other words, you cannot provide the alias value
HTTP for the HTTP port # 80.

Note: * You cannot create aliases for meta other than the ones that have existing aliases by
Reporting Engine. Also, the format of the aliases cannot be changed.
* Aliases are not supported for Alerts and CSV reports.
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Procedure

To use alias in a rule, follow these steps:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rule List panel, do one of the following:

l Select a rule and click   in the Rules toolbar.

l Click   > Edit.

3. Specify the meta with aliases in the Select field.

The following example specifies the eth.type, ip.proto, medium, service, tcp.dstport, and
tcp.srcport meta in the Select field.

4. Click Test Rule to see the results returned by this rule.
The following example displays the results under the eth.type, ip.proto, medium, service,
tcp.dstport, and tcp.srcport alias columns that were specified in the Select field of the
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rule.

RSA-Supplied Alias Definitions

The alias files under this topic are examples only and are based on current alias definitions in
the Reporting Engine. Security Analytics cannot modify these definitions in the Reporting Engine
depending on the changes in the concentrator xml file. Since any changes in the Concentrator
xml file are not reflected in the Reporting Engine.

The details of different meta are explained in each of the meta.aliases.
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eth.type

ALIAS_FORMAT=$alias
0=802.3
257=Experimental
512=Xerox PUP
513=Xerox PUP
1024=Nixdorf
1536=Xerox NS IDP
1537=XNS Address Translation (3Mb only)
2048=IP
2049=X.75 Internet
2050=NBS Internet
2051=ECMA Internet
2052=CHAOSnet
2053=X.25 Level 3
2054=ARP
2055=XNS Compatibility
2076=Symbolics Private
2184=Xyplex
2304=Ungermann-Bass network debugger
2560=Xerox IEEE802.3 PUP
2561=Xerox IEEE802.3 PUP Address Translation
2989=Banyan Systems
2991=Banyon VINES Echo
4096=Berkeley Trailer negotiation
4097=Berkeley Trailer encapsulation for IP
4660=DCA - Multicast
5632=VALID system protocol
6537=Artificial Horizons
6549=Datapoint Corporation (RCL lan protocol)
15360=3Com NBP virtual circuit datagram (like XNS SPP) not registered
15361=3Com NBP System control datagram not registered
15362=3Com NBP Connect request (virtual cct) not registered
15363=3Com NBP Connect repsonse not registered
15364=3Com NBP Connect complete not registered
15365=3Com NBP Close request (virtual cct) not registered
15366=3Com NBP Close response not registered
15367=3Com NBP Datagram (like XNS IDP) not registered
15368=3Com NBP Datagram broadcast not registered
15369=3Com NBP Claim NetBIOS name not registered
15370=3Com NBP Delete Netbios name not registered
15371=3Com NBP Remote adaptor status request not registered
15372=3Com NBP Remote adaptor response not registered
15373=3Com NBP Reset not registered
16972=Information Modes Little Big LAN diagnostic
17185=THD - Diddle
19522=Information Modes Little Big LAN
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21000=BBN Simnet Private
24576=DEC unassigned
24577=DEC Maintenance Operation Protocol (MOP) Dump/Load Assistance
24578=DEC Maintenance Operation Protocol (MOP) Remote Console
24579=DECNET Phase IV
24580=DEC Local Area Transport (LAT)
24581=DEC diagnostic protocol (at interface initialization?)
24582=DEC customer protocol
24583=DEC Local Area VAX Cluster (LAVC)
24584=DEC AMBER
24585=DEC MUMPS
24592=3Com Corporation
28672=Ungermann-Bass download
28673=Ungermann-Bass NIUs
28674=Ungermann-Bass diagnostic/loopback
28675=Ungermann-Bass ??? (NMC to/from UB Bridge)
28677=Ungermann-Bass Bridge Spanning Tree
28679=OS/9 Microware
28681=OS/9 Net?
28704=LRT (England) (now Sintrom)
28720=Racal-Interlan
28721=Prime NTS (Network Terminal Service)
28724=Cabletron
32771=Cronus VLN
32772=Cronus Direct
32773=HP Probe protocol
32774=Nestar
32776=AT&amp;T/Stanford Univ.
32784=Excelan
32787=Silicon Graphics diagnostic
32788=Silicon Graphics network games
32789=Silicon Graphics reserved
32790=Silicon Graphics XNS NameServer
32793=Apollo DOMAIN
32814=Tymshare
32815=Tigan
32821=Reverse Address Resolution Protocol (RARP)
32822=Aeonic Systems
32823=IPX (Novell Netware?)
32824=DEC LanBridge Management
32825=DEC DSM/DDP
32826=DEC Argonaut Console
32827=DEC VAXELN
32828=DEC DNS Naming Service
32829=DEC Ethernet CSMA/CD Encryption Protocol
32830=DEC Distributed Time Service
32831=DEC LAN Traffic Monitor Protocol
32832=DEC PATHWORKS DECnet NETBIOS Emulation
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32833=DEC Local Area System Transport
32834=DEC unassigned
32836=Planning Research Corp.
32838=AT&amp;T
32839=AT&amp;T
32840=DEC Availability Manager for Distributed Systems DECamds
32841=ExperData
32859=VMTP
32860=Stanford V Kernel
32861=Evans &amp; Sutherland
32864=Little Machines
32866=Counterpoint Computers
32869=University of Mass. at Amherst
32870=University of Mass. at Amherst
32871=Veeco Integrated Automation
32872=General Dynamics
32873=AT&amp;T
32874=Autophon
32876=ComDesign
32877=Compugraphic Corporation
32878=Landmark Graphics Corporation
32890=Matra
32891=Dansk Data Elektronik
32892=Merit Internodal
32893=Vitalink Communications
32896=Vitalink TransLAN III Management
32897=Counterpoint Computers
32904=Xyplex
32923=EtherTalk - AppleTalk over Ethernet
32924=Datability
32927=Spider Systems Ltd.
32931=Nixdorf Computers
32932=Siemens Gammasonics Inc.
32960=DCA Data Exchange Cluster
32966=Pacer Software
32967=Applitek Corporation
32968=Intergraph Corporation
32973=Harris Corporation
32975=Taylor Instrument
32979=Rosemount Corporation
32981=IBM SNA Services over Ethernet
32989=Varian Associates
32990=TRFS (Integrated Solutions Transparent Remote File System)
32992=Allen-Bradley
32996=Datability
33010=Retix
33011=AppleTalk Address Resolution Protocol (AARP)
33012=Kinetics
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33015=Apollo Computer
33023=Wellfleet Communications
33026=Wellfleet BOFL
33027=Wellfleet Communications
33031=Symbolics Private
33067=Talaris
33072=Waterloo Microsystems Inc.
33073=VG Laboratory Systems
33079=IPX
33080=Novell Inc
33081=KTI
33087=M/MUMPS data sharing
33093=Vrije Universiteit (NL)
33094=Vrije Universiteit (NL)
33095=Vrije Universiteit (NL)
33100=SNMP
33103=Technically Elite Concepts
33169=PowerLAN
33149=XTP
33238=Artisoft Lantastic
33239=Artisoft Lantastic
33283=QNX Software Systems Ltd.
33680=Accton Technologies (unregistered)
34091=Talaris multicast
34178=Kalpana
34525=IPv6
34617=Control Technology Inc.
34618=Control Technology Inc.
34619=Control Technology Inc.
34620=Control Technology Inc.
34848=Hitachi Cable (Optoelectronic Systems Laboratory)
34902=Axis Communications AB
34952=HP LanProbe test?
36864=Loopback (Configuration Test Protocol)
36865=3Com XNS Systems Management
36866=3Com TCP/IP Systems Management
36867=3Com loopback detection
43690=DECNET
64245=Sonix Arpeggio
65280=BBN VITAL-LanBridge cache wakeups
34915=PPPoe
34916=PPPoe
2056=Frame Relay ARP
16962=IEEE bridge spanning protocol
25944=Bridged Ethernet/802.3 packet
65278=ISO CLNP/ISO ES-IS DSAP/SSAP
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ip.proto

ALIAS_FORMAT=$alias
0=HOPOPT
1=ICMP
2=IGMP
3=GGP
4=IP
5=ST
6=TCP
7=CBT
8=EGP
9=IGP
10=BBN-RCC-M
11=NVP-II
12=PUP
13=ARGUS
14=EMCON
15=XNET
16=CHAOS
17=UDP
18=MUX
19=DCN-MEAS
20=HMP
21=PRM
22=XNS-IDP
23=TRUNK-1
24=TRUNK-2
25=LEAF-1
26=LEAF-2
27=RDP
28=IRTP
29=ISO-TP4
30=NETBLT
31=MFE-NSP
32=MERIT-INP
33=SEP
34=3PC
35=IDPR
36=XTP
37=DDP
38=IDPR-CMTP
39=TP++
40=IL
41=IPv6
42=SDRP
43=IPv6-Rout
44=IPv6-Frag
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45=IDRP
46=RSVP
47=GRE
48=MHRP
49=BNA
50=ESP
51=AH
52=I-NLSP
53=SWIPE
54=NARP
55=MOBILE
56=TLSP
57=SKIP
58=IPv6-ICMP
59=IPv6-NoNx
60=IPv6-Opts
61=AnyHost
62=CFTP
63=AnyNetwork
64=SAT-EXPAK
65=KRYPTOLAN
66=RVD
67=IPPC
68=AnyFile
69=SAT-MON
70=VISA
71=IPCV
72=CPNX
73=CPHB
74=WSN
75=PVP
76=BR-SAT-MO
77=SUN-ND
78=WB-MON
79=WB-EXPAK
80=ISO-IP
81=VMTP
82=SECURE-VM
83=VINES
84=TTP
85=NSFNET-IG
86=DGP
87=TCF
88=EIGRP
89=OSPFIGP
90=Sprite-RP
91=LARP
92=MTP
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93=AX.25
94=IPIP
95=MICP
96=SCC-SP
97=ETHERIP
98=ENCAP
99=AnyPrivate
100=GMTP
101=IFMP
102=PNNI
103=PIM
104=ARIS
105=SCPS
106=QNX
107=A/N
108=IPComp
109=SNP
110=Compaq-Pe
111=IPX-in-IP
112=VRRP
113=PGM
114=AnyHop
115=L2TP
116=DDX
117=IATP
118=STP
119=SRP
120=UTI
121=SMP
122=SM
123=PTP
124=ISIS
125=FIRE
126=CRTP
127=CRUDP
128=SSCOPMCE
129=IPLT
130=SPS
131=PIPE Pr
132=SCTP St
133=FC Fi
134=RSVP-E2E-
255=Reserved
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medium

ALIAS_FORMAT=$alias
1=Ethernet
2=Tokenring
3=FDDI
4=HDLC
5=NetWitness
6=802.11
7=802.11 Radio
8=802.11 AVS
9=802.11 PPI
10=802.11 PRISM
11=802.11 Management
12=802.11 Control
13=DLT Raw
32=Logs
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service

ALIAS_FORMAT=$alias
0=OTHER
20=FTPD
21=FTP
22=SSH
23=TELNET
25=SMTP
53=DNS
67=DHCP
69=TFTP
80=HTTP
110=POP3
111=SUNRPC
119=NNTP
123=NTP
135=RPC
137=NETBIOS
139=SMB
143=IMAP
161=SNMP
179=BGP
443=SSL
502=MODBUS
520=RIP
1024=EXCHANGE
1080=SOCKS
1122=MSN IM
1344=ICAP
1352=NOTES
1433=TDS
1521=TNS
1533=SAMETIME
1719=H.323
1720=RTP
2000=SKINNY
2040=SOULSEEK
2049=NFS
3270=TN3270
3389=RDP
3700=DB2
5050=YAHOO IM
5060=SIP
5190=AOL IM
5222=Google Talk
5900=VNC
6346=GNUTELLA
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6667=IRC
6801=Net2Phone
6881=BITTORRENT
8000=QQ
8002=YCHAT
8019=WEBMAIL
8082=FIX
20000=DNP3
1000000=KERNEL
1000001=USER
1000003=SYSTEM
1000004=AUTH
1000005=LOGGER
1000006=LPD
1000008=UUCP
1000009=SCHEDULE
1000010=SECURITY
1000013=AUDIT
1000014=ALERT
1000015=CLOCK
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tcp.dstport

ALIAS_FORMAT=$value ($alias)
7=echo
9=discard
13=daytime
17=qotd
19=chargen
20=ftp-data
21=ftp
22=ssh
23=telnet
25=smtp
37=time
42=nameserver
43=nicname
53=domain
70=gopher
79=finger
80=http
88=kerberos
101=hostname
102=iso-tsap
107=rtelnet
109=pop2
110=pop3
111=sunrpc
113=auth
117=uucp-path
119=nntp
135=epmap
137=netbios-ns
139=netbios-ssn
143=imap
158=pcmail-srv
170=print-srv
179=bgp
194=irc
389=ldap
443=https
445=cifs
464=kpasswd
512=exec
513=login
514=cmd
515=printer
520=efs
526=tempo
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530=courier
531=conference
532=netnews
540=uucp
543=klogin
544=kshell
556=remotefs
636=ldaps
749=kerberos-adm
993=imaps
995=pop3s
1109=kpop
1433=ms-sql-s
1434=ms-sql-m
1512=wins
1524=ingreslock
1723=pptp
2053=knetd
1122=msn im
1352=notes
1521=tns
1533=sametime
1718=h323
1720=rtp
1863=msn im
2049=nfs
3389=rdp
5050=yahoo im
5060=sip
5190=aim
6346=gnuetella
6667=irc
9001=tor
9030=tor
9535=man
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tcp.srcport

ALIAS_FORMAT=$value ($alias)
7=echo
9=discard
13=daytime
17=qotd
19=chargen
20=ftp-data
21=ftp
22=ssh
23=telnet
25=smtp
37=time
42=nameserver
43=nicname
53=domain
70=gopher
79=finger
80=http
88=kerberos
101=hostname
102=iso-tsap
107=rtelnet
109=pop2
110=pop3
111=sunrpc
113=auth
117=uucp-path
119=nntp
135=epmap
137=netbios-ns
139=netbios-ssn
143=imap
158=pcmail-srv
170=print-srv
179=bgp
194=irc
389=ldap
443=https
445=cifs
464=kpasswd
512=exec
513=login
514=cmd
515=printer
520=efs
526=tempo
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530=courier
531=conference
532=netnews
540=uucp
543=klogin
544=kshell
556=remotefs
636=ldaps
749=kerberos-adm
993=imaps
995=pop3s
1109=kpop
1433=ms-sql-s
1434=ms-sql-m
1512=wins
1524=ingreslock
1723=pptp
2053=knetd
1122=msn im
1352=notes
1521=tns
1533=sametime
1718=h323
1720=rtp
1863=msn im
2049=nfs
3389=rdp
5050=yahoo im
5060=sip
5190=aim
6346=gnuetella
6667=irc
9001=tor
9030=tor
9535=man
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udp.dstport

ALIAS_FORMAT=$value ($alias)
7=echo
9=discard
13=daytime
17=qotd
19=chargen
37=time
39=rlp
42=nameserver
53=domain
67=bootps
68=bootpc
69=tftp
88=kerberos
111=sunrpc
123=ntp
135=epmap
137=netbios-ns
138=netbios-dgm
161=snmp
162=snmptrap
213=ipx
443=https
445=cifs
464=kpasswd
500=isakmp
512=biff
513=who
514=syslog
517=talk
518=ntalk
525=timed
533=netwall
550=new-rwho
560=rmonitor
561=monitor
749=kerberos-adm
1167=phone
1433=ms-sql-s
1434=ms-sql-m
1512=wins
1701=l2tp
1812=radiusauth
1813=radacct
2049=nfsd
2504=nlbs
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Delete a Rule

This topic provides instructions to delete a rule.

Prerequisites

Make sure that you understand the Rule view components. For more information, see Rule View.

Procedure

Perform the following steps to delete a rule:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rulespanel, do one of the following.

l Select a rule and click in the Rule toolbar.

l Click   > Delete.

A confirmation dialog is displayed.

Note: If a rule is being used in a report, a warning that the rule is in use and cannot be
deleted is displayed.

3. Click Yesto delete the rule.
A confirmation message that the rule is deleted successfully is displayed and the selected
rule is deleted from the Rule List panel.

Delete a Rule Group

This topic provides instructions to delete a rule group.

Prerequisites

Make sure that you understand the Rule view components. For more information, see Rule View.

Procedure

Perform the following steps to delete a rule group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rule Groups panel, select the rule group that you want to delete.
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3. Click  .
A confirmation dialog is displayed.

Note: If any one of the rules in the group is being used in reports, a warning that the rule is
in use and cannot be deleted is displayed.

4. Click Yesto delete the group.
A confirmation message that the group is deleted successfully is displayed and the selected
group is deleted from the Rule Groups panel.

Duplicate a Rule

This topic provides instructions to duplicate a rule.

Prerequisites

Make sure that you understand the Rule view components. For more information, see Rule View.

Procedure

Perform the following steps to duplicate a rule:

1. In the Security Analytics menu, click Administration> Reports.
The Manage tab is displayed.

2. In the Rules list panel, select a rule that you want to duplicate.

3. In the Rule toolbar, click  .

The specific rule is duplicated.

Edit a Rule

This topic provides instructions to edit a rule.

Prerequisites

Make sure that you:

l Understand the Rule view components. For more information, see Rule View.

l Understand the Build Rule view components. For more information, see Build Rule View.

Procedure

Perform the following steps to edit a rule:
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1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rules list panel, do one of the following:

l Select a rule and click   in the Rule toolbar.

l Click   > Edit.

The Build Rule view tab is displayed.

Note: If a rule is edited, the updated rule definition is applied to the Reports, Charts,
and Alerts where the rule is included.

3. Modify the required fields.

4. Click Save.
A confirmation message that the rule is saved successfully is displayed.
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When you edit a rule, ensure to re-select the Rule for which you want the Chart to be generated,
so that the edited rule is applied. If you do not re-select the Rule and attempt to save or test the
rule, a warning message is displayed.

Export a Rule

This topic provides instructions to export a rule. You can only export one rule at a time.

Prerequisites

Make sure that:

l You have rules in the rule group.

l You understand the Rule view components. For more information, see Rule View.

Procedure

Perform the following steps to export a rule:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rules list panel, do one of the following:

l Select a rule and click   > Export in the Rule toolbar.

l Click  > Export.

A browser-specific export dialog may be displayed, allowing you to open or save the file.
You can export multiple rules at a time. To select multiple rule, press and hold the CTRL
button and select the rules to be exported.

Note: If you want to export multiple rules, you can do that only by exporting rule groups. For
more information, see Export a Rule Group. 

Export a Rule Group

This topic provides instructions to export a rule group.

Prerequisites

Make sure that:

l You have rules in the rule group.

l You understand the Rule view components. For more information, see Rule View.

Procedure

Perform the following steps to export a rule group:
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1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rule Groups panel, select the rule group containing the rules which you want to
export.
You can export multiple rules groups at a time. To select multiple rule groups, press and hold
the CTRL button and select the rules groups to be exported.

3. Click   >Export.

A browser-specific export dialog may be displayed allowing you to open or save the file.

Import Rules and Rule Groups

The topic provides instructions to import rules and rule groups. You can import rules and rule
groups from a Security Analytics instance into the rule tree in the Rule Groups panel. Rules
must be in a valid binary file exported from a Security Analytics instance. You cannot import
rules to a rule group. The imported files are stored in the root folder, All.

Prerequisites

Make sure that:

l You have the rules or rule groups exported from a Security Analytics instance.

l You understand the Rule view components. For more information, see Rule View.

Procedure

Perform the following steps to import rules or rule groups:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Do one of the following:

l In the Rule Groups panel, click  and select Import.

l In the Rule toolbar, click  and select Import.

The Import Rule dialog is displayed.
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3. Click Browse to browse and select the archived file containing the rules.
You can import multiple rules and rule groups at a time. To select multiple rules or rule
groups, press and hold the CTRL button and select the rules or rules groups to be imported.

4. Click Import.

Note: During the import process, if a duplicate rule and list exists and you do not select
the overwrite option, the rule and list is imported and no message about duplicate rules
and lists are displayed.

View Dependents of a Rule

This topic provides instructions to view dependents of a rule. You must traverse a rule list,
select a rule for which you want to identify the dependency over a report, chart, or alert.

The following figure shows the Rule View where you select the rule 'Access to Compliance
Data Details'. 

The following figure shows the dependency of the rule over alerts and reports.
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The following table lists the various columns in the Rule Dependencies dialog and their
description.

Column Description

Entity Name The name of the entity referencing the rule.

Path The path where the entity is located in the user interface.

Prerequisites

Make sure that you understand the Rule view components. For more information, see Rule View.

Procedure

Perform the following steps to view dependents of a rule:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Rules.
The Rule view is displayed.
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3. In the Rule List panel, click  > Dependents.

The Rule Dependencies dialog is displayed.

Next Steps

You can edit a report, chart or alert.

Manage Access for a Rule or Rule Group
This topic describes the access permissions the user will have depending on the user role to
manage a rule or rule group. The Reporting module provides access control at the rule and rule
group level. Only a user who has the right set of permissions can perform the tasks in the
Reporting module. The access control is managed by the administrator from the Administration
> Security > Roles tab.

When creating users and user roles, administrator must ensure that the roles created for specific
tasks have access to all the permissions higher in the hierarchy of roles.

Rules or Rule Groups can be tied to a specific set of user roles so that when a user logs into
Security Analytics, the only rules they can access are rules accessible to the group to which the
user belongs. Users that belong to a user role with the ‘Read & Write’ access permission have
full access rights on the rule. Further, the access can be tightened so that rules are accessed only
by those who have the ‘Read Only’ access.
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Note: You must at least have ‘Read Only’ permission on a group to view the rules within that
group.

At the rule level, you can set the following access permissions for the user roles in Security
Analytics:

l Read & Write

l Read Only

l No Access

Suppose, you want the Security Analysts to have access to all the rules in a Rule Group, you
can set the permission 'Read & Write' at the Rule Group level. And, if you do not want
the Operator role to have access to a specific set of rules in a rule group, you can set the
permission 'No Access' at the Rule Group level. The permission is set only for the rule group but
not the rules or sub-groups in the Rule Group.

Access Control for a Rule Group

When you want to change the rule group permissions, you must select a rule group and set their
access permissions using the Rule Permissions panel.

Before applying rule group permissions, the default permission set for all the user roles is 'No
Access' permission, and the checkboxes are unchecked. 
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If you want to change the access permission for a specific user role, you must set these at the
rule group level, as shown in the figure.Suppose, you want the Administrators to have access to
all the rules in a Rule Group, you can set the permission 'Read & Write' in the Rule Group
Permissions panel.
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And, you can also apply permissions to sub-groups and rules in the group by selecting the
checkbox.

The two scenarios are explained in brief:

l Scenario 1:Permissions applied to Rule Group/ Sub Group/ Rules based on the user role.

l Scenario 2:Permissions applied to Sub Group and Rules in the Group.

Role (Ana-
lysts)

Permissions applied to Rule Group/
Sub Group/ Rules based on the user

role

Permissions applied to Sub
group and Rules in the

Group

Group  Read & Write Read & Write

Sub Group Read Read & Write - Inherited

Rules Read Read & Write  - Inherited

The access permissions that you set can be applied to subgroups and child objects of this group. 

The Rule Group will be assigned the role of a Security Analyst and permissions are set to Read
& Write rule group.

For scenario 1, each of the levels will have a permission set depending on the user role. For
scenario 2, the permission at the Rule Group level will be inherited by the Sub Group and Rules
in the Group.
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Access Control for a Rule

When you want to change the rule permissions, you must select a rule and set their access
permissions using the Rule Permissions panel.

Before applying the Rule permissions, the default permission set for all the user roles is 'No
Access' permission and the checkbox is unchecked.

If you want to change the access permission for a specific user role, you must set these at the
rule level, as shown in the figure. Suppose, you want the Administrators to have access to a
specific rule, you can set the permission 'Read & Write' in the Rule Permissions panel.
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Access Control for a Rule When Multiple Rules are Selected

When you want to change permissions of multiple rules, you can select multiple rules at a time
and set their access permissions using the Rules Permissions Panel. The access permission that
you choose will be applied to all the selected rules.

Note: The '*' besides the role name indicates the other permissions available on the user role.
If you want to change the access permission for the required user role, select the user role and
change the access permission.
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Login as a specific user and view the access details

When you login to the Security Analytics UI as a user having 'Read access' permission, all the
rules will be denoted with the symbol ( ) and when you click on the symbol the 'Read
Only' callout is displayed on the Rules List panel.

When you login to the Security Analytics UI as a user not having 'Read & Write' access
permission on a Rule, all the rules will be denoted with the symbol ( ) and the rules appear
grayed out on the Rules List panel.

The following figure shows the Rules List panel when logged in with minimal 'Read & Write'
access permission.

Note: If a user (other than ADMIN) creates a rule, ADMIN cannot access that rule.
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Tabular Listing

The following table lists the various columns in the Rules Permissions panel:

Column Description

Roles The role of the user logged into the Security Analytics user

interface.

Read &

Write

The user can access, view, edit, delete,import, and export

rules on the Rules view. The user can also change the per-

mission on the rule.

Read

Only

The user can only access and view the rule on the Rules view

No

Access

The user cannot access or view the rule for which this per-

mission is set.

Topics

l Set Access Control for a Report

l Set Access Control for a Report Group

Set Access Control for a Rule

This topic provides instructions to set access control for a rule. The Reporting module provides
access control at the rule level. Only a user who has the right set of permissions can perform
tasks on the rule. The administrator when creating users and roles, must ensure that the roles
created for specific tasks have access to all the permissions higher in the hierarchy of roles.

At the rule level, you can set the following access permissions for the user roles in Security
Analytics:

l Read & Write – View or edit the rules in the rule group.

l Read Only – View the rules in the rule group.

l No Access – Cannot view or edit the rules in the rule group.

Prerequisites

Make sure that:
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l You have understood the components of the Rule view. For more information, see Rule View.

l You have a minimal 'Read & Write' access permission to set access permissions for a rule. 

Procedure

Perform the following steps to set access control for a rule:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rules list panel, select the rule.

3. Click  > Permissionsin the Rule toolbar.
The Rules Permissions dialog is displayed.

4. Select the following appropriate access permission for the user role and click Save.

l Read & Write

l Read Only

l No Access

Set Access Control for a Rule Group

This topic provides instructions to set access control at the rule group level. Only a user who has
the right set of permissions can perform the tasks on the rule. The administrator when creating
users and roles, must ensure that the roles created for specific tasks have access to all the
permissions higher in the hierarchy of roles.
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At the rule group level, you can set the following access permissions for the user roles in
Security Analytics:

l Read & Write – View or edit the rules in the rule group.

l Read Only – View the rules in the rule group.

l No Access – Cannot view or edit the rule in the rule groups.

Prerequisites

Make sure that:

l You have understood the components of the Rule view. For more information, see Rule View.

l You have a minimal 'Read & Write' access permission to set access permissions for a rule
group. 

Procedure

Perform the following steps to set access control for a rule group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rule Groups panel, select the rule group and do one of the following:

l Click  and select Permissions.

l Right-click the selected rule group and select Permissions.
The Rules Permissions dialog is displayed.
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3. (Optional) Select the appropriate checkbox to apply these permissions to subgroups and child
objects of this group.

4. Click Save.
A confirmation message that permission is successfully set for the selected rule group is
displayed.

Create a Chart Using a Rule
This topic provides instructions to create a chart using a rule.

Prerequisites

Make sure that you:

l Understand the Rule view components. For more information, see Rule View.

l Understand the Build Rule view components. For more information, see Build Rule View.

Procedure

Perform the following steps to create a chart:
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1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Do one of the following:

l You can create a chart using a rule when you create or edit the rule. For more
information, see Define a Rule and Edit a Rule.
Perform the following:

1. In the Build Rule view, click Use.
The Use Rule dialog is displayed.

2. Click Chart.

3. Click Select.

l Select a rule in the Rule List panel and click   in the Rule toolbar. From the drop-

down menu, select Use > Chart.

l In the Rule List panel and click  > Create Chart.

Note: If the rule contains lookup_and_add, sum_count, or sum_values rule action, the
associated chart will not contain any data.

For more information on defining Charts, see Chart Overview.

Create a Report Using a Rule
This topic provides instructions to create a report using a rule. When you create a report using a
rule, a default report is created with this single rule. You can further edit the report to add more
rules.

Prerequisites

Make sure that you:

l Understand the Rule view components. For more information, see Rule View.

l Understand the Build Rule view components. For more information, see Build Rule View.

Procedure

Perform the following steps to create a report using a rule:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.
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2. Do one of the following:

l You can create a report using a rule when you create or edit the rule. For more
information, see Define a Rule and Edit a Rule.
Perform the following:

a. In the Build Rule view, click Use.
The Use Rule dialog is displayed.

b. Click Report.

c. Select New Report or Existing Report based on your requirement.

d. Click Select. 

l Select a rule in the Rule List panel and click   in the Rule toolbar. From the drop-

down menu, select Use > Report.

l In the Rule List panel and click   > Create Report.

Note: Custom rules can be used to create a Report and If you select the view for the rule as
"Area" or "Pie", a window pops up for X-Axis and Y-Axis inputs. By default, you can select
only the first meta in X-Axis.

For more information on defining reports, see Report Overview.

Create an Alert Using a Rule
The topic provides instructions to create an alert using a rule. You cannot create an alert
using IPDB and Warehouse rules.

Prerequisites

Make sure that you:

l Understand the Rule view components. For more information, see Rule View.

l Understand the Build Rule view components. For more information, see Build Rule View.

Procedure

Perform the following steps to create an alert using a rule:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.
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2.  Do one of the following:

l You can create an alert using a rule when you create or edit the rule. For more
information, see Define a Rule and Edit a Rule.
Follow the below steps:

a. In the Build Rule view, click Use.
The Use Rule dialog is displayed.

b. Click Alert.

c. Click Select.

l Select a rule in the Rule List panel and click   in the Rule toolbar. From the drop-

down menu, select Use > Alert.

l Click   > Create Alert.

For more information on defining Alerts, see Alert Overview.
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Report Overview
This topic provides a brief description about a report. A report is a combination of rules and
other formatting objects such as headers and HTML-formatted notes that describe and identify
data pertaining to a particular area of interest. Reports are defined and managed in the Build
Report page and can be scheduled to run on an adhoc or timely basis. Once a report is run,
results are stored centrally and can be automatically sent over email, SFTP, URL, and NFS to
users, viewed via the SA web interface, downloaded as PDF and CSV files.

A report consists of the following:

Property Description Example

Report Name

Note: For Name field, the icon to extend the
column size is not displayed at the end of the
column field. You have to hover the mouse a
little to the left side to see the icon for extending
the column.

Used to identify the report

to schedule them at a later

time.

Report1

Text Pre-defined text fields

used within a report to

make the report more

meaningful to the user.

Header1,

Comment

Rules The rules (queries) used

to create a report.

select user-

.dst

where

ip.src =

10.10.10.1

Note: In the Reporting user interface, the displayed date or time is always according to the
user selected time zone profile.
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Define Report Groups and Reports
This topic is a collection of tasks for configuring Reports Group and Reports. You can define,
delete, edit, import and export report groups and lists in Security Analytics. Individual topics
describe the relevant procedures

Topics:

l Add a Report

l Add a Report Group

l Delete a Report

l Delete a Report Group

l Duplicate a Report

l Edit a Report

l Export a Report

l Export a Report Group

l Import Reports and Report Groups

l Refresh a Group or Report List

l View a List of All Reports

l View a Report

Add a Report

This topic provides instructions on how to add reports.

Prerequisites

Make sure that:

l You have rules defined before you add a report.

l You have understood the components of the Report view. For more information, see Report
View.

l You have understood the components of the Build a Report view. For more information,
see Build Report View.

Procedure

Perform the following steps to add reports to a group or sub-group from the Report panel:

Report Overview 186



Reporting Guide

1. In the Security Analytics menu, click Administration> Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. In the Reporttoolbar, click .

The Build Report tab is displayed.

4. Enter the name of the report.

5. Drag and drop the text and rules to the report.

Note: The text entered is optional and you may need this option only when you want to
display user-defined headers or content.

6. Click Save.
A confirmation message that the report is saved successfully is displayed.

Next Steps

Perform the following tasks:

1. You can edit, delete or refresh a report from the Report panel.

2. You can schedule a report from the Prerequisites view.

Add a Report Group

This topic provides instructions on how to add groups to the default folder or add sub-groups
under a report group. 
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Prerequisites

Make sure you have understood the components of the Report view. For more information, see
Report View.

Procedure

Perform the following steps to add groups to the default folder or add sub-groups under a report
group:

1. In the Security Analytics menu, select Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. In the Report Groups panel, click .

A default group is added in the Report Groups panel.

4. Enter the name of the new group.

5. Press Enter.
The group is added to the Report Groups panel.

Next Steps

You can add reports to the Report group.

Delete a Report

This section provides instructions on how to delete reports in a group or sub-group. 

Prerequisites

Make sure you have understood the components of the Report view. For more information, see
Report View.

Procedure

Perform the following steps to delete reports in a group or sub-group from the Report List panel:

1. In the Security Analytics menu, select Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 
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3. In the Report Listpanel, do one of the following:

o Select the reports and click  .

o Click   >Delete.

A confirmation dialog is displayed:

4. Click Yesto delete the report.
A confirmation message that the report is deleted successfully is displayed and the selected
report is deleted from the Report List panel.

Delete a Report Group

This topic provides instructions on how to delete report groups in the default folder or sub-groups
under a report group.

Prerequisites

Make sure that:

l You have no reports associated with the report group.

l You have understood the components of the Report view. For more information, see Report
View.

Procedure

Perform the following steps to delete report groups in the default folder or sub-groups under a
report group:

1. In the Security Analytics menu, select Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report Groups panel, select the report group and click  .

A confirmation dialog is displayed.
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4. Click Yesto delete the group.
A confirmation message that the group is deleted successfully is displayed and the selected
group is deleted from the Report Groups panel.

Duplicate a Report

This topic provides instructions on how to duplicate a report to schedule multiple report
schedules to schedule the same report. The duplicated report is displayed in the Reports List
panel with suffixes. For example, Report (1). 

Generally, the duplicate option is used in two scenarios:

l You want to make a copy of the report, to move the same report to another group.

l You want to retain most of the configuration settings for an object but modify few of these
settings.
For example, when you have a complex query in a rule or several rules in a report, it is very
much appropriate to use the duplicate option.

Prerequisites

Make sure you have understood the components of the Report view. For more information, see
Report View.

Procedure

Perform the following steps to duplicate an existing report:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report List panel, select a report that you want to duplicate and click  .

The report is saved successfully and added to the Report list.

Next Steps

You can move the duplicated report to another group.
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Edit a Report

This topic provides instructions on how to edit reports in a group or sub-group.

Prerequisites

l You have understood the components of the Report view. For more information, see Report
View.

l You have understood the components of the Build a Report view. For more information,
see Build Report View.

Procedure

Perform the following steps to edit reports in a group or sub-group from the Report List panel:

1. In the Security Analytics menu, select Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.  

3. In the Report List panel, do one of the following:

o Select a report and click .

o Click   > Edit.

The Build Report view tab is displayed.

4. Modify the text and add more rules to the report (if required).

5. Click Save.
A confirmation message that the report is saved successfully is displayed.
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Export a Report

This topic provides instructions on how to export selected reports to an external file that can be
later imported to another Security Analytics environment. 

Prerequisites

Make sure that:

l You have reports in the report group.

l You have understood the components of the Report view. For more information, see Report
View.

Procedure

Perform the following steps to export selected reports in the Report Groups panel to an external
file:

1. In the Security Analytics menu, select Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report List panel, select a report and click   and select one of the following:

l Export - This selection exports a report in a .zip file.

l Export as Text - This selection exports all the content from the Reporting Engine in a
.zip file which contains the data in text format.

4. Click OK.
You can export multiple reports at a time. To select multiple reports, check the checkbox of
the report to be exported. The exported file is saved to the local drive in an archived format.

Opening CSV files with Unicode characters in MS Excel

To open downloaded CSV files containing Unicode characters in MS Excel, follow these steps:

1. Download and save the CSV file.

2. Open Microsoft Excel and navigate to the Data tab.

3. Click on From Text menu item; find the CSV file that you downloaded and click Import.
The Text Import Wizard is displayed.

4. Select Delimitedor Fixed Width data type from the Original data type radio button.

5. Click File origindrop down list and select 65001: Unicode (UTF-8) and click Next.
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6. Select the delimiter that was used in the file that you imported and click Next.

7. Select the data format for each column of data that you want to import and click Finish.
The correct output is displayed in an MS Excel sheet.

Export a Report Group

This topic provides instructions on how to export selected report groups to an external file that
can be later imported to another Security Analytics environment. 

Prerequisites

Make sure that:

l You have reports in the Report Group.

l You have understood the components of the Report view. For more information, see Report
View.

Procedure

Perform the following steps to export selected report groups in the Report Groups panel to an
external file:

1. In theSecurity Analytics menu, select Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report Groups panel, select a report group and click   and select one of the

following:

l Export - This selection exports a report in a .zip file.

l Export as Text - This selection exports all the content from the Reporting Engine in a
.zip file which contains the data in text format.

You can export multiple report groups at a time. To select multiple report groups, press and
hold the CTRL button and select the report groups to be exported. The exported file is saved
to the local drive.

Import Reports and Report Groups

This topic provides instructions on how to import groups containing subgroups and reports from
other instances of Security Analytics into Report Groups panel. Reports must be in a valid binary
file that was exported from another Security Analytics instance.
During the import process, you select the binary file and specify whether existing reports with
the same name must be overwritten or not by the reports contained in the binary import file.
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l If you choose to overwrite, all duplicate rules, lists and reports are overwritten by
the contents of the binary import file.

l If you choose not to overwrite, and a duplicate rule, list or report exists in the target folder,
the import fails and display a message about duplicate reports.

You cannot import reports to a specific report group. The imported files are stored in the Allroot
folder.

Prerequisites

Make sure that:

l You have the reports or report groups exported from other instances of Security Analytics.

l You have understood the components of the Report view. For more information, see Report
View.

Procedure

Perform the following steps to import groups containing subgroups and reports from other
instances of Security Analytics into Report Groups panel:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report Groups panel, select a folder to import the file.

4. Do one of the following:

o In the Report Groups panel, click    > Importto import a group.

o In the Report toolbar, click   > Importto import a report.

The Import Report dialog is displayed. You can import multiple reports and report groups
at a time. To select multiple reports or report groups, press and hold the CTRL button and
select the reports or report groups to be imported.

5. Click Browse to select the binary file.
Security Analytics provides a file system view of the files.

6. Locate the binary file and click Open.
The file gets added to the Import Report list.

7. (Optional) To overwrite any existing rule in the library with an identically named rule in the
binary file when importing, check the Rule checkbox. If you do not select the Overwrite
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option, and an identical rule is encountered in the binary file, the binary file is imported and
no error message is displayed.

8. (Optional) To overwrite any existing list in the library with an identically named list in the
binary file, check the List checkbox. If you do not select the Overwrite option, and an
identical list is encountered in the binary file, the binary file is imported and no error
message is displayed.

9. (Optional) To overwrite any existing report in the library with an identically named report in
the binary file when importing, check the Report checkbox. If you do not select the
Overwrite option, and an identical report is encountered in the binary file, the binary file is
imported and no error message is displayed.

10. Click Import to import the binary file.

Refresh a Group or Report List

This topic provides instructions on how to refresh a report group or reports to view the re-
arrangement of groups or reports. 

Prerequisites

Make sure you have understood the components of the Report view. For more information, see
Report View.

Procedure

Perform the following steps to refresh a report group or reports:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. Do the following to move the group or reports to a new location:

o In the Report Groups panel, drag and drop the group.

o In the Reports List panel, drag and drop the reports to the desired group in the Report
Groups panel.
The report group or reports are moved to the new location.

4. Do the following to refresh a group or report list:

o In the Report Groupspanel, click  .

The report group gets refreshed.
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o In the Report Listpanel, click  .

The Report list gets refreshed.

View a List of All Reports

This topic provides instructions on how to view a list of all reports.

Prerequisites

Make sure that:

l You have understood the components of the Report view. For more information, see Report
View.

l You have understood the components of the View All Reports panel. For more information,
see View All Reports Panel.

Procedure

Perform the following steps to view a list of all reports:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Reportpanel, click View All Reports.
A list of reports along with their schedule name and time are displayed on the View tab.

Note: If no list is displayed, select a date from the calendar to view a list of reports for that
date. 
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4. You can select a scheduled report and print, save as PDF/CSV, send email notifications, or
view it on full screen.

Next Steps

Perform the following tasks:

1. You can print, save, email and view reports on full screen.

2. You can also select a date from the calendar to view a list of successfully run reports for the
chosen date.

View a Report

This topic provides instructions on how to view a report.

Prerequisites

Make sure that:

l You have understood the components of the Report view. For more information, see Report
View.

l You have understood the components of the View a Report panel. For more information,
see View a Report Panel.

Procedure

Perform the following steps to view a report:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.
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2. Click Reports.
The Report view is displayed.

3. In the Report List panel, do one of the following:

l Click   > View Scheduled Reports.

l Click the #Schedules column.
The Schedule Reports view tab is displayed with the status of each of the scheduled
report.

4. Select a scheduled report and click View.
One of the following is displayed:

l The selected report.

l The Sub reports panel for a scheduled report having 'Iterative' selected.

For each value in the configured list a report is displayed.

Note: If the report status is partial or complete, the "last run time stamp" and the "last
run (seconds)" are updated. However, the average time taken to run the report is
updated only when the report status is complete and not when it is partial.

Next Steps

Perform the following tasks:

1. You can print, save, email and view reports on full screen.

2. You can select a date from the calendar to view a list of successfully run reports for the
chosen date.

Schedule a Report

This topic provides instructions on how to schedule a report.  After a report is defined with the
required formatting components and rules, you can configure its execution properties by
scheduling a report. Here, you can quickly view, add, and edit the schedule details for a report.
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When you schedule a Warehouse report, you can use a supported task scheduler to allocate
specific resources in a cluster for the scheduled job. For more information on supported task
schedulers, see Features.

Prerequisites

Make sure that:

l You have understood the components of the Build Report view. For more information, see
Build Report View.

l You have understood the components of the Schedule a Report view. For more information,
see Features.

l If you want to use resource pools, you must set up the pools or queues in Reporting Engine.
For more information, see Step 5: Configure Tast Scheduler for a Reporting Engine topic in
Host and Services Configuration Guide.

Procedure

Perform the following steps to schedule a report:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Build Rulepage, click to create a rule. 

4. Click Save.
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5. Click Use.
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6. Select the New report or Existing Report.

7. Select a report group and click Select.

8. Enter the Report name and select the rule.

9. Click Schedule.
The Schedule Report view is displayed.
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Note: If you provide another user with access permissions to a report, you must also
provide permissions for the report group, the rules used in the report, and the rule
groups otherwise an error message is displayed.

8. To execute the reports as per the schedule, select the Enable checkbox.

9. In the Schedule Name field, enter a name for the schedule report configuration.

10. From the Data Source field, select the data source.

Note: If the data source is not listed, then ensure you have Readpermissions set for the
data source. This is applicable for NWDB and Warehouse data source. For more
information, see Configure Data Source Permissions topic in Host and Service
Configuration Guide.

11. (Optional) From the Warehouse Resource Pool drop-down, select the pools or queues
available in the cluster to schedule the report to run on either the pool or queue. This drop-
down is available only if you select a Warehouse DB report.

Note: All the queues or pools you specified in the Explore page for the Reporting Engine
are listed. If no pools or queues are configured in the Explorer page, this drop-down is
disabled and the jobs are submitted to the clusters without any a queue or pool name. 

Note: If the pool or queue configured in the report schedule is removed from the Cluster,
then in the Capacity Scheduler, the queue name remains undefined. However, in the Fair
Scheduler, the specified pool name will be created using the
property mapred.fairscheduler.allow.undeclared.pool.

12. From the Time Zone drop-down, select a time zone to display all the time-related data in a
report output in the specified format. This setting is configurable from the Reporting Engine
Explore view 
(/com.rsa.soc.re/configuration/reportoutputformatterconfig/reportoutputformatterconfig).

13. From the Run field, select the type of run schedule. (For example, Now or Hourly).
Depending on the type of run schedule, do either of the following:

l If you select a Later orMonthly run schedule, you must provide a value for the day and
time in the respective field provided.

l If you select an Hourly run schedule, you must specify the minutes in the At Minute
field.

l If you select a Daily run schedule, you must enter a value in the At field.
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l If you select a Weeklyrun schedule, you must enter a value in the At field and also select
the week days.

Note:While scheduling a report, if you select Past option or Range (specific/generic) option
or an end time range very close to the current time, you must ensure that the aggregate data in
the data source is returned. If there is an aggregation delay in the data source, the end time
you choose must account for the delay, otherwise reports lose non-aggregate data for that time
range.

For information on how to generate a report with variables, see Use Variables for Parameterized
Reporting.

14. (Optional) In the Output Actions panel, do the following:

a. Type the email address and subject.

b. Edit the body of the message for the report.

c. Select the format of the attachment.

d. Type a value for the CSV and Multi-value delimiters.

e. (Optional) In the Other Options field, do the following:

i. Click  and select SFTP, URL, or Network Share output action.

A row gets added with the selected output action.

ii. Select the appropriate options to send the report in PDF or CSV format, or both to the
RE configured SFTP, or URL, or Network Share output action.

15. (Optional) To add a list in the Dynamic List panel, see Prerequisites section.

16. (Optional) To choose a logo in the Logo panel, see Manage and Select a Report Logo section.

Note: If you do not specify a logo, the default RSA logo will be used. 

17. Click Schedule.
The scheduled report executes as scheduled and provides the configured outputs.
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Next Steps

Perform the following tasks:

1. You can notify the email recipient when the report execution completes and send reports in
PDF and CSV formats as attachments in the email.

2. You can generate a list based on the scheduled report and view them in the Listsmodule.

3. You can send a scheduled report in PDF or CSV format, or both to the RE configured SFTP
location, or URL, or Network Share.

4. You can change the default logo and view them in the scheduled report.

5. You can modify the Security Analytics Reporting Engine config details, by navigating to the
Reporting Engine General Tab. See the Reporting Engine General Tab topic in the Host and
Service Configuration Guide.
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Examples

When you schedule reports in the Schedule Report view, by default, the results for the Past
option are presented based on the user specified time zone. The following examples provide a
clear picture on what results to expect when you select Hours, Days, Weeks, Months, or
Years for the Past option based on the absolute or relative duration.

Note: By default, the relative duration checkbox is de-selected. This implies that the results
for the Past option are presented based on the absolute duration.

Based on Absolute duration:

Absolute Duration allows a report to be scheduled at an absolute time with respect to the current
time, excluding the seconds and considering the time interval as a whole. For example, 12.00pm
is the absolute time with respect to the current time (12.45 pm).

Hours

Suppose that you select Hours and specify one hour. If the current user specified time is
4.20PM, the report is generated for the time range, 3.00PM to 4.00PM.

Days

Suppose that you select Days and specify one day. If the current date is August 27, 2014 and the
current user specified time is 10.15AM, the report is generated for the range: August 26, 2014,
12.00AM to August 27, 2014, 12.00AM.

Weeks

Suppose that you select Weeks and specify one week. If the current date is August 27, 2014
2.30PM and the day is Wednesday, the report is generated for the range: Saturday, August 16,
2014, 12.00AM to Saturday, August 23, 2014, 12.00AM.

Months

Suppose that you select Months and specify one month. If the current date is August 27, 2014
2.30PM, the report is generated for the range:
July 01, 2014, 12.00AM to July 31, 2014, 12.00AM.

Years

Suppose that you select Years and specify one year.If the current date is August 27, 2014
2.30PM, the report is generated for the range:
January 01, 2013, 12.00AM to December 31, 2013, 12.00AM.

207 Report Overview



Reporting Guide

Based on Relative duration:

Relative Duration allows a report to be scheduled at a time relative to the current time which
might vary based on the current time. For example, 12.45 pm is the relative time with respect to
the current time (12.45 pm).

Hours

Suppose that you select Hours and specify one hour. If the current  user specified time is
4.20PM, the report is generated for the time range, 3.20PM to 4.20PM.

Days

Suppose that you select Days and specify one day. If the current date is August 27, 2014 and the
current user specified time is 10.15AM, the report is generated for the range: August 26, 2014,
10.15AM to August 27, 2014, 10.15AM.

Weeks

Suppose that you select Weeks and specify one week. If the current date is August 27, 2014
12.30PM and the day is Wednesday, the report is generated for the range: Thursday, August 21,
2014 12.30PM to Wednesday, August 27, 2014 12.30PM.

Months

Suppose that you select Months and specify one month. If the current date is August 27, 2014,
2.30PM the report is generated for the range:
July 27, 2014 2.30PM to August 27, 2014 2.30PM.

Years

Suppose that you select Years and specify one year.If the current date is August 27, 2014
2.30PM, the report is generated for the range: August 27, 2013 2.30PM to August 27, 2014
2.30PM.

Enable or Disable a Scheduled Report

This topic provides instructions on how to enable or disable a scheduled report.

Prerequisites

Make sure that:

l You have understood the components of the Report view. For more information, see Report
View. 

l You have understood the components of the Scheduled Reports view. For more information,
see Features.
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Procedure

Perform the following steps to enable or disable a scheduled report from the Scheduled Reports
List panel:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report List panel, select a report and click   > View Scheduled Reports.

View Scheduled Reports is displayed.

4. Select a report from the Scheduled Reports List panel.

5. Click  > Enable.
The state of the report is changed to ‘Running’, if the report is scheduled to run immediately.

6. Click   > Disable.
The state of the report is changed to ‘Inactive’.

Generate a List from the Scheduled Report

This topic provides instructions on how to generate a list from the output of the scheduled report.

Prerequisites

Make sure that:

l Your lists are created in Security Analytics prior to generating a list to schedule a report. 

l You have understood the components of the Schedule a Report view. For more information,
see Features.

l You have understood the components of the Dynamic List panel. For more information,
see Features.

Procedure

Perform the following steps to generate a list from the Build Report view:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 
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3. In the Report Listpanel, select a report and click   > Schedule Report.

The Schedule a Report view tab is displayed.

4. In the Dynamic List panel, click .

The Generate List dialog box opens.

5. Click Browse.
The List Selection panel is displayed.

6. Choose a list item and click Select.
The list name gets populated in the List Name field.

7. Select a valid rule to filter the report results further based on the rule definition.

8. Select a value for the Columnfield.
The column forms the values for the list that gets created.

9. If you want to overwrite the existing list, select the Overwrite Existing List? checkbox.

10. Click Save.
The list name gets populated in the Generate List panel.

11. (Optional) Select a list from the Generate List panel and click  to delete the selected list.

12. (Optional) Select a list from the Generate List panel and click  to edit the list details.

Next Steps

You can schedule a report from the Schedule Report panel. For more information, see Features.

Start or Stop a Scheduled Report

This topic provides instructions on how to start or stop a scheduled report.

Prerequisites

Make sure that:
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l You have understood the components of the Report view. For more information, see Report
View.

l You have understood the components of the Schedule Report panel. For more information,
see Features.

Procedure

Perform the following steps to start or stop a scheduled report:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report Listpanel, select a report and click   > View Scheduled Reports.

The View Scheduled Reports view is displayed.

4. Select a report from the Scheduled Reports List panel.

5. Click   > Start.
The state of the report is changed to ‘Running’, if the report is scheduled to run immediately.

6. Click   > Stop.
The state of the report is changed to ‘Completed’.

View an Execution History of a Scheduled Report

This topic provides instructions on how you can view the execution history of a scheduled report.
You can view the history of a scheduled report that is run. You can view the history based on the
following criteria: 

l Number of past schedules executed

l Start date and end date for the date range

You can view the details such as how many times the scheduled report was executed, the time
of execution (seconds), execution state. You can also view the report generated on a full screen. 

Prerequisites

Make sure you have understood the components on the Execution History panel. For more
information, see Features.
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Procedure

Perform the following to view the execution history of a scheduled report:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report List panel, do one of the following:

l Click   > View Scheduled Reports.

l Click the #Schedules column.
The Schedule Reports view tab is displayed with the status of each of the scheduled
report.

4. Do one of the following:

l Select a scheduled report and click  > Execution History.

l Select a scheduled report and click  .

The Execution History view is displayed.

Note: By default, you can view 10 number of execution history of a scheduled report. The
execution history shown depends on the Retain Report History Configuration set on the
Generaltab of the Administration > Services > Reporting Engine Configview.
For example, if you set the Retain Report History Configuration to 100 days, the data
displayed on the Execution History view is the past 100 days execution history details
considering the current date information.

5. From the Get history by: field, select the type of history to be fetched. (For example, Past or
Range (Specific))

6. In the Count field, enter the number of executions to be displayed.

7. Click Show History.
The execution history of the scheduled report is displayed.

View Scheduled Reports

This topic provides instructions on how to view scheduled reports. You must view the scheduled
reports to know the state of the scheduled report. If the scheduled report is in a stop or disable
state, you can start or enable the scheduled report.
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Prerequisites

Make sure that:

l You have understood the components of the Report view. For more information, see Report
View.

l You have understood the components of the Scheduled Reports View. For more information,
see Features.

Procedure

Perform the following to view the scheduled reports:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.

The Report view is displayed. 

3. In the Report List panel, do one of the following:

l Click  > View Scheduled Reports.

l Click the #Schedules column.

The Schedule Reports view tab is displayed with the status for each of the scheduled report.

Note: If the report status is partial or complete, the "last run timestamp" and the "last run
(seconds)" are updated. However, the average time taken to run the report is updated only
when the report status is complete and not when it is partial.

Next steps

Perform the following tasks:

1. You can add, edit and delete, start or stop the scheduled report.

2. You can view all the successfully run reports. For more information, see View All Reports

Panel.

Delete a Scheduled Report

This topic provides instructions on how to delete a scheduled report.

Prerequisites

Make sure that:
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l You have understood the components of Report view. For more information, see Report View.

l You have understood the components of the Schedule Report panel. For more information,
see Features.

Procedure

Perform the following steps to delete a scheduled report from the Scheduled Reports List panel:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report toolbar, click View All Schedules.
View Scheduled Reports is displayed.

4. In the Scheduled Reports Listpanel, select the report.

5. Click    >Delete Schedule.

A confirmation dialog is displayed.

5. Click Yesto delete the scheduled report.
A confirmation message that the scheduled report is deleted successfully is displayed and the
selected schedule is deleted from the Scheduled Reports List panel.

Edit a Scheduled Report

This topic provides instructions on how to edit a scheduled report.

Prerequisites

Make sure that:

l You have understood the components of the Report view. For more information, see Report
View.

l You have understood the components of the Schedule Report panel. For more information,
see Features.

Report Overview 214



Reporting Guide

Procedure

Perform the following steps to edit a scheduled report from the Scheduled Reports List panel:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report List panel, select a report and click   > View Scheduled Reports.

The View Scheduled Reports tab is displayed.

4. In the Scheduled Reports List panel, do one of the following:

l Select a report and click  .

l Select a report and click   > Edit Schedule.
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The Schedule Report tab is displayed.
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5. In the Schedule Report tab, do the following:

a. In the Schedule Name field, modify the name for the schedule report configuration.

b. To execute the reports as per the schedule, select the Enable checkbox.

c. From the Data Source field, select the database.

Note: If the data source is not listed, ensure you have Read permissions set for the
data source. This is applicable for NWDB and Warehouse data source. For more
information, see Configure Data Source Permissions topic in the Host and Services
Configuration Guide.

6. (Optional) From the Warehouse Resource Pool drop-down, select the pool or queue for the
report.

Note: The Warehouse Resource Pool drop- down is displayed only if the Warehouse
Rule is selected. If no pools or queues are entered for the Reporting Engine, this field is
disabled. 

7. From the Run field, select the type of run schedule. (For example, Now or Hourly).

8. Select the date range to run the query based on absolute duration or select the Use relative
time duration checkbox to run the query based on relative duration. 

9. (Optional) In the Output Actions panel, do the following:

i. Type the email address and subject.

ii. Edit the body of the message for the report.

iii. Select the format of the attachment.

iv. Type a value for the CSV and Multivalue delimiters.

10. (Optional) In the Other Options field, do the following:

i. Click  > SFTP or URL or Network Share. Based on the selected option, a row gets

added in the Other options field.

ii. Select the appropriate options to send the report in PDF or CSV format to the
configured SFTP, URL or Network Share.

11. (Optional) To add a list in the Dynamic List panel, see Prerequisites section.

12. (Optional) To choose another logo in the Logo panel, see Manage and Select a Report

Logo section.

Note: If you do not specify a logo, the default RSA logo is used.
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13. Click Schedule.
The scheduled report executes as scheduled and provides the configured outputs.

Manage Access for a Report or Report Group
This section covers the access permissions the user has depending on the user role to manage a
report and report group. The Reporting Module provides access control at the report and report
group level. The user who has the right set of permissions can only perform the tasks in reporting
module. The access control is managed by the administrator from the Administration >
Security > Roles tab.

When creating users and user roles, administrator must ensure that the roles created for specific
tasks have access to all the permissions higher in the hierarchy of roles.

Reports and Report Groups can be tied to a specific set of user roles so that when a user logs
into Security Analytics, the reports with the access rights for the specific user role can be
viewed. Users that belong to a user role with the ‘Read & Write’ access permission can define
reports. Further, the access can be tightened so that reports are accessed only by those who have
the ‘Read Only’ access.

Note: You must have ‘Read Only’ permission on a group to view the reports within that group.

At the report level, you can set the following access permissions for the user roles in Security
Analytics:

l Read & Write

l Read Only

l No Access

Suppose, you want the Security Analysts to have access to all the reports in a Report Group,
you can set the permission 'Read & Write' at the Report Group level. And, if you do not want
the Operator role to have access to a specific set of reports in a report group, you can set the
permission 'No Access' at the Report Group level.

The permission is set only for the report group but not the reports, rules, or sub-groups in the
Report Group.

Access Control for a Report Group

When you want to change the report group permissions, you must select a report group and set
their access permissions using the Reports Permissions panel.

Before applying report group permissions, the default permission set for all the user roles is 'No
Access', except for Administrators, as shown in the figure. 
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If you want to change the access permission for a specific user role, you must set these at the
report group level, as shown in the figure. <suppose,>Administrators to have access to all the
reports in a Report Group, you can set the permission 'Read & Write' in the Report Group
Permissions panel.

And, you can also apply permissions to sub-groups and reports in the group, as well as apply
read-only permission to rules in the reports by selecting the appropriate checkboxes, as shown in
the figure.
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The three scenarios are explained in brief:

l Scenario 1: Permissions applied to Report Group/ Sub Group/ Report based on the user role.

l Scenario 2: Permissions applied to Sub Group and Report in the Group.

l Scenario 3: Read-only permission applied to Rules in the Report.

Role
(Ana-
lyst)

Per-
missions
applied to
Report
Group/
Sub

Group/
Report
based on
the user
role

Per-
missions
applied to

Sub
group and
Report in
the Group 

Per-
mission
(Read-
only)
applied
to Rules
in the
Report

Grou-

p 

Read &

Write

Read &

Write

Read &

Write

Read &

Write
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Sub

Grou-

p

Read Read Read &

Write -

Inherited

Read &

Write

Repo-

rt

Read Read Read &

Write -

Inherited

Read &

Write

Rules Read Read Read Read

The Report Group will be assigned the role of a Security Analyst and permissions are set to
Read & Write report group.

For scenario 1, each of the levels has a permission set depending on the user role. For scenario
2, the permission at the Report Group level (Read & Write) is inherited by the Sub Group and
Reports in the Group. For scenario 3, the Read permission is set for the Rules except that the
permission set for the rules cannot be higher than the permissions set for the Report Group.

Access Control for a Report

When you want to change the report permissions, you must select a report and set their access
permissions using the Report Permissions panel.

Before applying the Report permissions, the default permission set for all the user roles is 'No
Access' permission and the checkbox is unchecked, as shown in the figure.
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If you want to change the access permission for a specific user role, you must set these at the
report level, as shown in the figure. Suppose, you want the Administrators to have access to a
specific report, you can set the permission 'Read & Write' in the Report Permissions panel.

And, you can apply read-only permission to rules in the reports by selecting the checkbox, as
shown in the figure.

The two scenarios are explained in brief:

l Scenario 1: Permissions applied to Report Group/ Sub Group/ Report/ Rules.

l Scenario 2: Read-only permission applied to Rules in the Report.

Role (Ana-
lysts)

Permissions applied to Report
Group/ Sub Group/ Report/ Rules

based on the user role

Permission (Read-
only) applied to Rules

in the Report

Group  Read &

Write

Read & Write Read & Write

Sub

Group

Read Read Read & Write

Report Read Read Read & Write

Rules Read Read Read
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The Report will be assigned the role of a Security Analyst and permissions are set to Read &
Write reports.

For scenario 1, each of the levels has a permission set based on the user role. For scenario 2, the
Read permission is set for the Rules except that the permission for the rules cannot be higher
than the permission for the Reports.

Note: If the permission for the rules is higher than the permission for the Reports then the
permission is be applied. For example, if you set the permissions for the Report Group as No
Access and then specify the option Apply Read-only permission to Rules in the Reports, then
the read-only permission is not set for the rules. 

Access Control for a Report When Multiple Reports are Selected

When you want to change permissions of multiple reports, you must select several reports and
set their access permissions using the Report Permissions panel. The access permission that you
choose is applied to all the selected reports.

Access Control for a Report When Multiple Reports with several rules are Selected

When you want to change permissions when multiple reports with several rules are selected, you
must select the checkbox in the Report Permissions panel, as shown in the figure. The read-only
access permission is applied to all the rules of the selected reports, provided that the permission
of the rules are lower than the permission of the reports.
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Login as a specific user and view the access details

When you login to the Security Analytics UI as a user having 'Read access' permission, all the
reports is denoted with the symbol ( ) and when you click on the symbol the 'Read
Only' callout is displayed on the Report List panel.

When you login to the Security Analytics UI as a user not having 'Read & Write' access
permission on a Report, all the reports are denoted with the symbol ( ) and the reports appear
grayed out on the Report List panel.

The following figure shows the Report List panel when logged in with minimal 'Read & Write'
access permission.

Note:  If a User (other than the super user) creates a report there will be no access to that
report for the super user. 

Tabular Listing

The following table lists the various columns in the Reports Permissions Panel:
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Column Description

Roles The role of the user logged into the Security Ana-

lytics UI.

Read & Write The user can access, view, edit, import, export,

and delete the report on the Reports view. The

user can also change the permission on the report.

Read Only  The user can only access and view the report on

the Reports view.

No Access The user cannot access or view the report for

which this permission is set. 

 Apply these per-

missions to sub-groups

and Reports in this

group

Select the checkbox to apply the selected per-

missions to the report group, sub-groups in the

group and reports in the group.

Note: This checkbox is populated only when
you set access permissions for a Report Group.

 Apply Read-only

permission to Rules in

the Reports

Select the checkbox to automatically apply per-

missions to the rules in the reports.

Topics:

l Set Access Control for a Report

l Set Access Control for a Report Group

Set Access Control for a Report

This topic provides instructions on how to set access control for a report. 

Prerequisites

Make sure that:
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l You have understood the components of the Report view. For more information, see Report
View.

l You have understood the access permissions the user will have depending on the user role.
For more information, see Manage Access for a Report or Report Group.

l You have a minimal 'Read & Write' access permission to set access permissions for a report. 

Procedure

Perform the following steps to set access permissions for a report:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report List panel, select a report.

4. Click  > Permissions.

The Reports Permissions dialog is displayed.

4. Based on the user role, select the appropriate buttons.

5. (Optional) Select the checkbox, if you want to provide read access permission to rules in the
reports.
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Note: On selecting the check box, all dependent rules are given READ access permission,
provided the permissions for the report is higher compared to the permissions of the rules.

6. Click Save.
A confirmation message that the permission is set for the selected report is displayed.

Set Access Control for a Report Group

This topic provides instructions on how to set permissions for a report group. 

Prerequisites

Make sure that:

l You have understood the components of the Report view. For more information, see Report
View.

l You have understood the access permissions the user will have depending on the user role.
For more information, see Manage Access for a Report or Report Group

l You have a minimal 'Read & Write' access permission to set access permissions for a report
group. 

Procedure

Perform the following steps to set access permissions for a Report Group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report Groups panel, select or right-click on a report group.

4. Click   > Permissions.
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The Reports Permissions dialog box is displayed.

4. Based on the user role, select the appropriate buttons.

5. (Optional) Select the appropriate checkbox to apply the selected permissions to sub-groups
and reports in the group.

6. (Optional) Select the appropriate checkbox to provide read access permission to rules in the
reports.

Note: On selecting the check box, all dependent rules is given READ access
permission, provided the permissions for the report is higher compared to the permissions of
the rules.

7. Click Save.
A confirmation message that the permission is successfully set for the selected report group
is displayed.

Investigate a Report
This topic provides instructions on how to investigate a report. You can investigate a report by
directly navigating to the Investigation module from the report. With the Investigate a report
option, you can investigate for each event mentioned in the report.

This topic provides instructions on how to investigate a report. You can investigate a report by
directly navigating to the Investigation module from the report. With the Investigate a report
option, you can investigate for each event mentioned in the report.
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Prerequisites

Make sure that:

l You have understood the components of the Report view. For more information, see Report
View.

l You have understood the components of the View All Reports Panel. For more information,
see View All Reports Panel.

Procedure

Perform the following steps to investigate a report:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. In the Report toolbar, click View All Reports.
The View All Reports tab is displayed.

Note: If no reports are displayed in the View All Reports, select a date for which you
want to display the reports.

4. Double-click the report name to view the report details.
The Report details screen is displayed.

5. Click on an ip.src address on the report to view it in the Investigation module.

Note: If you want to manually copy the result data and use it for investigation, make sure that
the the binary values are prefixed with 'hex:'.
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Next Steps

Perform the following tasks:

1. You can print, save, email, and view reports on full screen.

2. You can select a date from the calendar to view a list of successfully run reports for the
chosen date.

Manage and Select a Report Logo
This topic provides instructions on how to select and manage logos from the Reporting Engine
services configuration view.

Prerequisites

Make sure that you have the RE service defined prior to managing a logo.

Manage Report Logos

To manage logos:

1. In the Security Analytics menu, select Administration > Services.
The Services view is displayed.

2. In the Services List panel, select an RE service and click View > Config.
The Services Config view is displayed.

3. Select the Manage Logos tab.
All the available logos are displayed.

To add a logo:

1. In the Manage Logos tab, click  .

A file browser opens where you can choose the file from the local drive.

2. Select the logo and click Select.

The selected logo gets added to the Manage Logos section.

To delete a logo:

1. In the Manage Logos tab, do one of the following:

l Select the logo and click   .

l Perform (Ctrl+click) to select multiple logos and click  .

A confirmation dialog is displayed.
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2. If you want to delete the logo, click Yes.
The selected logo is deleted from the Manage Logos section.

To set a default logo:

In the Manage Logos tab, select a logo and click  .
The chosen logo is set as the default logo for the RE service.

Select a Logo

This section provides instructions on how to choose logos from the Schedule a Report view.

Prerequisites

l You have understood the components of the Schedule Report panel. For more information,
see Features.

l You have understood the components of the Scheduled Reports View. For more information,
see Features.

l You have understood the fields in the Change a Logo panel. For more information, see Select
a Logo Dialog.

Procedure

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. In the Report List panel, select a report.

4. Click   > View Scheduled Reports.

The View scheduled reports view tab is displayed.

5. Select a scheduled report and click  > Edit Schedule.
The Schedule a Report view tab is displayed.

6. In the Logo panel, click Change Logo.
The Change a Logo dialog box is displayed.

7. Do one of the following:
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l Click Upload new logo to upload another logo.

l Select a logo from the list.

8. Click Select.
The selected logo is available on the Logo panel.

Use Variables for Parameterized Reporting
This topic provides information about using variables for reporting in the RSA Security Analytics
Reporting module. Parameterized reporting allows you to specify values dynamically at runtime
without changing the rule definition so you can view the results based on a particular value. You
can achieve parameterize reporting by using variables in the query or rule. For information on
adding a rule, see Define a Rule. At runtime, you can enter the value for the variable or select the
value from the list based on which the result set is displayed.

The syntax to specify the variable is as follows:

Description
Examples of Supported Syn-
tax

Insert $ before a variable.

Enclose a variable within
braces.

columnname=${<variable>}

The syntax to define the variable is the same for NetWitness DB, IPDB and Warehouse DB
data sources. When you assign the value of the variable in a Run Configuration, you must
enclose the value within single quotes: '<value>'.

Some examples where a variable can be used are provided in this section.

View Source IP Addresses for a Specific Destination Country

The following is an example of a NetWitness DB rule to view the source and destination ip
addresses for a specific destination country. Here the value for source country is defined as a
variable ${local_Country}.
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At runtime, you are prompted to enter the value for the variable. The figure below shows the
local_Country variable where you can enter the value. If you enter the value as United
states, all the source and destination ip addresses with destination country as United states are
listed.
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You can use the above rule to schedule a report. For more information, see Prerequisites. You can
schedule two types of reports:

l Report with Dynamic Variables

l Iterative Report

Report with Dynamic Variables

Dynamic variables allows the user to specify the values for a variable defined in a rule while
scheduling a report.

To schedule a report with Dynamic Variable:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. On the Build Report page, click to create a report.

4. Add the rule which has the user defined variable from the Rules tab.

5. Click Schedule.
The Schedule Report view tab is displayed.
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6. To execute the reports as per the schedule, select the Enable checkbox.

7. In the Schedule Name field, enter a name for the schedule report configuration.

8. From the Data Source field, select the data source.

Note: If the data source is not listed, then ensure you have Read permissions set for the
data source. This is applicable for NWDB and Warehouse data source. For more
information, see Configure Data Source Permissions in the Reporting Engine
Configuration Guide.

9. (Optional) From the Warehouse Resource Pool drop-down, select the pools or queues
available in the cluster to schedule the report to run on either the pool or queue. This drop-
down is available only if you select a Warehouse DB report.
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Note: All the queues or pools you specified in the Explore page for the Reporting Engine
are listed. If no pools or queues are configured in the Explorer page, this drop-down is
disabled and the jobs are submitted to the clusters without any a queue or pool name.

Note: If the pool or queue configured in the report schedule is removed from the Cluster,
then in the Capacity Scheduler, the queue name remains undefined. However, in the Fair
Scheduler, the specified pool name will be created using the property
mapred.fairscheduler.allow.undeclared.pool.

10. From the Time Zone drop-down, select a time zone to display all the time-related data in a
report output in the specified format.This setting is configurable from the Reporting Engine
Explore view
(/com.rsa.soc.re/configuration/reportoutputformatterconfig/reportoutputformatterconfig).

11. From the Run field, select the type of run schedule. (For example, Now or Hourly).
Depending on the type of run schedule, do either of the following:

l If you select a Later orMonthly run schedule, you must provide a value for the day and
time in the respective field provided.

l If you select an Hourly run schedule, you must specify the minutes in the At Minute
field.

l If you select a Daily run schedule, you must enter a time value in the At field.

l If you select a Weekly run schedule, you must enter a value in the At field and also
select the week days.

Note:While scheduling a report, if you select Paste option or Range (specific/generic)
option or an end time range very close to the current time, you must ensure that the
aggregate data in the data source is returned. If there is an aggregation delay in the data
source, the end time you choose must account for the delay, otherwise reports lose non-
aggregate data for that time range.

12. In the variables field, click .

13. Do one of the following:

l Enter the value for the variable, or

l Choose the list value for the variable.
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14. Click Select.

15. Click Schedule.

The scheduled report executes as scheduled and provides the configured outputs.
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View All Destination IP Addresses for a Source IP Address

The following is an example of a Warehouse rule to view all the destination IP addresses for a
specific source IP. The source IP address ip_src is defined as a variable ${IP_Address}.

At runtime, you are prompted to enter the source IP address. The figure below shows the IP_
Address variable, and you can enter a valid source IP address. All the destination IP
addresses with the specified source IP are listed.
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Associate a Variable to a List of Values

You can associate the variable to a list. For example, you can create a list called Local_
Country and enter all the country names as values. You can select the list Local_Country
as the value for the variable Local_Country. At Run Configuration, the Local_Country
list is populated and you can select the country based on which results are displayed.
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IPDB Rule to View Device Details Based on the Device Name

The following is an example of a IPDB rule to view the details of a device based on the device
name. In the event source specification the device name is specified as a variable ${Device_
Name}.
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At runtime, you are prompted to enter the device name Device_Name. The figure below
shows the Device_Name variable and you can enter the event source specification, for
example, NIC:ESIPDB:ESIPDB-ES:ciscopix:111.111.111.25. All the device
details are displayed.
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Iterative Report

An iterative report generates a report for every value in the list.

To schedule an iterative report:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. On the Build Report page, click to create a report.

4. Add the rule which has the user defined variable from the Rules tab.

5. Click Schedule.
The Schedule Report view tab is displayed.
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6. To execute the reports as per the schedule, select the Enable checkbox.

7. In the Schedule Name field, enter a name for the schedule report configuration.

8. From the Data Source field, select the data source.

Note: If the data source is not listed, then ensure you have Read permissions set for the
data source. This is applicable for NWDB and Warehouse data source. For more
information, see Configure Data Source Permissions in the Reporting Engine
Configuration Guide.

9. (Optional) From the Warehouse Resource Pool drop-down, select the pools or queues
available in the cluster to schedule the report to run on either the pool or queue. This drop-
down is available only if you select a Warehouse DB report.
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Note: All the queues or pools you specified in the Explore page for the Reporting Engine
are listed. If no pools or queues are configured in the Explorer page, this drop-down is
disabled and the jobs are submitted to the clusters without any a queue or pool name.

Note: If the pool or queue configured in the report schedule is removed from the Cluster,
then in the Capacity Scheduler, the queue name remains undefined. However, in the Fair
Scheduler, the specified pool name will be created using the property
mapred.fairscheduler.allow.undeclared.pool.

10. From the Time Zone drop-down, select a time zone to display all the time-related data in a
report output in the specified format. This setting is configurable from the Reporting Engine
Explore view
(/com.rsa.soc.re/configuration/reportoutputformatterconfig/reportoutputformatterconfig).

11. From the Run field, select the type of run schedule. (For example, Now or Hourly).
Depending on the type of run schedule, do either of the following:

l If you select a Later orMonthly run schedule, you must provide a value for the day and
time in the respective field provided.

l If you select an Hourly run schedule, you must specify the minutes in the At Minute
field.

l If you select a Daily run schedule, you must enter a time value in the At field.

l If you select a Weekly run schedule, you must enter a value in the At field and also
select the week days.

Note:While scheduling a report, if you select Paste option or Range (specific/generic)
option or an end time range very close to the current time, you must ensure that the
aggregate data in the data source is returned. If there is an aggregation delay in the data
source, the end time you choose must account for the delay, otherwise reports lose non-
aggregate data for that time range.

12. In the variables field, do the following:

a. To run iterative reports, select the Iterative Report checkbox.

b. To Iterate on List value, click .
The List Selection Window opens.

c. Choose a list and click Select.
The list item selected gets added to the Iterate on List field.
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d. Select the variable on which the selected list value has to be applied.

13. Click Schedule.
The scheduled report executes as scheduled and provides the configured outputs.

The following figure shows the Iterative Report view.
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Working with Charts in the Reporting Module
The Charts module in Reporting module is used to define and view charts.

Topics

l Chart Overview

l Define Chart Groups and Charts

l Manage Access for a Chart or Chart Group

l Test a Chart

l Investigate a Chart

Chart Overview
Any rule in the Security Analytics system which is not sorted by none can be used to instantly
create a chart. In Security Analytics, the chart interval can be adjusted from the chart definition
panel itself. Each time a chart runs, it stores its result data locally in the Reporting Engine, so
that it can be reviewed in either the Dashboard View or Chart View without any performance
considerations. The following section details how charts are created, configured and added to
the global chart queue to generate data.
A chart consists of the following:

Property Description Example

Chart Name

Note: For Name field, the icon to extend the column size
is not displayed at the end of the column field. You have to
hover the mouse a little to the left side to see the icon for
extending the column.

Used to identify

the chart.

Chart1

Rule Basis Identifies the rule

path chosen from

the folder hier-

archy.

Note: In the Reporting user interface, the output for the field where Date and Time are
displayed is always according to the user selected time zone profile.
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Define Chart Groups and Charts
This topic is a collection of tasks for configuring Charts Groups and Charts. You can define,
delete, edit, import and export charts in Security Analytics. Individual topics describe the
relevant procedures.

Topics:

l Add a Chart

l Add a Chart Group

l Delete a Chart

l Delete a Chart Group

l Disable a Chart

l Drag and Drop a Chart to a Group

l Duplicate a Chart

l Edit a Chart

l Enable a Chart

l Export a Chart

l Export a Chart Group

l Import Charts and Chart Groups

l Refresh a Group or Chart List

l Search an Existing Chart

l View All Charts List

l View a Chart

Add a Chart

Use Variables for Parameterized Reporting

This topic provides instructions on how to add charts to a group or sub-group.

Prerequisites

Make sure that:
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l You have rules defined before you add a chart.

l You have understood the components of Build Chart view. For more information, see Build
Chart View.

Procedure

Perform the following steps to add charts to a group or sub-group:

1. In the Security Analytics menu, select Administration > Reports.
The Manage tab is displayed.

2. Click Charts to display the Chart view.

3. In the Chart toolbar, click  .

The Build Chart tab is displayed.

4. Enter the name of the chart.

5. For the Reporting Engine to collect the data and generate chart results, select the Enable
checkbox.

6. In the Rule Basis field, do the following:

Note: If the rule contains lookup_and_add, sum_count, or sum_values rule action, the
associated chart does not have any data.

a. Click Browse. The Add Rule dialog box is displayed.

b. Navigate the Rule tree and select a rule.

c. Click Select.
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7. The Rule appears in the Rule Basis field.

8. Select the data source from the Data Source drop-down list.

Note: If the data source is not listed, ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse data source. For more
information, see Configure Data Source Permissions topic in the Host and Services
Configuration Guide.

9. To modify (Optional) the Interval value, click the up or down arrow.
The Interval value is the interval in minutes at which the rule which forms the basis of the
chart is run to collect data.

10. Select the Limit value to limit the number of records to be displayed.

11. X-Axis and Y-Axis are used to specify the meta to be plotted in charts.
In X-Axis, the Meta for the 'Group by' rule is displayed. In Y-Axis, the aggregate functions
used in the rule are displayed.

Note: Sum, Count, Countdistinct and Average are the supported aggregate functions for
chart. By default, for Custom Rules with multiple 'Group by', you can select only the
first meta in X-Axis.

12. Click Save.
A confirmation message that the chart is saved successfully is displayed.

Next Steps

Perform the following tasks:

l You can edit, delete, refresh a chart from the Charts panel.

l You can test a chart from the Test a Chart View.

Add a Chart Group

This topic provides instructions on how to add groups to the default folder or add sub-groups
under a chart group. You can organize your charts under these folders and sub-folders. 

Prerequisites

Make sure you have understood the components of the Chart view. For more information, see
Chart View.

Procedure

Perform the following steps to add groups to the default folder or add sub-groups under a chart
group: 
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1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart Groups panel, click click  .

A default group is added in the Chart Groups panel.

4. Enter the name of the new group.

5. Press Enter.
The group is added to the Chart Groups panel.

Next Steps

You can add charts to the Chart group.

Delete a Chart

This topic provides instructions on how to delete charts in a group or sub-group.

Prerequisites

Make sure you have understood the components of the Chart view. For more information, see
Chart View.

Procedure

Perform the following steps to delete charts in a group or sub-group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart List panel, do one of the following:

o Select the charts and click .

o Click   > Delete.

A confirmation asks is you want to delete the selected chart.

4. Click Yesto delete the chart.
A confirmation message that the chart is deleted successfully is displayed and the selected
chart is deleted from the Chart List panel.
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Delete a Chart Group

This topic provides instructions on how to delete chart groups in the default folder or sub-groups
under a chart group.

Prerequisites

Make sure that:

l You have no charts associated with the chart group.

l You have understood the Chart view. For more information, see Chart View.

Procedure

Perform the following steps to delete chart groups in the default folder or sub-groups under a
chart group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart Groups panel, select the group and click  .

A confirmation dialog asks for confirmation on that you want to delete the selected group.

4. Click Yes to delete the group.
The selected group is deleted from the Chart Groups panel.

Disable a Chart

This topic provides instructions on how to de-activate a chart. By de-activating a chart, the
scheduled chart is de-activated with a confirmation message and the state of the chart is
changed to ‘Closed’. 

Prerequisites

Make sure you have understood the components of the Chart view. For more information, see
Chart View.

Procedure

Perform the following steps to disable a chart:

1. In the Security Analytics menu, click Administration> Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.
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3. In the Chart List panel, select a chart or several charts that display   in

the Enabled column.

4. Click  . 

A confirmation message indicates that the chart(s) status is changed successfully.

Drag and Drop a Chart to a Group

This topic provides instructions on how to drag and drop a chart from the Chart List panel to a
group in the Chart Groups panel.

Prerequisites

Make sure you have understood the components of the Chart view. For more information, see
Chart View.

Procedure

Perform the following steps to drag and drop a chart from the Charts List panel to a group in the
Charts Groups panel:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Select a chart from the Chart List panel and drag and drop the chart to a group in the Chart
Groups panel.
The chart gets copied to the group in the Chart Groups panel.

Duplicate a Chart

This topic provides instructions on how to duplicate an existing chart. The duplicated chart is
displayed in the Chart List Panel with suffixes. For example, Chart(1).

Prerequisites

Make sure you have understood the components of the Chart view. For more information, see
Chart View.

Procedure

Perform the following steps to duplicate an existing chart:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.
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2. Click Charts.
The Chart view is displayed.

3. From the Chart List panel, select a chart to be duplicated.

4. In the Chart toolbar, click  .

The chart is duplicated and gets added to the Chart List panel.

Next Steps

You can move the duplicate chart to another group. For more information, see Drag and Drop a
Chart to a Group.

Edit a Chart

This topic provides instructions on how to edit charts in a group or sub-group. 

Prerequisites

Make sure you have understood the components of the Build Chart view. For more information,
see Build Chart View.

Procedure

Perform the following steps to edit charts in a group or sub-group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart List panel, do one of the following:

l Double-click a chart or select a chart and click  .

l Select a chart and click   > Edit.
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The Build Chart view tab is displayed.

4. Modify the name of the chart.

5. For the Reporting Engine to collect the data and generate chart results, select the Enable
checkbox.

6. (Optional) In the Rule Basis field, do the following:

a. Click Browse.
The Add Rule dialog  is displayed.

b. Navigate the Rule tree and select a rule.

c. Click Select.
The Rule appears in the Rule Basis field.

7. Select the data source from the Data Source drop-down list.

Note: If the data source is not listed, then ensure you have Read permissions set for the
data source. This is applicable for NWDB and Warehouse data source. For more
information, see Configure Data Source Permissions topic in the Host and Services
Configuration Guide.

8. (Optional) To modify the Interval value, click the up or down arrows.

9. Select the limit value to limit the number of records to be displayed.

10. Click Save.
A confirmation message that the chart is edited successfully is displayed.
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Enable a Chart

This topic provides instructions on how to activate a chart. By activating a chart, the chart
executes as scheduled and provides the configured output with the state of the chart changed to
‘Running’. 

Note: By default, the chart is activated when the chart is added to the Chart List panel.

Prerequisites

Make sure you have understood the components of Chart view. For more information, see Chart
View

Procedure

Perform the following steps to enable a chart:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed. 

3. In the Chart List panel, select a chart or several charts that display   in

the Enabled column.

4. Click  .

A confirmation message indicates that the chart(s) state is changed successfully.

Export a Chart

This topic provides instructions on how to export selected charts to an external file that can be
later imported to another Security Analytics environment. 

Prerequisites

Make sure you have charts listed in the chart group.

Procedure

Perform the following steps to export selected charts to an external file:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.
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3. In the Chart List panel, select a chart and click  and do one of the following:

o Export - This selection exports a chart in a .zip file.

o Export as Text - This selection exports all the content from the Reporting Engine in a
.zip file which contains the data in text format.

You can export multiple charts at a time. To select multiple charts, check the checkbox of
the chart to be exported. The exported file is saved to the local drive.

Export a Chart Group

This topic provides instructions on how to export selected chart groups to an external file that
can be later imported to another Security Analytics environment. 

Prerequisites

Make sure you have charts listed in the Chart Group.

Procedure

Perform the following steps to export selected chart groups 

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart Groups panel, select a chart group and click    and do one of the following:

o Export - This selection exports a chart in a .zip file.

o Export as Text - This selection exports all the content from the Reporting Engine in a
.zip file which contains the data in text format.

You can export multiple chart groups at a time. To select multiple chart groups, press and hold
the CTRL button and select the chart groups to be exported. The exported file is saved to the
local drive.

Import Charts and Chart Groups

This topic provides instructions on how to import charts containing subgroups and charts from
other instances of Security Analytics into Chart Groups Panel. Charts must be in a valid binary
file that was exported from another Security Analytics instance.

During the import process, you select the binary file, and specify whether or not existing charts
with the same name should be overwritten by charts contained in the binary import file.
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l If you choose to overwrite, all duplicate rules, lists, and charts are overwritten by the contents
of the binary import file.

l If you choose not to overwrite, and a duplicate rule, list, or chart exists in the target folder,
the import will still happen and no message about duplicate charts is displayed.

Prerequisites

Make sure you have charts or chart groups exported from other instances of Security Analytics.

Procedure

Perform the following steps to import charts from other instances of Security Analytics:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. From the Chart Groups panel, select a folder to import the file.

4. Do one of the following:

o In the Chart Groups panel, click    > Import.

o In the Chart toolbar, click   > Import.

The Import Chart dialog box is displayed. You can import multiple charts and chart
groups at a time. To select multiple charts or chart groups, press and hold the CTRL
button and select the charts or chart groups to be imported.

5. Click Browse to select the binary file.
Security Analytics provides a file system view of the files.

6. Locate the binary file and click Open.
The file is added to the Import Chart list.

7. (Optional) To overwrite any existing rule in the library with an identically named rule in the
binary file when importing, check the Rule checkbox. If you do not select the Overwrite
option, and an identical rule is encountered in the binary file, the binary file is imported and
no error message is displayed.

8. (Optional) To overwrite any existing list in the library with an identically named list in the
binary file, check the List checkbox. If you do not select the Overwrite option, and an
identical list is encountered in the binary file, the binary file is imported and no error
message is displayed.
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9. (Optional) To overwrite any existing chart in the library with an identically named chart in
the binary file when importing, check the Chart checkbox. If you do not select the
Overwrite option and an identical chart is encountered in the binary file, the binary file is
imported and no error message is displayed.

10. Click Import to import the binary file.

Refresh a Group or Chart List

This topic provides instructions on how to refresh a chart group or charts to view the re-
arrangement of groups or charts. 

Procedure

Perform the following steps to refresh a chart group or charts:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Follow one of the below procedures:

l In the Chart Groups panel, drag and drop the group.
The chart group is moved to the new location.

l In the Chart List panel, drag and drop the charts to the desired group in the Chart Groups
panel.
The charts are moved to the new location.

4. Do the following:

o In the Chart Groups panel, Click  .

The chart group gets refreshed.

o In the Chart List panel, Click .

o In the Chart Toolbar panel, select Auto Refresh.
The Chart list gets refreshed.

Search an Existing Chart

This topic provides instructions on how to search an existing chart by entering text as a substring
in the search box of the Chart toolbar.
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Prerequisites

Make sure you have charts defined before you perform this task.

Procedure

Perform the following steps to search for an existing chart:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart toolbar, enter a text in the Search textbox.

4. Click  > Chart.

The charts with the substring in their name are displayed in the search drop-down list.

View All Charts List

This topic provides instructions on how to view all charts list.

Procedure

Perform the following steps to view all charts list:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart toolbar, click View All Charts.
All the executed charts for the selected date are displayed in a new tab.
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Note:
* If no list is displayed, you can select a date from the calendar to view a list of charts. 
* If you want to view a specific chart, enter the chart name in the search criteria.

4. Click the chart name to view the chart details for that date.

View a Chart

This topic provides instructions on how to view a chart.

Prerequisites

Make sure you have understood the components of the View a Chart panel. For more
information, see View a Chart Panel.
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Procedure

Perform the following steps to view a chart:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart List panel, do one of the following:

o Select a chart and click   > View.

o Select a chart and click View from the View Chart column.
The View Chart view tab is displayed.

4. In Chart Options, do the following:

a. Select the Time Range.

Note:When you select the Time Range option, you can select a pre-set time range such as
last hour, last 3 hours and so on or you can customize the selection by choosing Last N Days
or Custom. If you select Last N Days option, you can view the historical data for a maximum
of 15 days. Whereas, if you select the Custom option, you can select a start date and end date
to view the data for the selected date range.

b. Select the Series, either Chart Values over Time or Chart with Totals.
When you select Chart Values over Time, the chart displays the change in values for the
selected time. When you select Chart with Totals, the chart displays a total for each
aggregate value for the selected time.

c. Select Items to Plot.
The number of events you want to view on the chart.

d. From the Chart Type drop-down list, select the chart type.

e. Click Reload to reload the selected chart.
If there is a delay in retrieving the historical data for the selected time range, a message
is displayed.
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After the chart is generated, a notification is displayed in the notification tray available in the
Security Analytics toolbar. For more information on the Security Analytics toolbar, see Browser
Window topic in the Security Analytics Getting Started Guide.

Manage Access for a Chart or Chart Group
This guide describes the Alert feature in Reporting module. The Alerts module is used to define
and view alerts.

This section covers the access permissions the user has depending on the user role to manage a
chart and chart group. The Reporting Module provides access control at the chart and
chart group level. The user who has the right set of permissions can only perform the tasks in
reporting module. The access control is managed by the administrator from the Administration
> Security > Roles tab.

The administrator when creating users and user roles, must ensure that the roles created for
specific tasks should have access to all the permissions higher in the hierarchy of roles.

Charts and Chart Groups can be tied to a specific set of user roles so that when a user logs into
Security Analytics, the charts with the access rights for the specific user role can be
viewed. Users that belong to a user role with the ‘Read & Write’ access permission can define
charts. Further, the access can be tightened so that charts are accessed only by those who have
the ‘Read Only’ access.

Note: You must have ‘Read Only’ permission on a group to view the charts within that group.

At the chart level, you can set the following access permissions for the user roles in Security
Analytics:
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l Read & Write

l Read Only

l No Access

Suppose, you want the Security Analysts to have access to all the charts in a Chart Group, you
can set the permission 'Read & Write' at the Chart Group level. And, if you do not want
the Operator role to have access to a specific set of charts in a chart group, you can set the
permission 'No Access' at the Chart Group level.

The permission is set only for the chart group but not the charts, rules or sub-groups in the Chart
Group.

Access Control for a Chart Group

When you want to change the chart group permissions, you must select a chart group and set
their access permissions using the Charts Permissions panel.

Before applying chart group permissions, the default permission set for all the user roles is 'No
Access' permission, and the checkboxes are unchecked.
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If you want to change the access permission for a specific user role, you must set these at the
chart group level, as shown in the figure. Suppose, you want the Administrators to have access
to all the charts in a Chart Group, you can set the permission 'Read & Write' in the Charts
Group Permissions panel.

And, you can also apply permissions to sub-groups and charts in the group, as well as apply
read-only permission to rules in the charts by selecting the appropriate checkboxes.

The three scenarios are explained in brief:

l Scenario 1: Permissions applied to Chart Group/ Sub Group/ Chart based on the user role.

l Scenario 2: Permissions applied to Sub Group and Chart in the Group.

l Scenario 3: Read-only permission applied to Rules in the Chart.

Role
(Ana-
lyst)

Permissions applied to
Chart Group/ Sub

Group/ Chart based on
the user role

Permissions
applied to Sub
group and Chart
in the Group

Permission
(Read-only)

applied to Rules
in the Chart

Group  Read &

Write

Read & Write Read & Write Read & Write
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Sub

Group

Read Read Read & Write -

Inherited

Read & Write

Chart Read Read Read & Write -

Inherited

Read & Write

Rules Read Read Read Read

The Chart Group are assigned the role of a Security Analyst and permissions are set to Read &
Write chart group.

For scenario 1, each of the levels will have a permission set depending on the user role. For
scenario 2, the permission at the Chart Group level will be inherited by the Sub Group and
Charts in the Group. For scenario 3, the Read permission is set for the Rules except that the
permission set for the rules cannot be higher than the permissions set for the Chart Group.

Access Control for a Chart

When you want to change the chart permissions, you must select a chart and set their access
permissions using the Chart Permissions panel.

Before applying the Chart permissions, the default permission set for all the user roles is 'No
Access' permission and the checkbox is unchecked.
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If you want to change the access permission for a specific user role, you must set these at the
chart level, as shown in the figure. Suppose, you want the Administrators to have access to a
specific chart, you can set the permission 'Read & Write' in the Charts Permissions panel.

And, you can apply read-only permission to rules in the charts by selecting the checkbox.
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The two scenarios are explained in brief:

l Scenario 1: Permissions applied to Chart Group/ Sub Group/ Chart/ Rules based on the user
role.

l Scenario 2: Read-only permission applied to Rules in the Chart.

Role
(Ana-
lyst)

Permissions applied to Chart
Group/ Sub Group/ Chart/

Rules based on the user role

Permission (Read-
only) applied to

Rules in the Chart

Group  Read &

Write

Read & Write Read & Write

Sub

Group

Read Read Read & Write

Chart Read Read Read & Write
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Rules Read Read Read

The Chart will be assigned the role of a Security Analyst and permissions are set to Read &
Write charts.

For scenario 1, each of the levels has a permission set based on the user role. For scenario 2, the
Read permission is set for the Rules except that the permission for the rules cannot be higher
than the permission for the Charts.

Note: If the permission for the rules is higher than the permission for the Chart, the permission
is not applied. For example, if you set the permissions for the Report Group as No Access and
specify the option Apply Read-only permission to Rules in the Reports, the read-only
permission is not set for the rules. 

Access Control for a Chart When Multiple Charts are Selected

When you want to change permissions of multiple charts, you must select several charts and set
their access permissions using the Charts Permissions panel. The access permission that you
choose is applied to all the selected charts.

Access Control for a Chart When Multiple Charts with Several Rules are Selected

When you want to change permissions when multiple charts with several rules are selected, you
must select the checkbox in the Charts Permissions panel.
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The read-only access permission is applied to all the rules of the selected charts, provided that
the permission of the rules are lower than the permission of the charts.

Note:  If a user (other than the super user) creates a chart, the super user cannot access that
chart. 

Tabular Listing

The following table lists the various columns in the Charts Permissions panel.

Column Description

Roles The role of the user logged into the Security Analytics UI.

Read & Write The user can access, view, edit, import, export, and delete

the chart on the Charts view. The user can also change the

permission on the chart.

Read Only  The user can only access and view the chart on the Charts

view.

No Access The user cannot access or view the chart for which this per-

mission is set. 
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Column Description

 Apply these per-

missions to sub-groups and

Charts in this group

Select the checkbox to apply the selected permissions to the

chart group, sub-groups in the group and charts in the group.

Note: This checkbox is populated only when you set
access permissions for a Chart Group.

 Apply Read-only per-

mission to Rules in the

Charts

Select the checkbox to automatically apply permissions to

the rules in the charts.

Topics

l Set Access Control for a Chart

l Set Access Control for a Chart Group

Set Access Control for a Chart

This topic provides instructions on how to set access control for a chart.

Prerequisites

Make sure that:

l You have understood the access permissions the user will have depending on the user role.
For more information, see Manage Access for a Chart or Chart Group.

l You have a minimal 'Read & Write' access permission to set access permissions for a chart. 

Procedure

Perform the following steps to set access permissions for a chart:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart List panel, select a chart.
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4. Click  > Permissions.

The Charts Permissions dialog box is displayed.

5. Based on the user role, select the appropriate buttons.

6. (Optional) Select the checkbox if you want to provide read access permission to dependent
rules.

Note: On selecting the check box, all dependent rules with No access permission are
granted a READ access permission.

6. Click Save.
A confirmation message that the permission is successfully set for the selected chart is
displayed.

Set Access Control for a Chart Group

This topic provides instructions on how to set permissions for a chart group. 

Prerequisites

Make sure that:
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l You have understood the access permissions the user will have depending on the user role.
For more information, see Manage Access for a Chart or Chart Group.

l You have a minimal 'Read & Write' access permission to set access permissions for a chart
group. 

Procedure

Perform the following steps to set access permissions for a chart group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart Groups panel, select a chart group.

4. Click   > Permissions.

The Charts Permissions dialog box is displayed.

5. Based on the user role, select the appropriate buttons.
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6. (Optional) Select the appropriate checkbox to apply these permissions to sub-groups and
charts in the group.

7. (Optional) Select the appropriate checkbox to provide read access permission to dependent
rules.

Note: On selecting the check box, all dependent rules with No access permission will be
given READ access permission.

7. Click Save.
A confirmation message 'The permission is successfully set for the selected chart group' is
displayed.

Test a Chart
This topic provides instructions on how to test a chart based on the time range and the chart type
selected.

Prerequisites

Make sure you have understood the components of the Test a Chart view. For more
information, see Test a Chart View.

Procedure

Perform the following steps to test a chart:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Do one of the following:

o In the Chart toolbar, click  .

o In the Chart panel, double-click a chart or select a chart and click .

o In the Chart List panel, click   > Edit.

The Build Chart view tab is displayed.

4. Click Test Chart to view the chart.
The View Chart view tab is displayed.
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5. Select the From and To date ranges.

6. Select the Series, either Time Series or Summary.

7. From the Chart Type drop-down list, select the chart type.

8. Click Run Test to run the test.
The chart data (if any) for the selected time range is displayed.

Investigate a Chart
This topic provides instructions on how to investigate a chart. You can investigate a chart by
navigating directly to the Investigation module from the chart. You can use Investigate a Chart
feature to investigate an event at a specific point of time or for the entire time range for which
the chart is generated.

The View Chart view provides a calendar to select the date to retrieve the list of charts
executed. Based on the date selected in the calendar, a list of charts executed on the selected
date is populated. You can double-click the chart name to view the chart details.

Using the Chart Options you can change the time frame or format of the chart such as Step
Area, Line, Bar etc for a different date range.

Prerequisites

Make sure you currently have an active data source.

Procedure

Perform the following steps to investigate a chart:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart toolbar, click View All Charts.
All the executed charts for the selected date from the Chart Options panel are displayed on
a new tab.
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4. Click the chart name to view the chart details.

5. Do one of the following:

l Click a data point on the chart to investigate for that data point.

l In the toolbar, click Investigate to investigate for the entire time range.
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Working with Alerts in the Reporting Module
The Alerts module is used to define and view alerts.

Topics

l Alert Overview

l Define Alerts

l Define Alert Templates

l Manage Access for an Alert

l Configure Security Analytics to Generate an Alert

l Investigate an Alert

l Configure Reporting Engine to Send Sylog Messages over TCP/TLS for Alerts

Alert Overview
This topic provides a brief description about an alert. An alert is a rule that you can schedule to
run on a continuous basis and log its findings to different alerting outputs, including the
Reporting > Manage > Alerts module, Record, SMTP, SNMP, and Syslog. You can take any
rule that exists in Security Analytics and create an alert from it if that rule has a unique where
clause. After you create an alert, you can add that alert to the alert queue. After you add  an
alert to the queue, it runs every minute (by default).

Property Description Example

Name

Note:  For Name field, the icon to extend
the column size is not displayed at the
end of the column field. You have to
hover the mouse a little to the left side to
see the icon for extending the column.

Used to identify the

alert. Clicking the alert

name displays the rule on

which this alert is based

in the Define Rules panel.

Alert1

Description Used to describe the alert. Template

messages
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An alert consists of the following:

Note: In the Reporting user interface, wherever Date and Time or an input entered for this
field are displayed, it is always according to the user selected time zone profile. By
default, Reporting Engine displays all the repeated values for a meta key. If you do not want
the meta values to repeat in the Alert Output, enable the "removeRepeatedMetaValue" option
by navigating to "Configuration > AlertConfiguration available for the Reporting Engine
in the Services Configuration > Explore view. For example, in an HTTP Session the value
for action is displayed as get, get, put, put, post, get. When this option is
enabled, the value is displayed as get, put, post.

Define Alerts
This topic is a collection of tasks for configuring Alerts. You can define, delete, edit, import and
export alerts in Security Analytics. Individual topics describe the relevant procedures.

Topics

l Add an Alert

l Delete an Alert

l Disable an Alert

l Edit an Alert

l Enable an Alert

l Export an Alert

l Import an Alert

l Refresh Alerts List

Add an Alert

This topic provides instructions on how to add an alert.

Prerequisites

Make sure that:

l You have rules defined with unique where clauses before you add an alert.

l You have decoders connected to the concentrator added to the Reporting Engine for the
selected data source, before adding an alert rule.

l You have understood the components of the Create/Modify Alert view. For more information,
see Create or Modify Alert View.
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Procedure

Perform the following steps to add an alert:

1. In the Security Analytics menu, click Administration> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. In the Alert toolbar, click .
The Create/Modify Alert tab is displayed.

Note:  If you want to add a metakey in the rule, specify the same in the format:
${meta.metakey}. For example, ${meta.ip.dst}.

4. Click Enable to enable the alert.

5. In the Rule Basis field, do the following:

a. Click Browse.
The Lookup Rule Basis dialog box is displayed.

b. Navigate the Rule tree and select a rule.

c. Click OK.
The Rule name is displayed in the Rule Basis field.

6. Select a data source from the Data Sources drop-down list.

Note: If the data source is not listed, then ensure you have Read permissions set for the
data source. This is applicable for NWDB and Warehouse data source. For more
information, see Configure Data Source Permissions topic in the Host and Services
Configuration Guide.
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7. Select the Push to decoders checkbox for the Reporting Engine to send the rule to the
Decoder.

8. (Optional) Enter an alert description in the Description field.

9. Select the severity level from the Severity drop-down list.

10. In the Notification field, do the following:

a. Select the appropriate notification.
The selected notification tab is displayed in the Create/Modify Alert dialog box.

b. (Optional) De-select the notification to disable the notification tab.

c. Define the action in one of the Notification tabs:

i. In the Record tab field, do the following:

a. From the Execute drop-down list, select the frequency for recording an alert. 

b. Enter the RECORD message. You can create the message from scratch or select
a template in the Body Template field and modify the template here.

c. (Optional) If templates have been defined, select a template for the RECORD
message that you can use as is or modify.

ii. In the SMTP tab field, do the following:

a. From the Execute drop-down list, select a value to identify the number of times
that you want to send an email message for the alert.

b. Enter an email address or comma-separated list of email addresses to which you
want to send this alert. 

c. Enter the subject of the email message.

d. Enter the body of the message. You can create the message from scratch or you
can select a template in the Body Template field and modify the template here.

e. (Optional) If templates have been defined, select a template for the SMTP
message that you can use as is or modify.

iii. In the SNMP tab field, do the following:

a. From the Execute drop-down list, select a value to identify the number of times
that you want to send an SNMP message for the alert.

b. Enter the SNMP message. You can create the message from scratch or select a
template in the Body Template field and modify the template here.
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c. (Optional) If templates have been defined, select a template for the SNMP
message that you can use as is or modify.

iv. In the Syslog tab field, do the following:

Note: You can configure Multiple Syslog servers on the Syslog Configuration
panel. For more information, see Reporting Engine Output Actions topic in the Host
and Services Configuration Guide.

a. Click .

The New Syslog Configuration dialog box is displayed.

b. From the Syslog Configs drop-down list, select a value for the syslog
configuration.

c. From the Execute drop-down list, select a value to identify the number of times
that you want to send a Syslog message for the alert.

d. Select the facility from the Facility drop-down list.

e. Select the severity level from the Severity drop-down list.

f. Enter the Syslog message. You can create the message from scratch or select a
template in the Body Template field and modify the template here.

g. (Optional) If templates have been defined, select a template for the Syslog
message that you can use as is or modify.

h. Click Save.
The Syslog configuration gets added to the alert.
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11. Click Create.
Security Analytics creates the alert with a confirmation message that the alert is saved
successfully. Security Analytics fires the alert and executes the output actions every minute.

Delete an Alert

This topic provides instructions on how to delete an alert.

Prerequisites

Make sure you have understood the components of the Alert view. For more information, see
Alert View.

Procedure

Perform the following steps to delete an alert:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. In the Alert List panel, select the alert and click  .
A Warning dialog asks for confirmation that you want to remove the selected alerts.

4. Click Yes to delete the alert.
A confirmation message that the alert is deleted successfully is displayed and the selected
alert is deleted from the Alert List panel.

Disable an Alert

This topic provides instructions on how to disable the selected alerts and remove the alerts from
the Decoder and Log Decoder.

Prerequisites

Make sure you have understood the components of the Alert view. For more information, see
Alert View.

Procedure

Perform the following steps to disable an alert:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. In the Alert List panel, select the alert that display   in the Enabled column.
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4. Click .
A confirmation message indicates that the alert(s) status is changed successfully.

Edit an Alert

This topic provides instructions on how to edit an alert. 

Prerequisites

Make sure that:

l You have understood the components of the Alert view. For more information, see Alert View.

l You have understood the components of the Create or Modify Alert view. For more
information, see Create or Modify Alert View.

Procedure

Perform the following steps to edit an alert:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. In the Rule Basis field, navigate the rule tree and select another rule.
The Rule name is displayed in the Rule Basis field.

4. (Optional) Select a data source from the Data Sources drop-down list.
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Note: If the data source is not listed, then ensure you have Read permissions set for the
data source. This is applicable for NWDB and Warehouse data source. For
more information, see Configure Data Source Permissions topics in the Host and
Services Configuration Guide.

6. (Optional) Modify the alert description in the Description field.

7. Modify the appropriate Notification tabs – RECORD, SMTP, SNMP, and Syslog.

8. Click Create.
A confirmation message that the alert is edited successfully is displayed.

Enable an Alert

This topic provides instructions on how to activate an alert to execute and send output actions
every minute, when the alert conditions are met.

Prerequisites

Make sure that:

l You have understood the components of the Alert view. For more information, see Alert View.

l You have understood the components of the Create or Modify Alert view. For more
information, see Create or Modify Template Dialog.

Procedure

Perform the following steps to enable an alert:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. In the Alert List panel, select the alert that display   in the Enabled column.

4. Click  .

A confirmation message indicates that the change to the alert(s) state was successful.

Export an Alert

This topic provides instructions on how to export alerts to an external file that can be later
imported to Security Analytics. 
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Prerequisites

Make sure you have understood the components of the Alert view. For more
information, see Alert View.

Procedure

Perform the following steps to export alerts to an external file:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. In the Alert List panel, select an alert and click    and do one of the following:

o Export - This selection exports an alert in a .zip file.

o Export as Text - This selection exports all the content from the Reporting Engine in a
.zip file which contains the data in text format.

You can export multiple alerts at a time. To select multiple alerts, check the checkbox of the
alert to be exported.

4. Click   > Export.

The exported binary file is saved to the local drive.

Import an Alert

This topic provides instructions on how to import alerts from other instances of Security
Analytics into Alert List panel. Alerts imported from another Security Analytics instance must
be of a valid binary file.

During the import process, you select the binary file, and specify whether or not existing alerts
with the same name should be overwritten by alerts contained in the binary import file.

l If you choose to overwrite, all duplicate rules, lists, and alerts are overwritten by the contents
of the binary import file.

l If you choose not to overwrite, and if a duplicate rule, list, or alert exists in the target folder,
the import will still happen and no message about duplicate alerts is displayed.

Prerequisites

Make sure that:
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l You have alerts exported from other instances of Security Analytics.

l You have understood the components of the Alert view. For more information, see Alert View.

l You have understood the components of the Import an Alert dialog. For more information, see
Import Alert Dialog.

Procedure

Perform the following steps to import alerts from other instances of Security Analytics into
Alerts List panel:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. In the Alert toolbar, click   > Import.

The Import Alert dialog box is displayed.

4. Click Browse to select the binary file.
Security Analytics provides a file system view of the files. You can import multiple alerts at
a time. To select multiple alerts, check the checkbox of the alert to be imported.

5. Locate the binary file, and click Open.
The file gets added to the Import Chart list.

6. (Optional) To overwrite any existing alert in the library with an identically named alert in the
binary file when importing, check the Alert checkbox. If you do not select the Overwrite
option, and an identical alert is encountered in the binary file, the binary file is imported and
no error message is displayed.

7. Click Import to import the binary file.

Refresh Alerts List

This topic provides instructions on how to refresh the list of alerts. 

Prerequisites

Make sure you have understood the components of the Alert view. For more information, see
Alert View.

Procedure

Perform the following steps to refresh the list of alerts:
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1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. From the Alert toolbar, click   to refresh the alerts list.

The entire Alert List panel is refreshed.

Define Alert Templates
This topic is a collection of tasks for configuring Alert Templates. You can define, delete, edit,
import and export alert templates in Security Analytics. Individual topics describe the relevant
procedures.

Topics

l Add a Template

l Delete a Template

l Edit a Template

l View All Templates

Add a Template

This topic provides instructions on how to add a template.

Prerequisites

Make sure that:

l You have understood the components of the Alert view. For more information, see Alert View.

l You have understood the components of the Template view. For more information, see
Template Toolbar.

Procedure

Perform the following steps to add a template:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Click  .

The Template view tab is displayed.
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4. In the Template toolbar, click .

The Create/Modify Template dialog box is displayed.

5. Enter the name of the template.

6. Enter an alert message.

7. Click Create.
A confirmation message that the template is created successfully is displayed.

Delete a Template

This topic provides instructions on how to delete a template. 

Prerequisites

Make sure that:
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l You have understood the components of the Alert view. For more information. see Alert View.

l You have understood the components of the Template view. For more information,
see Template Toolbar.

Procedure

Perform the following steps to delete a template:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Click  .

The Template view tab is displayed.

4. In the Template List panel, select the template and click .

A confirmation dialog is displayed.

5. Click Yes to delete the template.
A confirmation message that the template is deleted successfully is displayed.

Edit a Template

This topic provides instructions on how to edit a template.

Prerequisites

Make sure that:

l You have understood the components of the Alert view. For more information, see Alert View.

l You have understood the components of the Template view. For more information, see
Template Toolbar.

l You have understood the components of the Create or Modify Template view. For more
information, see Create or Modify Template Dialog.

Procedure

Perform the following steps to edit a template:
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1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Click  .

The Template view tab is displayed.

4. In the Template List panel, select a template and click .

The Create/Modify Template dialog box is displayed.

5. Modify the template name and alert message.

6. Click Save.
A confirmation message that the template is edited successfully is displayed.

View All Templates

This topic provides instructions on how to view all template messages. 

Prerequisites

Make sure that:

l You have understood the components of the Alert view. For more information, see Alert View.

l You have understood the components of the Template view. For more information, see
Template Toolbar.

Procedure

Perform the following steps to view all template messages:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.
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3. In the Alert toolbar, click Template.
The Template view tab is displayed with a list of templates.

Manage Access for an Alert
This topic provides an overview of the access permissions the user may have depending on the
user role to manage an alert. The Reporting module provides access control at the alert level.
Only a user who has the right set of permissions can perform the tasks in the Reporting
module. The access control is managed by the administrator from the Administration >
Security > Roles tab.

Note: Reporting Engine Alert permissions are prefixed with 'RE' to distinguish it from Event
Streaming Analysis (ESA). 

When creating users and user roles, administrator must ensure that the roles created for specific
tasks have access to all the permissions higher in the hierarchy of roles.

Alerts can be tied to a specific set of user roles so that when a user logs into Security Analytics,
the only alerts they can access are alerts accessible by the role the user belongs. Users that
belong to a user role with the ‘Read & Write’ access permission can define alerts. Further, the
access can be tightened so that alerts are accessed only by those who have the ‘Read Only’
access.

At the alert level, you can set the following access permissions for the user roles in Security
Analytics:

l Read & Write

l Read Only

l No Access

Access Control for an Alert

When you want to change the alert permissions, you must select an alert and set their access
permissions using the Alert Permissions panel.

Before applying the Alert permissions, the default permission set for all the user roles is 'No
Access' permission and the checkbox is unchecked, as shown in the figure.
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If you want to change the access permission for a specific user role, you must set these at the
alert level, as shown in the figure. Suppose, you want the Administrators to have access to a
specific alert, you can set the permission 'Read & Write' in the Alert Permissions panel.

And, you can apply read-only permission to rules in the alerts by selecting the checkbox.

The two scenarios are explained in brief:
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l Scenario 1: Permissions applied to Alert/ Rules based on the user role.

l Scenario 2: Read-only permission applied to Rules in the Alert.

Role (Ana-
lysts)

Permissions applied to Alert/
Rules based on the user role

Permission (Read-only)
applied to Rules in the

Alert

Alert Read &

Write

Read & Write Read & Write

Rules Read Read Read

The Alert is assigned the role of a Security Analyst and permissions are set to Read &
Write alerts.

For scenario 1, each of the levels has a permission set based on the user role. For scenario 2, the
Read permission is set for the Rules except that the permission for the rules must not be higher
than the permission for the Alerts.

Note: If the permission for the rules is higher than the permission for the Alerts, the
permission is not applied. For example, if you set the permissions for the Alert as No
Access and then specify the option Apply Read-only permission to Rules in the Alerts, the
read-only permission is not set for the rules. 

Access Control for an Alert When Multiple Alerts are Selected

When you want to change permissions of multiple alerts, you must select several alerts and set
their access permissions using the Alert Permissions panel. The access permission that you
choose is applied to all the selected alerts.
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Login as a specific user and view the access details

When you login to the Security Analytics UI as a user having 'Read access' permission, all the
alerts will be denoted with the symbol
( ) and when you click on the symbol the 'Read Only' callout is displayed on the Alert List
panel.

When you login to the Security Analytics UI as a user not having 'Read & Write' access
permission on an Alert, all the alerts will be denoted with the symbol ( ) and the alerts appear
grayed out on the Alert List panel.

The following figure shows the Alert List panel when logged in with minimal 'Read & Write'
access permission.

Note: If a User (other than the super user) creates an alert there will be no access to that alert
for the super user.

The following table lists the various columns in the Alert Permissions Panel:
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Column Description

Roles The role of the user logged into the Security Analytics UI.

Read & Write The user can access, view, edit, import, export, and delete the

alert on the Alerts page. The user can also change the permission

on the alert.

Read Only The user can only access and view the alert on the Alerts page.

No Access The user cannot access or view the alert for which this permission

is set. 

 Apply Read-only

permission to Rules in

the Alerts

Select the checkbox to automatically apply permissions to the rules

in the alerts.

Topics

l Set Access Control for an Alert

Set Access Control for an Alert
This topic provides instructions on how to set access control for an alert. 

Prerequisites

Make sure that:

l You have understood the components of the Alert view. For more information, see Alert View.

l You have understood the access permissions the user will have depending on the user role.
For more information, see Manage Access for an Alert.

l You have a minimal 'Read & Write' access permission to set access permissions for an alert. 

Procedure

Perform the following steps to set access permissions for an alert:

1. In the Security Analytics menu, click Administration > Reports. The Manage tab is
displayed.
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2. Click Alerts.
The Alert view is displayed.

3. In the Alert List panel, select an alert.

4. Click  > Permissions.

The Alert Permissions dialog box is displayed.

5. Based on the user role, select the appropriate buttons.

6. (Optional) Select the checkbox if you want to automatically provide read access permission
to dependent rules.

Note: On selecting the check box, all dependent rules with No access permission will be
given READ access permission.

6. Click Save.
A confirmation message that the permission is successfully set for the selected alert is
displayed.

Configure Security Analytics to Generate an Alert
This topic provides instructions on how to configure Security Analytics to generate an alert.
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Procedure

Perform the following steps to configure Security Analytics to generate an alert:

1. Configure an NWDB data source for the Reporting Engine.

2. Create Alerts:

a. Add or Modify an Alert in the Create or Modify Alert View.

b. (Optional) Set up alert message templates in the Template Toolbar.

3. Schedule Alerts in the View Alerts Schedule.
After you enable an alert in the the View Alerts Schedule, Security Analytics runs the alert
every minute (by default).

4. View Alerts that have fired in the View an Alert List.

Topics

l Disable a Scheduled Alert

l View an Alert List

l View Alerts Schedule

Disable a Scheduled Alert

This topic provides instructions on how to disable the scheduled alerts and remove the alerts. 

Prerequisites

Make sure that:

l You have understood the components of the Alert view. For more information. see Alert View.

l You have understood the components of the View Alerts Schedule. For more information, see
View Alerts Schedule View.

Procedure

Perform the following steps to disable a scheduled alert:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Click .

The View Alerts Schedule view tab is displayed.
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4. In the Alerts Schedule List panel, select the scheduled alert (s) to be disabled.

5. Click . 

A confirmation message indicates that the alert(s) status is changed successfully and the
alert is now available in the Alert List Panel.

View an Alert List

This topic provides instructions on how to view alerts. You must view the alerts based on the
date selected and the maximum number of alerts.

Prerequisites

Make sure that:

l You have understood the components of the Alert view. For more information, see Alert View.

l You have understood the components of View Alerts Panel. For more information, see View
Alerts Panel.

Procedure

Perform the following steps to view alerts:

1. In the Security Analytics menu, click Administration> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. In the Alert toolbar, click View Alerts.
The View Alerts view tab is displayed.
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4. Select the last number of days from the drop-down list.

5. Enter a value for the Max no of alerts.
The alerts list is displayed based on the chosen filter value.

View Alerts Schedule

This topic provides instructions on how to view the alerts scheduled. You must view the alerts
scheduled to know the state of the alert. 

Prerequisites

Make sure that:

l You have understood the components of the Alert view. For more information, see Alert View.

l You have understood the components of the View Alerts Schedule. For more information,
see View Alerts Schedule View.

Procedure

Perform the following steps to view the alerts scheduled:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. In the Alert toolbar, click View Schedule.
The View Alerts Schedule tab is displayed with a list of alerts scheduled.
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Investigate an Alert
This topic provides instructions on how to investigate an alert. You can investigate every alert
that is triggered and the investigation details are displayed in the Investigation module for that
particular alert.

Prerequisites

Make sure you have understood the components of View Alerts panel. For more information,
see View Alerts Panel.

Procedure

Perform the following steps to investigate an alert:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. In the Alert toolbar, click View Alerts.
The View Alerts view tab is displayed.

4. Do one of the following:

o Click the  button against the alert you want to investigate. 

The Investigation module displays the details of the first session that registered the match
for the given alert  for immediate analysis.
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o Click on the alert name of the alert you want to investigate.
The Investigation module displays all matches for that particular alert for the hour
surrounding the registered alert.

Configure Reporting Engine to Send Sylog Messages over
TCP/TLS for Alerts
This topic provides instructions on how to configure the Reporting Engine to send syslog
messages over TCP with Transport Layer Security (TLS) when an alert is triggered.

Prerequisites

Make sure you have installed and configured a Syslog server that supports TCP/TLS in your
environment. For example, WinSyslog.

Procedure

Perform the following steps to configure the Reporting Engine to send syslog alert over TCP
with Transport Layer Security (TLS):

1. Obtain the required certificates.

2. Append the CA certificate to the ca.pem file on the NetWitness server.

3. Configure the Syslog Server to accept messages from client machines.

4. Configure the delivery of alert messages in NetWitness UI.

Task 1: Obtain the required certificates

Perform the following to generate certificates for configuring Reporting Engine to send syslog
messages over TCP with TLS:

1. Generate a Certificate Authority (CA) certificate. For more information,
see http://www.rsyslog.com/doc/tls_cert_ca.html.

Note: You can ignore this step, if you already have a CA running in your environment.

2. Generate key pair for the Syslog Server. For more information, see
http://www.rsyslog.com/doc/tls_cert_machine.html.

Note: You can ignore this step, if you have already configured security for the Syslog Server
using the key and certificates generated by the same CA.

Task 2: Append the CA certificate to the ca.pem file on the SA Server

Perform the following to append an existing CA certificate to ca.pem file:
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1. Manually append the contents of the CA certificate that you generated and append it to
/var/lib/puppet/ssl/certs/ca.pem file.

2. Run the following command on the SA Server, to have the certificate populate to the
Truststore:
puppet agent -t

Task 3: Configure the Syslog Server to accept messages from client machines

Perform the following to configure Syslog server to accept messages from client machines with
the same CA certificate:

1. Copy the three files to your secure TCP server target location:

l ca_cert.pem

l server_cert.pem

l server_key.pem
Where:
ca_cert.pem - is the CA certificate
server_cert.pem - is the server certificate
server_key.pem - is the server key

For more information, see the documentation specific to your Syslog server. If you are using
rsyslog, refer to http://www.rsyslog.com/doc/tls_cert_server.html.

Task 4: Configure the delivery of alert messages in Security Analytics

Configure Reporting Engine to send syslog messages over TCP with Transport Layer Security
(TLS) when an alert is triggered by enabling SECURE_TCP in the Output Actions tab for the
Reporting Engine service in the Reporting Engine Services Config View. For more information,
see Reporting Engine Output Actions topic in the Host and Services Configuration Guide.
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Working with Lists in the Reporting Module
The Lists module is used to define and view lists that can be used in Reports.

Topics:

l Lists Overview

l Define List Groups and Lists

l Manage Access for a List or List Group

Lists Overview
This topic provides a brief description about a list. A list is a variable that refers to a series of
comma-separated values (CSV).  You can insert a list into a rule or use it as an argument to a
rule action. Lists can act as placeholders for other values, which you can populate and update as
needed.

Note: In the User Interface (UI), the date or time displayed depends on the time zone profile
selected by the user

The lists cannot be empty, have duplicate or blank values. For example, even if the list has one
value it cannot be blank.

Note: If you are defining a report with a rule which has lookup_and_add in the Then clause
and direct the report output to a list, the list is not populated with the result.
For example, if you create a rule with ip.src in the select clause and lookup_and_add
('ip.dst','ip.src', 10) in the Then clause, the report displays the result, but if you have redirected
the output to a list, the list will be empty.

Define List Groups and Lists
This topic is a collection of tasks for configuring List Groups and Lists. You can define, delete,
edit, import and export list groups and lists in Security Analytics. Individual topics describe the
relevant procedures.

Topics

l Add a List

l Add a List Group

l Delete a List

l Delete a List Group
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l Duplicate a List

l Edit a List

l Export a List

l Export a List Group

l Import Lists and List Groups

Add a List

This topic provides instructions to create a list. Lists can be added within a group or in the root
folder.

Prerequisites

Make sure that:

l You understand the List view components. For more information, see List View.

l You understand the Build List view components. For more information, see Build List View.

Procedure

Perform the following steps to create a list:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

3. In the List toolbar, click .

The Build List view tab is displayed.
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4. In the Name field, enter a unique name for the list.

5. In the Description field, enter a description for the list.

6. In the List Values field, do one of the following:

l Click Insert and enter the values separated by comma. You can paste a list of values
from a file or other lists defined.

l In the Value column, enter the values.

7. If you want quotes to be inserted directly for the values at runtime, then select the Quotes
will be inserted for all the values option.

8. Click Save.

Add a List Group

This topic provides instructions to add list groups and list sub-groups.
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Prerequisites

Make sure that you understand the List view components. For more information, see List View.

Procedure

Perform the following steps to add list groups and list sub-groups:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

3. Do one of the following.

l To create a list group:

1. In the List Groups panel, click  .

The following figure shows the new list group added to the List Groups panel.
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2. Type the name for the list group and press ENTER.

l To add a list sub-group:

1. In the List Groups panel, select the list group to which you want to add a sub-
group.

2. Click  .

A new list sub-group is added to the list group.

3. Type the name for the list sub-group and press ENTER.

Delete a List

This topic provides instructions to delete a list or multiple lists. 

Prerequisites

Make sure that you understand the List view components. For more information, see List View.

Procedure

Perform the following steps to delete a list:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

3. In the List View panel, do one of the following:

l Select a list or multiple lists that you want to delete and click  in Lists toolbar.

l Click   > Delete.

A dialog asks for confirmation that you want to delete the selected lists.

Note: Before you delete a list, make sure that the list is not associated with any
rule.

4. Click Yes to delete the list.
A confirmation message that the list is deleted successfully is displayed and the selected list
is deleted from the List View panel.

Delete a List Group

This topic provides instructions to delete a list group.
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Prerequisites

Make sure that you understand the List view components. For more information, see List View.

Procedure

Perform the following steps to delete a list group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

3. In the List Groups panel, select the group and click  .

A dialog asks for confirmation that you want to delete the selected group.

Caution: If you delete a group, all sub-groups and lists in that group are deleted.

4. Click Yes to delete the selected group.
A confirmation message that the group is deleted successfully is displayed and the selected
group is deleted from the List Groups panel.

Note: If you try to delete a list group that has lists referenced in a rule or an alert, a warning
message that 'Lists are referenced in a rule' is displayed.

Duplicate a List

This topic provides instructions to duplicate a list.

Prerequisites

Make sure that you understand the List view components. For more information, see List View.

Procedure

Perform the following steps to duplicate a list:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.
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3. In the List View panel, select a list that you want to duplicate.

Note: You can only duplicate one list at a time.

4. In the List toolbar, click  .

Edit a List

This topic provides instructions to edit a list. 

Prerequisites

Make sure that:

l You understand the List view components. For more information, see List View.

l You understand the Build List view components. For more information, see Build List View.

Procedure

Perform the following steps to edit a list:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

3. In the List View panel, select a list that you want to edit.
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4. Do one of the following.

l Click   in the List toolbar.

l In the List View panel, click  > Edit.

The Build List view tab is displayed.

Note: You can only edit one list at a time.

5. Modify the required fields and add new values to the list.

6. Click Save.
A confirmation message that the list is saved successfully is displayed.

Export a List

This topic provides instructions to export a list from the List View panel.

311 Working with Lists in the Reporting Module



Reporting Guide

Prerequisites

Make sure that you have understood the List view components. For more information, see List
View.

Procedure

Perform the following steps to export a list:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

3. In the List View panel, select a list and click and do one of the following:

o Export - This selection exports a list in a .zip file.

o Export as Text - This selection exports all the content from the Reporting Engine in a
.zip file which contains the data in text format.

4. Click > Export

You can export multiple lists at a time. To select multiple lists, check the checkbox of the lists to
be exported. A browser-specific export dialog may be displayed allowing you to open or save the
file.

Export a List Group

This topic provides instructions to export a list group. You can export selected list groups to an
external file that can be later imported to Security Analytics. If nothing is selected in the List
Library panel, then the entire list tree is exported. When you export, the result is a single export
file in binary format.

Prerequisites

Make sure that you have understood the List view components. For more information, see List
View.

Procedure

Perform the following steps to export a list group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

3. In the List Groups panel, select a list group and click and do one of the following:
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o Export - This selection exports the list group in a .zip file.

o Export as Text - This selection exports all the content from the Reporting Engine in a
.zip file which contains the data in text format.

4. Click  > Export.

You can export multiple list groups at a time. To select multiple list groups, press and hold
the CTRL button and select the list groups to be exported. The exported file is saved to the
local drive.

Import Lists and List Groups

This topic provides instructions to import lists and list groups. You can import lists and list
groups from instances of Security Analytics into the list tree in the List Groups panel. Lists must
be in a valid binary file exported from a Security Analytics instance.

Prerequisites

Make sure that:

l You export the lists or list groups from a Security Analytics instance.

l You have understood the List view components. For more information, see List View.

Procedure

Perform the following steps to import lists or list groups:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

3. Do one of the following.

l In the List Groups panel, click    > Import.

l In the List toolbar, click   > Import.

The Import List dialog box is displayed. You can import multiple lists and list groups at a
time. To select multiple lists or list groups, press and hold the CTRL button and select the
lists or list groups to be imported.
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4. Click Browse to browse and select the archived file containing the lists.

5. Click Import.

Note: During the import process, if a duplicate list exists and you do not select the overwrite
option, the list is imported and no message about duplicate lists is displayed.

Manage Access for a List or List Group
This topic describes the access permissions the user has depending on the user role to manage a
list or list group. The Reporting module provides access control at the list and list group level.
Only a user who has the right set of permissions can perform the tasks in the Reporting module.
The access control is managed by the administrator from the Administration > Security >
Roles tab.

The administrator when creating users and user roles, must ensure that the roles created for
specific tasks have access to all the permissions higher in the hierarchy of roles.

Lists or List Groups can be tied to a specific set of user roles so that when a user logs into
Security Analytics, the only lists they can access are lists accessible to the group to which the
user belongs. Users that belong to a user role with the ‘Read & Write’ access permission have
full access rights on the list. Further, the access can be tightened so that lists are accessed only
by those who have the ‘Read Only’ access.

Note: You must have ‘Read Only’ permission on a group to view the lists within that group.

At the list level, you can set the following access permissions for the user roles in Security
Analytics:

l Read & Write

l Read Only

l No Access

Suppose, you want the Security Analysts to have access to all the lists in a List Group, you can
set the permission 'Read & Write' at the List Group level. And, if you do not want
the Operator role to have access to a specific set of lists in a list group, you can set the
permission 'No Access' at the List Group level.

The permission is set only for the list group but not the lists, or sub-groups in the List Group.

Working with Lists in the Reporting Module 314



Reporting Guide

Access Control for a List Group

When you want to change the list group permissions, you must select a list group and set their
access permissions using the Lists Permissions panel.

Before applying list group permissions, the default permission set for all the user roles is 'No
Access' permission, and the checkboxes are unchecked, as shown in the figure. 

If you want to change the access permission for a specific user role, you must set these at the
list group level, as shown in the figure.Suppose, you want the Administrators to have access to
all the lists in a List Group, you can set the permission 'Read & Write' in the Lists Group
Permissions panel.
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And, you can also apply permissions to sub-groups and lists in the group by selecting the
checkbox, as shown in the figure.

The two scenarios are explained in brief:

l Scenario 1: Permissions applied to List Group/ Sub Group based on the user role.

l Scenario 2: Permissions applied to Sub Group and Lists in the Group.

Role (Ana-
lysts)

Permissions applied to List
Group/Sub Group based on the
user role

Permissions applied to Sub
group and Lists in the
Group

Group  Read & Write Read & Write

Sub Group Read Read & Write - Inherited

Lists Read Read & Write - Inherited

The access permissions that you set can be applied to subgroups and child objects of this group. 

The List Group will be assigned the role of a Security Analyst and permissions are set to Read
& Write list group.

For scenario 1, each of the levels will have a permission set depending on the user role. For
scenario 2, the permission at the List Group level will be inherited by the Sub Group and Lists in
the Group.
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Access Control for a List

When you want to change the list permissions, you must select a list and set their access
permissions using the List Permissions panel.

Before applying the List permissions, the default permission set for all the user roles is 'No
Access' permission and the checkbox is unchecked, as shown in the figure.

If you want to change the access permission for a specific user role, you must set these at the
list level, as shown in the figure. Suppose, you want the Administrators to have access to a
specific list, you can set the permission 'Read & Write' in the Lists Permissions panel.
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Access Control for a List When Multiple Lists are Selected

When you want to change permissions of multiple lists, you can select multiple lists at a time
and set their access permissions using the Lists Permissions Panel. The access permission that
you choose is applied to all the selected lists.

Note: The '*' besides the role name indicates the other permissions available on the user role.
If you want to change the access permission for the required user role, select the user role and
change the access permission.
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Note: If a user (other than ADMIN) creates a list, ADMIN cannot access that list.

Tabular Listing

The following table lists the various columns in the Lists Permissions panel:

Column Description

Roles The role of the user logged into the Security Analytics user interface.

Read &

Write

The user can access, view, edit, delete,import, and export lists on the Lists view.

The user can also change the permission on the rule.

Read

Only

The user can only access and view the list on the Lists view

No

Access

The user cannot access or view the list for which this permission is set.

Topics

l Set Access Control for a List

l Set Access Control for List Groups

319 Working with Lists in the Reporting Module



Reporting Guide

Set Access Control for a List

This topic provides instructions to set permissions for a list. You can set list permissions from
the List panel. At the list level, you can set the following access permissions for the user roles in
Security Analytics:

l Read & Write – View or edit the list.

l Read Only – View the list.

l No Access – Cannot view or edit the list.

Prerequisites

Make sure that:

l You have understood the components of the List view. For more information, see List View.

l You have a minimal 'Read & Write' access permission to set access permissions for a list. 

Procedure

Perform the following steps to set access control for a list:

1. In the Security Analytics menu, click Administration> Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

3. In the List View panel, select a list.

4. Click  > Permissions in the List toolbar.
The List Permissions dialog is displayed.
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5. Select the appropriate access permission for each of the user roles and click Save.
A confirmation message that the permission is successfully set for the selected list is
displayed.

Set Access Control for List Groups

This topic provides instructions to set permissions for list groups. You can set list group
permissions from the List Groups panel. At the list group level, you can set the following access
permissions for the user roles in Security Analytics:

l Read & Write – View or edit the list group.

l Read Only – View the list group.

l No Access – Cannot view or edit the list group.

Prerequisites

Make sure that:

l You have understood the components of the List view. For more information, see List View.

l You have a minimal 'Read & Write' access permission to set access permissions for a list
group. 

Procedure

Perform the following steps to set access control for a list group:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.

The List view is displayed.

3. In the List Groups panel, select a chart group.

4. Click   > Permissions.
The List Permissions dialog is displayed.
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5. (Optional) Select the appropriate checkbox to apply these permissions to subgroups and child
objects of this group. 

6. Click Save.
A confirmation message that the permission is successfully set for the selected list group is
displayed.
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Reporting Module References
This topic describes the features and functions of the Reporting user interface in Security
Analytics. The references are grouped by location in the user interface: Alert, Chart, List,
Report, and Rule.

Topics

l Alert References

l Alert Permissions Dialog

l Alert View

l Create or Modify Alert View

l Import Alert Dialog

l Template References

l Create or Modify Template Dialog

l Template Toolbar

l View Alerts Panel

l View Alerts Schedule View

l Chart References

l Build Chart View

l Charts Permissions Dialog

l Chart View

l Import Chart Dialog

l Test a Chart View

l View a Chart Panel

l List References

l Build List View

l Lists Permissions Dialog

l List View

l Report References
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l Build Report View

l Import Report Dialog

l Reports Permissions Dialog

l Report View

l Schedule References

l Features

l Features

l Features

l Features

l Features

l Select a Logo Dialog

l View All Reports Panel

l View a Report Panel

l Rule References

l Build Rule View

l Query Aggregates

l Rule Permissions Dialog

l Rule View

l IPDB Event Source Specification

l Warehouse Database Rule Definition Modes

l General Syntax of an Advanced Rule

l All Event Categories Report

Alert References
The Reporting module user interface provides access to Security Analytics Alerts. This topic
contains descriptions of the user interface as well as other reference information to help users
manage Alerts.

Topics
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l Alert Permissions Dialog

l Alert View

l Create or Modify Alert View

l Import Alert Dialog

l Template References

l Create or Modify Template Dialog

l Template Toolbar

l View Alerts Panel

l View Alerts Schedule View

Template References

The Reporting module user interface provides access to Security Analytics alert templates. This
topic contains descriptions of the user interface as well as other reference information to help
users manage Alert Templates.

Topics

l Create or Modify Template Dialog

l Template Toolbar

Create or Modify Template Dialog

This topic describes the features in the Create or Modify Template dialog. In the Create/Modify
Template dialog, you can customize alert templates for use when creating alerts. Procedures
associated with this  dialog are described under Define Alert Templates.

The following figure is an example of the Create/Modify Template dialog.
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The following table describes the fields in the Create/Modify Template dialog.

Feature Description

Name Indicates the name of the template for Reporting alerts. For example, source IP.

Message Specifies the message that will be sent when an alert is triggered.

Create Creates the template with a confirmation message and becomes available for use

in Reporting immediately. 

Save Saves the template with the edited details or when a new template is created. This

button is visible only in the edit mode. 

Cancel Clicking Cancel closes the dialog without saving the template or any changes

made to the template.
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Template View

This topic describes the features of the Template view. In the Template view, you can add,
view, and delete alert templates. Associated procedures are provided under Define Alert
Templates.

To access the template view:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Click .

The following figure is an example of the Template view.

The Template view includes the following panels:

l Template toolbar

l Template List panel

The following figure shows the different panels on the Alerts Template view.

Template Toolbar

The Template toolbar allows you to add, modify, and delete alert templates. After templates are
defined, you can select a template to simplify defining and modifying alert messages.

The following table lists the various actions in theTemplate view and their description.

Actions Description

This option allows you to create a new alert template.
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Actions Description

This option deletes the selected alert template.

This option allows you to edit an existing alert template.

Template List

The Template list presents all the templates in a tabular format.

The following table describes the columns in the Templates List panel.

Column Description

Name This is the name of the template. 

Message This is the alert message defined for the template.

Alert Permissions Dialog

This topic describes the features of the Alert Permissions dialog and the access permissions the
user may have depending on the user role to manage an alert. Users with 'Read & Write' access
permission to set access permissions for an alert can configure permissions in the Alert
Permissions dialog. 

Procedures related to this dialog are described in Manage Access for an Alert.

To access the dialog:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alerts view is displayed. 

3. In the Alert Listpanel, select a report.

4. Click   > Permissions.

The Alerts Permissions dialog is displayed.
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The following figure is an example of the Alert Permissions dialog.

The following table describes the features in the Alert Permissions dialog.

Feature Description

Roles The role of the user logged into the Security Analytics UI.

Read&Write The user can access, view, edit, import, export, and delete the alert

on the Alerts page. The user can also change the permission on the

alert.

Read Only The user can only access and view the alert on the Alerts page.

No Access The user cannot access or view the alert for which this permission

is set. 

Apply Read-only per-

missions to Rules in the

Alerts

Select the checkbox to automatically apply permissions to the rules

in the alerts.

Cancel  This option cancels all the changes made to the permissions.
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Feature Description

Save This option saves the selections and provides access to the roles

based on the selections.

Alert View

The Alert view allows you to import, export, manage, and add alerts. Procedures related to this
view are provided inWorking with Alerts in the Reporting Module

You can perform the following actions using this toolbar:

l Add an Alert. 

l Edit an Alert. 

l Delete an Alert. 

l Enable an Alert. 

l Disable an Alert. 

l Refresh an Alerts List.

l Import an Alert. 

l Export an Alert. 

l Set access permissions for the alert. 

l View All Templates. 

l View Alerts Schedule.

l View an Alert List.

To access the Alert view:

1. In the Security Analytics menu, click Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

The following figure shows the different panels of the Alert view.
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The Alert view includes the following features:

l Alert toolbar

l Alert List panel

Alert Toolbar 

The Alert toolbar allows you to add, modify, delete, enable, disable, refresh, import, and export
an alert. Using this toolbar, you can also set access permissions for the selected alert.

The following table describes the features in the Alert Toolbar.

Feature Description

This option allows you to add a new alert to the Reporting module.

This option allows you to delete one or more selected alerts.

This option allows you to edit an alert.

Enable  This option enables the selected alerts.

Disable  This option disables the selected alerts.

This option refreshes the view.
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Feature Description

The actions menu has the following options: Import, Export and Permissions.

Alert List Panel

The Alert List panel lists all the alerts in a tabular format. The following table lists the various
columns in the Alert List panel and their description.

This is an example of the Alert List panel.

The following table describes the features in the Alert List Panel.

Feature Description

Enabled Displays the state of the alert:

l Enabled - the alert is active and fires based on the rule assigned to it.

l Disabled - the alert is not active.

Pushed? Indicates whether the alert is sent to Decoders or Log Decoders:

l Yes - Alert is pushed to Decoders or Log Decoders.

l No - Alert is not pushed to Decoders or Log Decoders.

Name Identifies the name of the alert. Clicking the alert name displays the rule on

which this alert is based in the Define Rules panel.

Description Indicates the alert description.
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Feature Description

Actions Indicates the action the system takes when the alert fires.

The different available action types are:

l Record

l SMTP

l SNMP

l Syslog

Create or Modify Alert View

The Create/Modify Alert view allows you to add, manage, and edit Alerts. Related procedures
are provided in Working with Alerts in the Reporting Module.

To access the Create/Modify Alert view:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.
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3. In the Alert toolbar, click .

The following figure is an example of the Create/Modify Alert view.

The Create or Modify Alert view includes the following sections:

l Alert Definition section

l Alert Description section

l Alert Notification section

Alert Definition Section

The Alert Definition section allows you to select an alert rule and data sources, push the event
to the decoder or log decoder, and enable or disable the alert.
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The following table describes the fields in the Alert Definition section:

Field Description

Enable l Enable activates the alert. The alert executes and sends output actions every
minute (by default) when the alert conditions are met.

l Disable deactivates the alert. The alert does not execute and does not send any
output actions.

Rule

Basis

Clicking Browse displays the Rules Library panel from which you select the rule

that is the basis of this alert.

You must select a rule that has a unique where clause for an alert.

Data

Sources

Specifies the data source for the alert.

Push to

decoders

Checking this option pushes the ‘where’ clause of the alert rule to Decoders
connected to the selected NWDB data source. This is the recommended option to
create RE alert, as the alert conditions are checked at Decoder itself and the alert
queries will be comparatively faster in NWDB.

If you uncheck this option, the alert rule ‘where’ clause will be queried against the
selected NWDB data source. Based on the complexity and metas in the ‘where’
clause of the rule, the alert queries might take more time to process in NWDB.

Note: Security Analytics does not send rules to the Decoder automatically.

Alert Notification Section

The Alert Notification section allows you to define the notification action Security Analytics
takes when alert fires, say recording or sending the alert using one of the defined output actions.
The output actions are Simple Mail Transfer Protocol (SMTP), Simple Network Management
Protocol (SNMP), or Syslog message.

When you create an alert, the Notification section has the default Record tab. The icon besides
the Record tab, allows you to select the notification type from the drop-down list for the output
that you want to specify for this alert: SMTP, SNMP, or Syslog.
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Depending on the notification type selected, the Notification section is populated with pre-
defined text that has certain variables that will add Meta appropriate to the alert. In the
Reporting Engine, these variables are replaced with actual values. The following table lists the
variables and their description.

Variable Description

${meta.<-

metakey>}

The meta key value.

Note: If the <metakey> did not fetch any value, then an empty string
("") is printed. 

${meta.time} /

${meta.-

time:<time_

format>}

${meta.time} - The session time is printed in  "yyyy-MMM-dd

HH:mm:ss" format. ${meta.time:<time_format>} - The session

time is printed in the user given custom time format. For example,

${meta.time:dd-MM-yyyy HH:mm:ss}.

For more information on the supported time formats, see http://-

doc-

s.oracle.com/javase/7/docs/api/java/text/SimpleDateFormat.html

Note: If the time format provided by the user is invalid, then the
default time format will be used. The default time format is "yyyy-
MMM-dd HH:mm:ss".

${name} The alert name defined in Reporting Engine.

${count} The number of times an alert is detected in a given time frame. (By

default, it is one minute)

${sa.host} The Security Analytics host name as configured in Reporting Engine.

${device.id} The Security Analytics device id of the data source.

The Alert Notification section has four tabs:

l Record

l SMTP

l SNMP

l Syslog
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Record Tab

The Record tab allows you to define the frequency for recording an alert and the message that
you want to generate when an alert fires.

The following table lists the various fields in the Record tab and their description.

Field Description

Execute Indicates the frequency for recording an alert.

l Once - Record the alert only once based on the alert interval no matter how
often the alert fires. Security Analytics records the number of times that alert
has actually fired during that interval in the log file so that analysts know how
many times that alert registered a match over a given day.

l Each Event - Record the alert each time as it fires. If an alert fires unlimited
number of times during a day, that alert is often treated as noise and can be
ignored, except in case of alerts that require continuous monitoring such as
network configuration changes and DDOS attacks.

Note: Select Each Event setting from the Execute drop-down list for SNMP and
Syslog output actions. 

Body Indicates the body of the message.

Body

Template

(Optional) If templates have been defined, you can select a template for the alert

message. 

SMTP Tab

The SMTP tab allows you to define the SMTP (email) output for this alert.
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The following table lists the various fields in the SMTP tab and their description.

Field Description

Execute Indicates the number of times that you want to send an email message for the

alert.

l Once - Sends only one email for an interval, if alert fires in that interval,
irrespective of how many alerts fired.

l Each Event - Send an email with the alert for every event in which the rule
criteria are met.

To Identifies the email address or comma-separated list of email addresses to which

you want to send this alert. 

Subject Indicates the subject of the email message.

Body Indicates the body of the message.

Body

Template

(Optional) If templates have been defined, select a template for the SMTP mes-

sage that you can use as is or modify.

SNMP Tab

The SNMP tab allows you to define the SNMP output for the alert.

The following table lists the various fields in the SNMP tab and their description.

Field Description

Execute Indicates the number of times that you want to send an SNMP output for the alert.

l Once - Sends an SNMP message along with an email for an interval, if alert
fires in that interval, irrespective of how many alerts fired.

l Each Event - Send an SNMP message with the alert for every event in which
the rule criteria are met.
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Field Description

Body Indicates the body of the message.

Body

Template

(Optional) If templates have been defined, select a template for the SNMP mes-

sage that you can use as is or modify.

Syslog Tab

The Syslog tab allows you to define the Syslog message output for this alert.

Clicking allows you to add Syslog configuration to an alert. The New Syslog Configuration
dialog box is displayed:

The following table describes the fields in the New Syslog Configuration dialog:

Field Description

Syslog

Configs

Indicates the Syslog configuration defined in the Syslog Configuration panel of the

Device Config view.
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Field Description

Execute Indicates the number of times that you want to send a Syslog output for the alert.

l Once - Sends a Syslog output along with an email for an interval, if alert fires in
that interval, irrespective of how many alerts fired.

l Each Event - Send a Syslog output with the alert for every event in which the
rule criteria are met.

Facility Indicates the type of program logging the message. Several examples for the type

of programs: syslog, daemon, mail, kernel.

Severity Indicates the severity level of the alert fired.

l Emergency

l Alert

l Critical

l Error

l Warning

l Notice

l Informational

l Debug

Body Indicates the body of the message.

Body

Template

(Optional) If templates have been defined, select a template for the Syslog mes-

sage that you can use as is or modify.

Alert Description Section

The Alert Description section allows you to provide a description for the alert.

The following table describes the fields in the Alert Description section.

Reporting Module References 340



Reporting Guide

Field Description

Description Identifies the description of the alert.

Create Creates the alert. (This option is displayed when you create an alert.)

Save Saves the changes made to the alert. (This option is displayed when you modify

an alert.)

Import Alert Dialog

In the Import Alert dialog, you can import an alerts archive and specify whether to overwrite
existing rules, lists, and alerts. Associated procedures are provided under Define Alerts

To access the dialog:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed. 

3. In the Alert panel, select a folder to import the file.

4. In the Alert toolbar, click   > Import to import an alert.

The following figure is an example of the Import Report dialog.

The following table lists the various actions in the Import Alert dialog and their description.

Actions Description

This option displays a view of the local zip file system so that you can

select the alert to be imported.

Deletes the selected alert from the Import Alert dialog.
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Actions Description

File Name  Indicates the name of the imported binary file.

Overwrite? Allows you to select the option to overwrite an existing version of the

alert you are importing. If you do not select the Overwrite option, a

duplicate file is imported and no error message is displayed.

Close Closes the Import Alert dialog.

Import Imports the alert with a confirmation message.

Template References

The Reporting module user interface provides access to Security Analytics alert templates. This
topic contains descriptions of the user interface as well as other reference information to help
users manage Alert Templates.

Topics

l Create or Modify Template Dialog

l Template Toolbar

View Alerts Panel

This topic describes the features of the View Alerts panel. The View Alerts panel allows you to
view alerts triggered by the Reporting module and investigate any alert in the Investigation
module. Only your alerts (the alerts for which you have view permission) are listed in a table.
You can customize the view to show alerts for a specific period of time, and set the maximum
number of alerts displayed in a single page. The procedures associated with this panel are
provided under View an Alert List

To access the dialog:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alert.
The Alert view is displayed. 

3. Click  .

Reporting Module References 342



Reporting Guide

The following figure shows the different panels on the View Alerts panel.

Features

The View Alerts panel has the following features:

l View Alerts toolbar

l View Alerts list

View Alerts Toolbar

The View Alerts toolbar allows you to filter alerts based on a count, or the start and end date of
the alerts.
The following table lists the operations in View Alerts toolbar.
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Option Description

Last Hour(s) data The data fetched from the previous execution.

Max No Of

Alerts

The maximum number of alerts that you want to display in a single

page.

View Alerts List

The View Alerts List  lists all the filtered alerts in a tabular format. The following table lists the
columns in the View Alerts List panel.

Column Description

Investigates the alert. Clicking the button opens the Investigation module, where

the details of the first session that registered the match for the given alert is dis-

played for immediate analysis. 

Note: You are not redirected to the Investigation module, when:
-You reconfigure a data source for an existing alert and run an alert on the new
data source.
-You enter a hostname instead of an IP address in the data source field.

Name Indicates the name of the alert that registered the match. The hyperlink on the

name opens the Investigation module to view all matches for that particular alert

for the hour surrounding the registered alert. 

Number

of hits

Indicates the number of times the alert is fired.

Detected Indicates the the date and time at which the alert fired.

Message Indicates the alert message.

View Alerts Schedule View

In the View Alerts Schedule view, you can view the following information about each of your
scheduled alerts.
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l Completion status, name, last run time, last session ID, total alerts triggered.

l Statistics about the the time taken to run the scheduled alert: duration, average duration,
maximum duration,

You can also disable scheduled alerts.

Related procedures are provided in Enable an Alert

To access the dialog:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Alert.
The Alert view is displayed. 

3. Click  .

The following figure shows the View Alerts Schedule view.

Features

The View Alerts Schedule view includes the following panels:

1. Alerts Schedule toolbar

2. Alerts Schedule list
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Alerts Schedule Toolbar Panel

The Alerts Schedule Toolbar panel allows you to modify the state of the scheduled alert.

Clicking Disable disables the selected alert. When schedule alerts are no longer needed or are
determined to be ineffective, you can disable them so that they are no longer executed. You can
select one of more alerts to disable. When an alert is disabled, it is removed from the scheduled
alerts list so that you can't view it here, and it will not execute again unless you manually
execute the alert or set up a new schedule for it.

Alerts Schedule List Panel

The Alerts Schedule List panel lists only the Enabled alerts in a tabular format. The following
table lists the columns in the Alerts Schedule List panel and their description.

Column Description

State The state of the scheduled alert:

l Completed

l Failed

Name The name of the scheduled alert.

Last Run {#time} The last time the scheduled alert was run.

Last Session Id The Session Id of the last scheduled alert.

Total Alerts The total number of event occurrences.

Duration The time taken to run the scheduled alert.

Avg (s) The average time taken to run the scheduled alert.

Max (s) The maximum time taken to run the scheduled alert.

Chart References
The Reporting module user interface provides access to Security Analytics charts. This topic
contains descriptions of the user interface as well as other reference information to help users
manage Charts.

Topics
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l Build Chart View

l Charts Permissions Dialog

l Chart View

l Import Chart Dialog

l Test a Chart View

l View a Chart Panel

Build Chart View

In the Build Chart view, you can define a chart and test a chart. You build a chart by
assigning a name and selecting the rules from the Add Rule dialog. The only rules that you
can use for charts are NetwitnessDB rules. The procedures associated with this view are
provided under Define Chart Groups and Charts and Test a Chart

The following figure shows the Build Chart view.

Features

The following table lists the features in the Build Chart view.

Field Description
Enable Specifies if the Reporting Engine must collect the data and generate

chart results. If the Enable checkbox is not selected, the results are

not rendered.

Chart

Name

Identifies the name of the chart.

Rule

Basis

Click Browse to display the Add Rules dialog box from which you

select a rule that is the basis of this chart.
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Field Description
You must select a rule which is not sorted by none.

Data

Source

Allows the user to select a data source from the drop-down list. The

Reporting module works with the following data sources:

l Broker

l Concentrator

l Decoder

l Log Decoder

l Log Collector

Interval

(Minutes) 

The chart data refresh interval in minutes.

Limit The number of records for which chart is generated.

Save Saves the chart to the database.

Test

Chart 

Plots a test chart based on the chart definition.

Charts Permissions Dialog

This topic describes the features of the Chart Permissions dialog and the access permissions the
user may have depending on the user role to manage a chart and chart group. Users with 'Read
& Write' access permission to set access permissions for an chart can configure permissions in
the Chart Permissions dialog. 

Procedures related to this dialog are described inManage Access for a Chart or Chart Group.

To access the dialog:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Charts view is displayed. 

3. In the Chart List panel, select a report.

4. Click   > Permissions.

The Chart Permissions dialog is displayed.
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The following figure is an example of the Chart Permissions dialog.

The following table describes the features in the Charts Permission dialog.

 Feature Description

Roles The role of the user logged into the Security Analytics UI.

Read & Write The user can access, view, edit, import, export, and delete the

chart on the Charts view. The user can also change the per-

mission on the chart.

Read Only  The user can only access and view the chart on the Charts

view.

No Access The user cannot access or view the chart for which this per-

mission is set. 
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 Feature Description

 Apply these permissions

to sub-groups and Charts in

this group

Select the checkbox to apply the selected permissions to the

chart group, sub-groups in the group and charts in the group.

Note: This checkbox is populated only when you set access
permissions for a Chart Group.

 Apply Read-only per-

mission to Rules in the Charts

Select the checkbox to automatically apply permissions to the

rules in the charts.

Cancel  This option cancels all the changes made to the permissions.

Save This option saves the selections and provides access to the

roles based on the selections.

Chart View

The Chart view allows you to organize, view, and manage charts and chart groups. The
procedures associated with this view are described under Define Chart Groups and Charts, Manage
Access for a Chart or Chart Group, and Test a Chart.

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

To access the Chart view:
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The following figure shows the Chart view.

Features

The Chart view includes the following panels:

l Chart Groups

l Chart toolbar 

l Chart List

Chart Groups Panel

The Chart Groups panel allows you to organize charts in a group. You can create a group, add
charts to the group and move charts among groups. The following figure shows the Chart Groups
panel.
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The Charts Groups Panel includes the following options:

Feature Description

This option allows you to add a new chart to the Reporting module.

This option allows you to delete one or more selected charts.

This option allows you to edit a chart.

This option refreshes the view.

The actions menu has the following options: Import, Export and Permissions.

Chart Toolbar

TheCharts toolbar allows you to add, modify, delete, duplicate, activate, de-activate, import
and export a chart. You can also set access permissions for charts in a group.

The Chart toolbar includes the following options:

Feature Description

This option allows you to add a new chart to the Reporting module.

This option allows you to delete one or more selected charts.

This option allows you to edit an chart.
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Feature Description

Enable  This option enables the selected charts.

Disable  This option disables the selected charts.

This option creates a duplicate copy of the selected chart.

The actions menu has the following options: Import, Export and Permissions.

Chart List

The Chart List presents all the charts in a tabular or grid format.

The following table lists the columns in the Chart List panel and their description.

Feature Description

Name The name of the chart.

Group The Chart Group to which the chart belongs.

Enabled Yes - The chart is enabled.

No - The chart is disabled.
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Feature Description

State The state of the chart:

l Queued

l Completed

l Failed

Duration The time taken to execute the latest chart.

Avg(s) (in

seconds)

The average time taken to run the chart.

Max(s) (in

seconds)

The maximum time taken to run the chart.

View Chart This is a hyperlink that redirects to the View a Chart Panel.

Actions The actions menu has the following options: Enable, Disable, View,

Delete, Edit, and Export. 

Import Chart Dialog

This topic describes the features of the Chart Groups Panel. In this dialog, you can import charts
containing subgroups and charts from other instances of Security Analytics into Chart Groups
Panel. Charts must be in a valid binary file that was exported from another Security Analytics
instance.

Procedures related to this dialog are described in Import Charts and Chart Groups

The dialog has a different appearance to import groups containing subgroups and charts from
other instances of Security Analytics into Chart Groups panel. To access the dialog:

Perform the following steps to import charts from other instances of Security Analytics:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart Groups panel, select a folder to import the file.
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4. Do one of the following:

1. In the Chart Groups panel, click    > Import.

2. In the Chart toolbar, click   > Import.

The following figure is an example of the dialog.

The following table describes the features in the Import Chart dialog.

 Feature Description

Browse This option displays a view of the local file system so that you can select the

chart to be imported.

Delete This option deletes an imported report from the list of imported charts.

File Name Displays a list of chart files that will be imported to your Charts module when

you click Import.

Overwrite? Allows you to select the option to overwrite an existing version of the chart you

are importing. If you do not select the Overwrite option, a duplicate file is impor-

ted and no error message is displayed.

Close This option closes the dialog. If you have charts to select for import, but have

not clicked Import. The charts are not imported, and are not saved in this dialog. 

Import This option imports the selected charts to your Charts module.

View a Chart Panel

In the View a Chart panel, you can view and manage charts. There are options for filtering and
sorting the information in the chart, as well as options for the type of chart, the number of items
to chart, and charting values or totals. When viewing a chart, you can open the charted sessions
in the Investigation module and save the chart as a PDF.

Associated procedures are described inWorking with Charts in the Reporting Module

To access this view:
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1. In the Security Analytics menu, click Administration > Reports.

The Manage tab is displayed.

2. Click Charts.

The Chart view is displayed.

3. Click   > View.

The following figure is an example.

The View a Chart panel has the following panels:

l Charts Toolbar

l Charts Output

l Charts Calendar

l Charts Options

l Charts Executed List

Charts Toolbar

The Charts toolbar has options that allow you to investigate, and view the chart on another
screen.
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The following table lists the options in the Charts toolbar.

Operation Description

 Investigate Investigates the chart details.

 Full Screen Displays the chart on a full screen.

Charts Output Panel

The Charts Output panel displays the chart with the sortBy on the Y-axis, time on the X-axis and
legends.

Note: You can save the chart as PDF using the  icon. 

Charts Calendar Panel

The Charts Calendar panel filters the list of charts based on the date you select from the
Calendar, as shown in the following figure.
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Charts Options Panel

The Charts Options panel displays the time range, series, and chart type fields to configure the
chart is displayed.

The following table lists the fields in the Charts Options panel.

Field Description

Time

Range

The default time range is Last 3 Hours. However, you can select a different value
from the drop-down list, for example, Last Hour, or Last 6 Hours which are the
preset values. Or you can customize by selecting Last N Days or the Custom option.

Note: The time range selected by you for a chart will be saved. When you open the
same chart the next time, the time range that is saved will be displayed. This
behavior is not applicable for the custom option.

From The start date and time. (only for custom option)

To The end date and time. (only for custom option)
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Field Description

Series The series field provides the user with two options:

l Chart Values over Time: Renders the chart for the entire time range selected.

l Chart with Totals: Renders the summary of data for the selected date range.

Items

to Plot

The maximum number of events the user wants to view on the chart.

Chart

Type

The type of chart to be rendered either area, bar, column, line, step line, step area,

spline area or spline.

Charts Executed List Panel

The Charts Executed List panel displays all the executions for a particular chart for the selected
date. Double-clicking on any chart execution loads the chart on the Charts Output panel. By
default, the last executed chart is displayed in the Charts Output panel.

Test a Chart View

The Test a Chart view allows user to view and test the charts.Associate. Associated procedures
are provided in View a Chart Panel.

To access the Test a Chart View:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Chart List panel, select a report.

4. Click View.
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The following figure shows the Test a Chart view.

Features

The Test a Chart view consists of the following panels:

l Charts Toolbar

l Charts Output

l Chart Options

Charts Toolbar

The Charts toolbar allows you to investigate on a particular chart and change the screen to full
screen.

Feature Description

Investigate This option allows you to investigate further on the selected chart.

Full Screen This option allows view the chart in a full screen.

Chart Output

The Chart Output displays the information in a chart format for the selected time chart options.
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The following table lists the features in the Test a Chart View and their description.

Feature Description

Display This option allows you select the values that needs to be displayed and have the fol-

lowing options: X Axis, Y Axis and Legends.

X Axis This field displays the session count.

Y Axis  This field displays the actual output.

Legends This field displays the list of variables appearing in the chart.

Chart Options

The following figure Chart Options panel displays the time range, series, and chart type fields to
configure the chart display.

The following table lists the fields in the Charts Options panel and the descriptions. 
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Feature Description

Time

Range The default time range is Last 3 Hours. However, you can select a different

value from the drop-down list, for example, Last Hour, or Last 6 Hours which are

the preset values. Or you can customize by selecting Last N Days or the

Custom option.

From  The start date and time. (only for custom option).

To  The end date and time. (only for custom option).

Series

The series field provides the user with two options:

• Chart Values over Time: Renders the chart for the entire time range selected.

• Chart with Totals: Renders the summary of data for the selected date range.

Items to

Plot

The maximum number of events the user wants to view on the chart.

Chart

Type The type of chart to be rendered either area, bar, column, line, step line, step area,

spline area or spline.

List References
The following are list reference topics:

l Build List View

l Lists Permissions Dialog

l List View
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Build List View

In the Build List view, you can enter values for a list and save or reset the values. You can use
lists when you are writing Reporting rules to simplify the process of specifying values in the
Rule. Associated procedures are provided in Working with Lists in the Reporting Module.

To access this view:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

3. In the List toolbar, click  .

The Build List view tab is displayed.

The following figure shows the Build List view.
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The following table describes the features in the Build List view.

Feature Description

Name Identifies and labels the list.

Description A short description for the list.

List Values The grid of values associated with the selected list from the List Library panel.

Quotes will

be inserted

for all the val-

ues

If you want quotes to be automatically included for the values at runtime,

select this checkbox. If the checkbox is not selected and if a value in the list

contains a comma, then that value has to be enclosed within single quotes.

Each list value for an IPDB rule must be enclosed within single quotes. This

syntax does not apply to list values for an NWDB rule.

Save This option saves the rule which can be used to create a report, a chart or a

list.

Reset This option deletes all the information from the fields.

Lists Permissions Dialog

In the Lists Permissions dialog, you can manage access permissions that pertain to a list or list
group. Users with 'Read & Write' permission to set access permissions for a list can configure
permissions here. Associated procedures are provided in Manage Access for a List or List Group.

To display the Reports Permissions dialog:

1. In the Security Analytics menu, click Administration > Reports.

The Manage tab is displayed.

2. Click Lists.

The Lists view is displayed. 

3. In the List panel, select a report.

4. Click   > Permissions.

The List Permissions dialog is displayed.

The following figure is an example of the Lists Permissions dialog.

Reporting Module References 364



Reporting Guide

The following table describes the features in the Lists Permissions dialog.

 Feature Description

Roles The role of the user logged into the Security Analytics user

interface.

Read&Write The user can access, view, edit, delete, import, and export lists

on the Lists view. The user can also change the permission on

the rule.

Read Only The user can only access and view the list on the Lists view.

No Access The user cannot access or view the list for which this per-

mission is set.

Apply these permissions to

sub-groups and Lists in this

groups

Select the checkbox to automatically apply permissions to the

sub-groups and list in the groups.

Cancel  This option cancels all the changes made to the permissions.
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 Feature Description

Save This option saves the selections and provides access to the

roles based on the selections.

List View

The List view presents available lists in a grid. Associated procedures for this view are provided
under: Define List Groups and Lists. You can perform the following actions:

l Define lists and list groups.

l Delete lists and list groups.

l Set access permissions for lists and list groups.

l Import lists and list groups.

l Export lists and list groups.

l Edit a list.

l Duplicate a list.

To access the view:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

The following figure shows the List view.
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Features

The List view includes the following panels:

l List Groups panel

l List toolbar

l List View panel

List Groups Panel

The Groups panel provides a list of groups used to organize lists and has a toolbar that allows
you to perform operations on the groups. The features of the Groups panel are described in the
following table.
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Feature Description

This option allows you to add a new chart to the Reporting module.

This option allows you to delete one or more selected charts.

This option allows you to edit a chart.

This option refreshes the view.

The actions menu has the following options: Import, Export and Permissions.

You can perform the following actions using the List Groups panel:

l Refresh the lists in a group.

l Move lists between different groups. You can move a list from one group to another by
dragging and dropping the list in the required group.

l Add a list group.

l Delete a list group.

l Import lists and list groups.

l Export list groups.

l Set access control for list groups.

List Toolbar

Feature Description

This option allows you to add a new list to the Reporting module.

This option allows you to delete one or more selected lists.

This option allows you to edit a list.

This option creates a duplicate copy of the selected list.
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Feature Description

The actions menu has the following options: Import, Export and Permissions.

List View Panel

The List View panel displays all the lists defined in a tabular format. The following table lists
the  columns and their description.

Column Description

Name

The name of the list.

Note: For Name field, the icon to extend the column size is not displayed at the
end of the column field. You have to hover the mouse a little to the left side to
see the icon for extending the column.

Group The list group to which the list belongs.

Date

Modified

The date and time when the list was modified.

Report References
The Reporting module user interface provides access to Security Analytics reports. This topic
contains descriptions of the user interface as well as other reference information to help users
manage Reports.

Topics

l Build Report View

l Import Report Dialog

l Reports Permissions Dialog

l Report View

l Schedule References

l Features

l Features

l Features
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l Features

l Features

l Select a Logo Dialog

l View All Reports Panel

l View a Report Panel

Schedule References

The Reporting module user interface provides access to Security Analytics scheduled reports.
This topic contains descriptions of the user interface as well as other reference information to
help users schedule reports.

Topics

l Features

l Features

l Features

l Features

l Features

Execution History Panel

The Execution History panel allows you to fetch and display history details.

To access this view:

1. In the Report List panel, do one of the following:

l Hover the mouse over a report and click   > View Scheduled Reports. 

l Click #Schedules column.

l In the Report List panel, do one of the following:

l Hover the mouse over a report and click   > View Scheduled Reports. 

l Click #Schedules column.
The Schedule Reports view is displayed with the status of each of the scheduled report.
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l Select a scheduled report and do one of the following:

l Click  > Execution History.

l Click  from the Scheduled Reports Toolbar Panel.

The following figure is an example of the Execution History view.

Features

The View Execution History has the following panels:
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l Execution History Options panel

l Execution History Output panel

Options Panel

The Execution History Options panel allows you to fetch the history details based on either past
n number of scheduled reports or a specific date range.

The following table lists the operations in the Execution History Options panel:

Operation Description

Get history by: This is the criteria to view the execution history:

l Past # Executions: The past n number of scheduled reports.

l Range (specific): The start date and end date for the date range.

Note: The From and To field is populated in the Security Analytics UI
only when you select 'Range (Specific)' from the Get history by list.

From The start date for the date range.

To The end date for the date range.

Count The number of execution history of the scheduled report to be displayed.

Shows the history details based on the selected criteria.

Output Panel

The Execution History Output panel displays the history details with the execution date,
execution duration (seconds), state of the scheduled report, and a link to view the report.

The following table lists the various columns in the Execution History Output panel:

Column Description

Execution Date The date on which the scheduled report was executed. By default, the

execution date is in descending order.
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Column Description

Execution Duration

(Sec)

The time duration taken to execute the scheduled report.

State The state of the scheduled report:

l Scheduled: If a report is scheduled to run on an hourly, daily, weekly,
monthly, or later time, the state of the report is displayed as
scheduled, for the first run.

l Queued: If a report is still waiting to get executed, the state of the
report is displayed as queued.

l Running: If the report schedule is in progress, the state of the report is
displayed as running.

l Partial: If in a report with several rules, a single rule execution failed
or an output action failed or creation of PDF/CSV failed, the state of
the report is displayed as partial. For example, consider a report with
five rules and
four rules are executed successfully and one fails, then the state is
displayed as Partial.

l Failed: If in a report with several rules, all the rule schedule
executions failed, the state of the report is displayed as failed.

l Completed: If a report schedule is successfully executed, the state of
the report is displayed as completed.

l Canceled: When cancel request is completed, the state of the report is
displayed as canceled.

l Inactive: If a report schedule is disabled, the state of the report is
displayed as Inactive.

l Not available: If the report schedule executed information is not
available, the state of the report is displayed as not available.

View Report The hyperlink to View a Report on full screen.

Close Closes the execution history view.
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Generate List Dialog

The Generate List dialog allows you to generate and customize a list.

The following figure is an example of the Generate List dialog.

Features

Field Description

List Name The name of the list chosen from the List Selection panel.

Browse Click this button to select a list from the List Selection Window dia-

log.

Rule Select a rule to be used to create the list.

Column Select a value for the column. 

Overwrite Existing

List?

Overwrites the existing list.

Save Adds the desired list to the Generate List panel of the Schedule

Report view.

The following table lists the features in the Generate List dialog.

The List Selection Window dialog consists of lists that are defined in the Lists panel. Here, you
can select a list to associate it with the report. The following figure shows the dialog.
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Schedule Report Panel

The Schedule Report panel allows you to schedule a customized report.Prior to scheduling a
report, you have to create a dynamic list (with the overwrite option selected) with services
added. For more information, see Prerequisites. Then use the list to generate a report with details
in the report like services and host names.

To access this view:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. In the Report List panel, click   > Schedule Report.
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The following figure shows the panels on the Schedule Report view.

Features

The Schedule Report view consists of the following panels:

l Schedule Report

l Output Actions

l Dynamic List

l Logo

Schedule Report Panel

The Schedule Report panel allows you to schedule reports.
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The following table lists the fields in the Schedule Report panel.

Field Description

Enable Enables the report schedules and runs the report.

Report Name The name of the report.

Schedule Name  The name of the scheduled report configuration.

NetWitness DB The database can be NWDB, IPDB, and Warehouse DB depending on the

type of database that you selected in the rule definition. If the report has

rules of NWDB, IPDB, and Warehouse DB types, all the database types or

rule types are displayed.
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Field Description

Warehouse

Resource Pool

If the report has rules of Warehouse DB, the Warehouse Resource Pool

drop-down is displayed to select the pools or queues available in the

cluster. If no pools or queues are entered for the Reporting engine, this field

is disabled. For more information, see Step 5: Configure Task Scheduler for

a Reporting Engine topic in the Host and Services Configuration Guide.

Run Provides the type of schedule for the run configuration:

l Ad-hoc execution

l Hourly execution

l Daily execution

l Weekly execution

l Monthly execution

On The data range on which the query is run.

Use relative

time calculation

Uses the relative time duration to schedule a report.

Iterative Report Select the checkbox to schedule a report for the selected list value.
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Field Description

Iterate on List Click this button to navigate to the List Selection panel and select a

list. The following figure displays this panel:

The List Selection panel is a collection of Lists. The Reporting Engine

maintains an active list of the available list names by continuously syn-

chronizing with the collection to which it is connected.

Apply To Apply list values on the selected variable. 

Variables  Displays the rule variables along with their associated values and the iter-

ative properties included in the report.

Note: Depending on the rule chosen while creating a report, you can
view dynamic variables defined for the rule in the Variablesfield of the
Schedule Report panel. For example, Test-Country is the rule having the
dynamic variable var. 

Schedule Schedules the report.

Reset Resets the scheduled report.
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Field Description

Configure Allows you to alter the Reporting Engine configuration details on the

Reporting Engine General Tab topic in the Host and Services Configuration

Guide.

Note: This button is visible on the Schedule Report panel only when you
have the 'Manage Device' access permissions on the Reporting module.

Output Actions Panel

The Output Actions panel specifies output actions to notify the email recipient when the report
execution completes and also sends reports in PDF and CSV formats as attachments in the
email, based on your selection.

The following table lists the fields in the Output Actions panel.

Field Description

To A comma-separated list of email addresses to receive the output.

Subject The subject entered in the mail.
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Field Description

Body The body of the email. By default, the body field is populated with pre-

defined text that has certain variables that will add meta appropriate to the

generated report.

In the Reporting Engine, these variables are replaced with actual values.

l ${RanAtStartTime} : The Start time of the report.

l ${DataRangeStartTime} : The Start time of the data time range.

l ${DataRangeEndTime} : The End time of the data time range.

l ${LinkToSA} : The link to the Security Analytics Host from the email
which in turn opens the report in Security Analytics interface.

l ${ReportName} : The name of the report.

l ${DataSource} : The name of the data source.

Attach: The output format in which the report is attached to the email, such as

PDF or CSV as configured in the Schedule Report dialog.

CSV Delimiter The default CSV delimiter is comma (,). If the CSV content contains a

comma, you must identify a unique separator so the content is stored in its

original form. For example, if msg is a column in the report to be saved as

CSV and the msg content is as follows: ASA-SSM-CSC-20 Module in

slot 1," application reloading ""CSC SSM"""," version

""6.2.1599.0"" CSC SSM scan services are reloading

because of a pattern file or configuration update

The above content will be included in three columns due to the commas

(,). To avoid this, you must specify a different delimiter such as a pipe line

character “|”.   

Note: To import the CSV file into Microsoft Excel, use the Data > From
Text option in the Excel application. When you import the CSV file you
must  specify the file type of the file being imported as Delimited and
use the same delimiter that you specify to generate the CSV file.
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Field Description

Multivalue Delim-

iter

The data in multivalued fields are separated by the multivalue delimiter.

The default Multivalue delimiter is two pipe line characters (||).

Other Options You can select an SFTP, URL, or Network Share location configured in

((RE}} and then send the report either in PDF or CSV format based on the

requirement.

Select this option to send the report to the SFTP, URL or Network Share

location configured in the Reporting Engine Services Config view.

Type The type of output action chosen. For example, SFTP, URL or Network

Share.

Output Actions Select the SFTP, URL or Network Share name configured in the Report-

ing Engine Services Config view.

Send as PDF

/ Send as CSV

Select these options to send the report either in PDF or CSV format, or

both to the configured Notification Server (SFTP, URL or Network

Share).

Dynamic List Panel

The Dynamic List panel populates the lists created and you can add, edit or delete the list. The
list is generated based on the scheduled report which can be viewed in the Lists view.

The following table lists the operations in the Generate List panel.
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Operation Description

Adds a new list to the report.

Deletes all the lists added to the report.

Displays the Generate List dialog.

List Name The name of the list chosen from the List Selection panel. For more information

on the List Selection panel, see Features.

Logo Panel

The Logo panel populates the default logo from the Select a Logo panel. For more information
on choosing a logo from this panel, see Manage and Select a Report Logo.

You can set the default logo for a Reporting Engine. This is the logo that is used in the generated
reports. For more information on choosing a logo, see Select a Logo Dialog.

Note: If you have not selected any logo then the default RSA logo is used on the report. The
option Save as PDF for the previously executed reports does not support a new customer logo.
It displays the default RSA Logo, if the customer logo must be displayed in the Schedule a
Report view.

Scheduled Reports View

The Scheduled Reports view allows you to create, view and manage scheduled reports.
Associated procedures are provided in Schedule Reports andSet Access Control for a Report. You
can:

l Enable or disable a scheduled report.

l Start or stop a scheduled report.

l Edit a scheduled report.

l Delete a scheduled report.

l Set access permissions for a report.

l View the execution history of a scheduled report.
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To access this view:

1. In the Security Analytics menu, click Administration > Reports.

The Manage tab is displayed.

2. Click Reports.

The Report view is displayed.

3. In the Report List panel, do one of the following:

l Click   > View Scheduled Reports.

l Click the #Schedules column.

The following figure shows the different panels in this view:

Features

The View Scheduled Reports has the following features:

l Scheduled Reports toolbar

l Scheduled Reports List panel

Scheduled Reports Toolbar

The Scheduled Reports has options to add, modify and delete the scheduled report as well as
options to enable or disable the selected run configuration.

The following table lists the operations in the Scheduled Reports toolbar.

Operation Description

Create a new report schedule or scheduled report.

Deletes the selected report schedule.
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Operation Description

Edits the selected report schedule.

Note: Double-click on a desired report schedule to edit it.

Enables the selected report schedule.

Disables the selected report schedule.

View the history of the scheduled report.

Filter schedules based on the type of schedule. (For

example, AdHoc)

Allows you to set permissions for the selected scheduled report.

Automatically refreshes the scheduled reports list.

Searches schedules based on the schedule name.

Scheduled Reports List Panel

The Scheduled Reports List panel lists the scheduled reports in a tabular format. You can
perform the following actions using the

The following table lists the columns in the Scheduled Reports List panel:

Column Description

Name The name of the scheduled report.

Schedule The type of schedule for the run configuration:

l Ad-hoc execution

l Hourly execution

l Daily execution

l Weekly execution

l Monthly execution

Last Run Displays the last time the report was run.
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Column Description

Last Run(s)  Displays the number of times the same report was sched-

uled.

Avg(s) Displays the average time taken to run the report.
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Column Description

State Indicates the state of the scheduled report.

l Scheduled: If a report is scheduled to run on an hourly,
daily, weekly, monthly, or later time, the state of the
report is displayed as scheduled, for the first run.

l Queued: If a report is still waiting to get executed, the
state of the report is displayed as queued.

l Running: If the report schedule is in progress, the state
of the report is displayed as running.

l Partial: If in a report with several rules, a single rule
execution failed or an output action failed or creation of
PDF/CSV failed, the state of the report is displayed as
partial. For example, consider a report with five rules
and

l four rules are executed successfully and one fails, then
the state is displayed as Partial.

l Failed: If in a report with several rules, all the rule
schedule executions failed, the state of the report is
displayed as failed.

l Completed: If a report schedule is successfully executed,
the state of the report is displayed as completed.

l Canceled: When cancel request is completed, the state
of the report is displayed as canceled.

Note: Cancel option may not work for Warehouse
Analytics jobs. You must kill the job manually. Following
are the steps to kill the job:
For MapR:
1. Get the Jobid from job logs.
2. Login to jobtracker UI and search for Jobid to kill
under "Running Jobs".
Sample URL: http://<job-tracker-
host>:50030/jobtracker.jsp
3. Kill the Jobid:
• Select Jobid under "Running Jobs" and click Kill
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Column Description

Selected Jobs.
(or)
• Click on Jobid link, scroll down and click Kill this job
link.
For Pivotal:
1. Get the Jobid from job logs.
2. Kill the Jobid.
For Example:
mapred job -list
mapred job -kill job_1406294496331_0385
(or)
yarn application -list
yarn application -kill application_1406294496331_0385

l Inactive: If a report schedule is disabled, the state of the
report is displayed as Inactive.

l Not available: If the report schedule executed
information is not available, the state of the report is
displayed as not available.

Click to view the rule execution information and output
action information. 
This pop-up notifies the status of multiple rules in a report
and the time taken for its execution.

Note: You can view the rule execution and output action
information for a scheduled report having the state
Completed, Running, Partial or Failed. By default,
the Output Actions for Completed Report on Reporting
Engine Config page is set to enable, to receive an
email when the report status is completed. To receive an
email for Failed or Partial reports, you must disable this
option.

View Report Click to view the rule execution information on the View a

Report Panel. You can view the rule execution information

for a scheduled report having the state 'running' as well.
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Task Scheduler for Warehouse Reporting

A task scheduler in a Hadoop cluster schedules the jobs consisting of tasks, and allocates
specific resources to each job running in a cluster. By default, the task scheduler allocates equal
number of resources to all the jobs. For example, if 10 jobs are running they will share resources
of the cluster equally. However, you can configure the task scheduler to control the execution of
the jobs such that one job runs faster than others by allocating more resources (pools or queues)
to the job. This helps you prioritize to run a few reports over others.

Features

Security Analytics supports two task schedulers:

l Fair Scheduler (org.apache.hadoop.mapred.FairScheduler)

l Capacity Scheduler (org.apache.hadoop.mapred.CapacityTaskScheduler)

Fair Scheduler

This scheduler divides the total capacity of the cluster into logical pools. You can submit a job to
any one of these pools. All the jobs submitted to a pool share the resources allocated to the pool
only. Once a pool has free resources, the freed resources are given to other pools with jobs
running. For example, a fair scheduler has 100% resources with two pools namely Pool A and
Pool B which share the total resources at 40% and 60% respectively. If Pool A has four jobs
running, it allocates 10% resources to each job. When the four jobs are completed, the freed
resources are allocated to Pool B.

Note: You can configure a pool to run more than one job in parallel.

Capacity Scheduler

This scheduler divides the total capacity of the cluster into queues. Each queue is allocated a
pre-configured share of the total capacity. A job may be submitted to any of these queues. If
more than one job is submitted to the same queue, the jobs will be executed sequentially. For
example, if a capacity scheduler has 100% resources with three queues namely the Default,
Low and High and they share the total resources at 20%, 30% and 50% respectively. If Default
has two jobs D1 and D2, Low has three jobs L1, L2 and L3, and High has four jobs H1, H2, H3
and H4, these jobs are executed in their respective queues sequentially. If the jobs in a queue
are completed, the freed resources will not be distributed to other queues.

Build Report View

In the Build Report view, you can create a report, add text and rules, and schedule a report.
Associated procedures are provided under Add a Report and Prerequisites
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To access this view:

1. In the Security Analytics menu, click Administration > Reports.

The Manage tab is displayed.

2. Click Reports.

The Report view is displayed.

3. In the Report toolbar, click  .

The Build Report tab is displayed.

The following figure is an example of the Build Report view.

The Build Report view consists of the following panels:

l Report

l Text

l Rules

Report Panel

The Report panel allows you to create a report by assigning a name to the report. The content in
a report depends on the items selected from the Text and Rules panels.
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When you add rules to a report, you can change the output format of these rules either to tabular,
area, line or pie by clicking the  button.

The following table lists the features of the Report Panel and the description.

Feature Description

Name This field allows you enter the name of the report.

Options This field allows you to select the output format of the report such as Tabular,

Area, Bar, Bubble, Column, Line, Pie, Step Line, Step Area, Spline Area and

Spline.

Schedule  Clicking this option generates the report.

Save Clicking this option saves the report.

Text Panel

The Text panel consists of a list of text elements that add to the look and feel of the report. You
can use these text elements to format the report.

l To add more structure to reports, you can use these headers defined in the Text panel to
indent up to four levels. This allows you to identify specific sections in a report that can be
included in the Table of Contents for easy navigation in the report result.
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l To add headers to the Report panel, drag and drop H1, H2, H3, or H4 onto the Report pane
based on the desired level of indentation.

The following table lists the text elements used to format a report:

Text Elements Description

Header 1 The Header 1 element adds a first-level heading to the report defin-

ition.

Header 2 The Header 2 element adds a second-level heading to the report defin-

ition.

Header 3  The Header 3 element adds a third-level heading to the report defin-

ition.

Header 4  The Header 4 element adds a fourth-level heading to the report defin-

ition.

Table of Contents  The Table of Contents adds table of contents to the report definition.

Body Text  The Body Text element adds body text to the report definition.
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Text Elements Description

Comment  The Comment element adds comments to the report definition.

Note: The Comment element is not displayed when you view all the
reports.

Rules Panel

The Rules panel consists of a list of rules that are defined in the Rules panel. From the rules list,
you can drag and drop rules onto the Report panel to associate those rules with the report.

You can search for a specific rule using search text box provided in the Rules panel.

The following table lists the features of the Rules Panel and the description.

Feature Description

Text This option allows you to select the text elements you can use to format a report:

Rules This option allows you select the rule you want to use to create the report.
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Import Report Dialog

This topic describes the features of the Build Report view. In this dialog, you can import groups
containing subgroups and reports from other instances of Security Analytics into Report Groups
panel. Reports must be in a valid binary file that was exported from another Security Analytics
instance.

Procedures related to this dialog are described in Import Reports and Report Groups.

To access the dialog:

1. In the Security Analytics menu, click Administration > Reports. 
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report Groups panel, select a folder to import the file.

4. Do one of the following:

l In the Report Groups panel, click    > Import to import a group.

l In the Report toolbar, click   > Import to import a report.

The following figure is an example of the Import Report dialog.

 Feature Description

Browse This option displays a view of the local file system so that you can select the

report to be imported.

Delete This option deletes an imported report from the list of imported reports.

File Name Displays a list of report files that will be imported to your Reports module when

you click Import.
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 Feature Description

Overwrite? Allows you to select the option to overwrite an existing version of the report you

are importing. If you do not select the Overwrite option, a duplicate file is impor-

ted and no error message is displayed.

Close This option closes the dialog. If you have reports select for import, but have not

clicked Import. The reports are not imported, and are not saved in this dialog. 

Import This option imports the selected reports to your Reports module.

Reports Permissions Dialog

This topic describes the features of the Reports Permissions dialog. The users with 'Read &
Write' access permission to set access permissions for a report can configure permissions in the
Reports Permissions dialog. Associated procedures are provided in Manage Access for a Report or
Report Group

To display the Reports Permissions dialog:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report List panel, select a report.

4. Click  > Permissions.

The Reports Permissions dialog is displayed.
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The following figure is an example of the Reports Permissions dialog.

Note: On selecting the check box, all dependent rules are given READ access permission,
provided the permissions for the report is higher compared to the permissions of the rules.

The following table describes the features in the Reports Permissions dialog.

 Feature Description

Roles Displays all the roles who can get access to the per-

missions.

Read&Write Allows you to get Read&Write access to the Rules in the

Reports.

Read Only Allows you to get Read Only permissions to the Rules in

the Reports.

No Access If you select this option, you will not get permission to the

Rules in the Reports.

Apply Read-only permissions to

Rules in the Reports

Allows to set Read Only permissions to the Rules in the

Reports for all the roles .
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 Feature Description

Cancel  This option cancels all the changes made to the per-

missions.

Save This option saves the selections and provides access to

the roles based on the selections.

Report View

In the Report view, you can create and organize report groups. The procedures associated with
this view are provided under Define Report Groups and Reports.

You can perform the following actions using this panel:

l Refresh a group or report list.

l Add a report group.

l Delete a report group.

l Import reports and report groups.

l Export a report group.

l Set access permissions for a report group.

The toolbar has the following options:

l Add a Report

l Edit a Report

l Delete a Report

l Duplicate a Report

l Import Reports and Report Groups

l Export a Report

l Set Access Control for a Report

l Prerequisites

l Prerequisites

To access this view:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.
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2. Click Reports.
The Report view is displayed.

The following figure shows the different panels on the Report view.

Features

The Report view includes the following sections:

l Report Groups panel

l Report toolbar

l Report List panel

Report Groups Panel

The Report Groups panel allows you to organize reports in a group. You can create a report
group, add reports to the group, and move reports among groups. You can view all reports by
selecting All option under the Groups column.

Feature Description

This option allows you to add a new report to the Reporting module.

This option allows you to delete one or more selected report.
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This option refreshes the view.

The actions menu has the following options: Import, Export and Permissions.

Report Toolbar 

The Report toolbar allows you to add, modify, delete, duplicate, import and export reports. You
can also set access permissions for a report in a group.

Feature Description

This option allows you to add a new report to the Reporting module.

This option allows you to delete one or more selected reports.

This option allows you to edit a chart.

This option creates a duplicate copy of the selected report.

The actions menu has the following options: Import, Export and Permissions.

Report List Panel

The Report List panel lists all the reports in a tabular format.

The following table describes the columns in the Report List panel.
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Column Description

Name The name of the report.

Group The Report Group to which the report belongs.

Date

Modified 

The date and time when the report was modified.

#Schedules  The count indicates the number of schedules created for a report.

Actions The actions menu has the following options: Schedule Report, View Scheduled

Reports, Delete, Edit, and Export. 

Schedule References

The Reporting module user interface provides access to Security Analytics scheduled reports.
This topic contains descriptions of the user interface as well as other reference information to
help users schedule reports.

Topics

l Features

l Features

l Features

l Features

l Features

Select a Logo Dialog

In the Select a Logo dialog, you can upload a new logo that is not available in Reporting Engine
Services Config view or choose an existing logo from the Reporting Engine Services
Config view. The procedure associated with this view are described under Select a Logo.

To access this dialog:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report List panel, select a report.
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4. Click   > View Scheduled Reports.

The View scheduled reports view tab is displayed.

5. Select a scheduled report and click   > Edit Schedule.

The Schedule a Report view tab is displayed.

6.  Click the Logo panel.
The Change a Logo dialog box is displayed.

The following figure is an example of the Select a Logo dialog.

The following table lists the fields in the Select a Logo dialog.

Field Description

Upload new

logo

Click the icon to upload a new logo from the local directory.

Select Select a logo from the existing list to be used as a logo in the scheduled

report.

Cancel Cancels the logo selection and returns to the Schedule a Report panel.

Set Default Select a logo to set it as the default logo.
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View All Reports Panel

In the View All Reports view, you can display, print, save and email reports. The
procedures associated with this view is described under View a List of All Reports.

To access this view:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed. 

3. In the Report panel, click View All Reports.

The following figure is an example of this panel.

Features

The View All Reports panel has the following features:

l Reports toolbar

l Reports Output

l Reports Calendar

l Reports Time

The following table lists the options in the View All Reports toolbar:
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Operation Description

Searches schedules based on the report name or schedule name

for a selected calendar day.

Clicking on any of the reports listed allows you to view the report.

Reports Toolbar

The Reports toolbar allows you to print, save, email, and view reports on full screen.

Note: The Reporting Engine is responsible for generating PDF and CSV output of the reports
based on the report definition. The size of the PDF files for a report must not exceed 50,000
cells.

The following table lists the options in the Reports toolbar.

Operation Description

Prints the generated report.

Saves the report as a PDF and CSV file.

Note: The Save As PDF option is not available for a large report. If you are
generating a PDF for a report and it takes a longer time than expected, you
get a warning message stating PDF generation is in progress, please try
after some time.

When you click download as a CSV file, the Select Rule to downloaddialog is

displayed. You must select a rule from this dialog to download the rule result in

a CSV file.

If the file generation takes a while, you can click on the Notify me option to be

notified once the PDF or CSV is generated. Once the PDF or CSV is gen-

erated, you can view the Notifications for the status. 

Emails the report with the PDF or CSV attachment.

Opens the generated report on a new window.
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Reports Output Panel

The Reports Output panel displays the report with the report schedule name, report generated
time and the actual report with the selected rule variables.

Feature Description

Name This field displays the name of the scheduled report.

Time

This field displays the time when the report is generated.

Report This field displays the details report with the selected rule variables.

Reports Calendar Panel

The Reports Calendar panel is used to select a date from the Calendar. Based on the date you
select, the list of successfully run reports for the date is displayed.

Reporting Module References 404



Reporting Guide

Reports Time Panel

The Reports Time panel displays the time when the report was actually run.

View a Report Panel

The View a Report panel is used to review the reports. The procedure associated with this is
described under View a Report.

To access this view:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. In the Report List panel, do one of the following:

l Click   > View Scheduled Reports.

l Click the #Schedules column.
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The following figure shows the View Scheduled Reports.

Features

The View a Report panel has the following sections:

l Reports toolbar

l Reports Output panel

l Reports Calendar panel

l Reports Time panel

When you click View on the scheduled report having Iterative selected, the Sub Reports panel
is displayed. For each value in the configured list a report is generated.
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The following table lists the columns in the Sub Reports panel.

Column Description

Values The List values chosen for a dynamic variable from the List Selection panel.

State Indicates the state of the scheduled report for each of the list values.

l Partial: If in a report with several rules, a single rule execution failed or an
output action failed or creation of PDF/CSV failed, the state of the report
is displayed as partial. For example, consider a report with five rules and four
rules are executed successfully and one fails, then the state is displayed as
Partial.

l Failed: If in a report with several rules, all the rule executions failed, the state
of the report is displayed as failed.

l Completed: If a report is successfully executed, the state of the report
is displayed as completed.

View Clicking on any of the report schedules or sub reports listed and then View dis-

plays the desired report.

Note: You can view the completed rules on the View a Report page even
when the report is 'running'.

For more information, on each of these panels, see View All Reports Panel.

Rule References
The Reporting module user interface provides access to Security Analytics rules. This topic
contains descriptions of the user interface that pertain to Rules defined for Reports and Alerts as
well as other reference information to help users manage Rules.

Topics

l Build Rule View

l Query Aggregates

l Rule Permissions Dialog

l Rule View
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l IPDB Event Source Specification

l Warehouse Database Rule Definition Modes

l General Syntax of an Advanced Rule

l All Event Categories Report

Warehouse Database Rule Definition Modes

This topic describes Warehouse DB rule definition modes. You can generate reports of the
Warehouse data source by creating rules to query the data source. The rules can be defined in
two modes:

l Default Mode

l Expert Mode

Default Mode

In Default Mode, you can create rules containing simple SQL like HIVE queries that
contain clauses like Select, Where, Group By, and Having. By default, you can create rules to
query sessions or raw logs. For more information on Simple query syntax and examples, see All
Event Categories Report.

The following figure is an example of the Build Rule view that displays when you
select Warehouse DB for Rule Type without the Expert Mode selected.
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Querying Raw Logs

The raw log format is used in the select or where clause to query for raw logs.

Note: The time range that you can specify in your query is a day (24 hours). If you have
specified a time range less than a day in your query, the result set contains data of at least a
day (24 hours).

The following figure is an example of the Build Rule view that displays when you
select Warehouse DB for Rule Type and create a rule for querying raw logs.

Expert Mode

The following figure is an example of the Build Rule view that displays when you
select Warehouse DB for Rule Type with Expert Mode selected.
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If you want to generate a report for a specific time range, you need to manually define the time
range in the query using the following two variables:

l ${report_starttime} - The starting time of the range in seconds.

l ${report_endtime} - The ending time of the range in seconds.

For example, SELECT col1, col2 FROM custom_table WHERE timecol >= ${report_
starttime} AND timecol <= ${report_endtime};

Note: By default, Reporting Engine treats ${keyword} as a variable. If you want to specify
HIVE variables, you must mention the complete syntax of a variable. For example,
${hiveconf:hive.exec.scratchdir}.

Topics:

l General Syntax of an Advanced Rule

l All Event Categories Report

Warehouse DB Advanced Rules

This topic provides examples of Warehouse Data source rules. You can define Warehouse DB
rules using HIVE queries. You can define simple and advanced rules for the Warehouse Data
source using the following modes:
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l Default Mode 

l Expert Mode

Advanced rules are defined using complex HIVE queries created using the clauses DROP,
CREATE, and so on. Unlike simple rules, we always insert the results into a table. For more
information on Advanced HIVE query language, see HIVE language manual.

The following examples illustrate advanced rules in the expert mode:

l Hourly, daily, weekly, and monthly report

l Table partition based on location report

l Join logs and sessions based on unique_id report

l List report

l Parameterized report

l Partition based table with multiple locations

l Automated partition using custom function (10.5.1 onwards) 

General Syntax of an Advanced Rule

The following figure shows how to define an advanced query.
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The following syntax is an example of an advanced query:
DROP Table IF EXISTS sessions21022014;

CREATE External TABLE sessions21022014

ROW FORMAT SERDE ‘org.apache.hadoop.hive.serde2.avro.AvroSerDe’

STORED AS INPUTFORMAT

'org.apache.hadoop.hive.ql.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT

'org.apache.hadoop.hive.ql.io.avro.AvroContainerOutputFormat'

LOCATION '/RSA/rsasoc/v1/sessions/data/2013/12/2’

TBLPROPERTIES('avro.schema.literal'='
{

"type":"record";

"name":"nextgen";

"fields":
[
{"name":"time", "type":["long", "null"], "default":"null"},

{"name":"threat_category", "type":["string", "null"],
"default":"null"},

{"name":"ip_src", "type":["string", "null"], "default":"null"},

{"name":"device_class", "type":["string", "null"], "default":"null"}
]
'};

set mapred.input.dir.recursive=true;
set hive.mapred.supports.subdirectories=true;

select  from_unixtime(time), threat_category, ip.src from time_variable
where threat_category is not NULL and time >= ${report_starttime}
and time <= ${report_endtime};

Note: Reporting Engine treats a line beginning with <hyphen> <hyphen> as a comment in
Expert Warehouse Rule.
For example,
set mapred.input.dir.recursive=true;
-- This is an Expert comment
set hive.mapred.supports.subdirectories=true;

The general syntax of an advanced query is as explained below:

1. Drop and create an external table, and then format the row:
Firstly, we drop the table, if the table already exists and create an external
table sessions21022014
DROP TABLE IF EXISTS sessions21022014
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CREATE EXTERNAL TABLE sessions21022014

Note:  You must create an external table only if you are using an other table. For example,
if you are using an other table apart fromsessions21022014 then you must drop the table
and create an external table.

Then, specify the row format as Avro.SerDe interface to instruct HIVE as to how a record is
to be processed. Avro.SerDe allows you to read or write Avro data as HIVE tables and store
them as input format and output format.
ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avro.Avro.SerDe'
STORED AS INPUTFORMAT

'org.apache.hadoop.hive.ql.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT

'org.apache.hadoop.hive.ql.io.avro.AvroContainerOutputFormat'

2. Specify the HDFS location:
Secondly, you must specify the HDFS
location '/RSA/rsasoc/v1/sessions/data/2013/12/2' from where the data is queried before
executing the HIVE statements.The location parameter specifies the data to be fetched
depending on the date input provided. This is a variable parameter hence you can fetch
values depending on the date entered.

3. Define the table schema:
Thirdly, you define the table schema by defining columns with a specific data type and
default value as 'null'.
TBLPROPERTIES('avro.schema.literal'='

{"type":"record";

"name":"nextgen";

"fields":

[

{"name":"ip_src", "type":["string", "null"], "default":"null"}

]

'};

4. Import data from directory which contains sub directories:
Then, you must enable HIVE to recursively scan all sub-directories and fetch all the data
from all sub-directories.
set mapred.input.dir.recursive=true;

set hive.mapred.supports.subdirectories=true;
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5. Fetch data from the HIVE table:
Once you execute all the above statements, you can query the database with the HIVE
query select clause to fetch the data from the HIVE table.

Hourly, Daily, Weekly, and Monthly Report

In these example rules, you can create various reports for December 02, 2013 (as in the below
figure). The date variable in the LOCATION statement can be altered, depending on which you
can create an hourly, daily, weekly, and monthly report.

Hourly Report

In this example rule, you can create an houly report for December 02, 2013. The LOCATION
statement can be altered to generate an hourly report.

LOCATION '/RSA/rsasoc/v1/sessions/data/2013/12/2' - the date input (2013/12/2) indicates
year/month/day. The entire data for 02 December, 2013 is retrieved using this location
statement. 

The result set of this query would be an hourly report.

Daily Report

In this example rule, you can create a daily report for December 2013. The LOCATION
statement can be altered to generate a daily report.

LOCATION '/RSA/rsasoc/v1/sessions/data/2013/12' - the date input (2013/12) indicates
year/month. The entire data for December, 2013 is retrieved using this location statement.
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The resultset of this query would be a daily report.

Weekly Report

In this example rule, you can create a weekly report for December 2013. The LOCATION
statement can be altered to generate a weekly report.

LOCATION '/RSA/rsasoc/v1/sessions/data/2013/12' - the date input (2013/12) indicates
year/month. The entire data for December, 2013 is retrieved using this location statement.

The result set of this query would be a weekly report.

Monthly Report

In this example rule, you can create a monthly report for the year 2013. The LOCATION
statement can be altered to generate a monthly report.
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LOCATION '/RSA/rsasoc/v1/sessions/data/2013' - the date input (2013) indicates year. The
entire data for the year 2013 is retrieved using this location statement.

The result set of this query would be a monthly report.

For more information on LOCATION definition, see Specify the HDFS location in the General
Syntax of an Advanced Rule section.

You must perform the following steps in sequence to view the resultset of an advanced rule:

1. Define an Advanced Rule

2. Add an advanced rule to a Report

3. Schedule a Report

4. View a scheduled Report

The following figure shows how to define an advanced rule.
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The following figure shows how to add an advanced rule to a report (For
example, AllEventCategories).

The following figure shows how to schedule a daily report.
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If you want to generate a report for a specific time range, you need to manually define the time
range in the query using the following two variables:
${report_starttime} - The starting time of the range in seconds.
${report_endtime} - The ending time of the range in seconds.

For example, SELECT from_unixtime(time), threat_category, ip.src FROM
time_variable WHERE threat_category is not NULL AND time >= ${report_
starttime} AND time <= ${report_endtime};

The following figure shows the result set of scheduling a daily report.
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Table Partition Based on Location Report

In this example rule, you can create a table partition based on location. Each table can have one
or more partition keys which determines how the data is stored. For example, a country_dst of
type STRING and an ip_src of type STRING. Each unique value of the partition keys defines a
partition of the table.

In the example provided, we execute a HIVE query to fetch destination country and IP address
of source from the sessions05032014 table and group the result set by these fields.

This rule provides information about the table created, row formatted, location (directory path)
for avro data files in Warehouse, and returns a result set as per the HIVE query to indicate that
the query returned a result set. For more information on these statements, see the General
Syntax of an Advanced Rule section.

The following figure shows the result set of creating a table partition based on location report.
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Join Logs and Sessions Based on unique_id Report

In this example rule, you can create a rule to join logs and sessions table to fetch unique_id, IP
address of source and destination, and packet ID based on unique_id.

In the example provided, we execute a HIVE query to fetch certain fields from both the
sessions_table and logs_table by performing a join based on the 'unique_id' field.

This rule provides information about the table created, row formatted, location (directory path)
for avro data files in Warehouse, and returns a result set as per the HIVE query to indicate that
the query returned a result set. For more information on these statements, see the General
Syntax of an Advanced Rule section.
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The following figure shows the result set of joining logs and sessions table based on unique_id.

List Report

In this example rule, you can create a List report to fetch IP address of source and destination,
and device type from the lists_test table where device type is not null and IP address of source
is fetched from the appropriate event list.
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This rule provides information about the table created, row formatted, location (directory path)
for avro data files in Warehouse, and returns a result set as per the HIVE query to indicate that
the query returned a result set. For more information on these statements, see the General
Syntax of an Advanced Rule section.

The following figure shows the result set of executing a list report.
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Parameterized Report

In this example rule, you can create a rule to fetch IP addresses of source and destination, and
device type from the runtime_variable table based on the specified run time
variable ${EnterIPDestination}. At run time, you are prompted to enter a value for the IP
address of destination ip_dst. Based on the value entered, the result set is displayed.

This rule provides information about the table created, row formatted, location (directory path)
for avro data files in Warehouse, and returns a result set as per the HIVE query to indicate that
the query returned a result set. For more information on these statements, see the General
Syntax of an Advanced Rule section.

The following figure shows the result set of executing a parameterized report.
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Partition Based Table with Multiple Locations

The following is an example of partition based table with multiple locations:

set mapred.input.dir.recursive=true;
set hive.mapred.supports.subdirectories=true;
DROP TABLE IF EXISTS AVRO_COUNT;
CREATE EXTERNAL TABLE AVRO_COUNT
PARTITIONED BY (partition_id int)
ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avro.AvroSerDe'
WITH SERDEPROPERTIES (
'avro.schema.literal'='{
"name": "my_record", "type": "record",
"fields": [
{"name":"sessionid", "type":["null", "long"], "default" :

null},
{"name":"time", "type":["null", "long"], "default" : null}
]}'
)
STORED AS
INPUTFORMAT
'org.apache.hadoop.hive.ql.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT
'org.apache.hadoop.hive.ql.io.avro.AvroContainerOutputFormat';
ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=0) LOCATION

'/rsasoc/v1/sessions/data/2015/07/22/8';
ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=1) LOCATION

'/rsasoc/v1/sessions/data/2015/07/22/9';
ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=2) LOCATION

'/rsasoc/v1/sessions/data/2015/07/22/10/';
ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=3) LOCATION

'/rsasoc/v1/sessions/data/2015/07/22/11/';
ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=4) LOCATION

'/rsasoc/v1/sessions/data/2015/07/22/12/';
SELECT COUNT(*) as TOTAL FROM AVRO_COUNT WHERE time >=

${report_starttime} AND time
<= ${report_endtime};

The partition based table with multiple location is as explained below:

1. Enable HIVE to recursively scan all sub-directories and read all the data from the sub-
directories.
set mapred.input.dir.recursive=true;

set hive.mapred.supports.subdirectories=true;

2. Drop and create an external table, and then format the rows:
DROP TABLE IF EXISTS AVRO_COUNT;
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CREATE EXTERNAL TABLE AVRO_COUNT

PARTITIONED BY (partition_id int)

ROW FORMAT SERDE

'org.apache.hadoop.hive.serde2.avro.AvroSerDe'

WITH SERDEPROPERTIES (

'avro.schema.literal'='{

"name": "my_record", "type": "record",

"fields": [

{"name":"sessionid", "type":["null", "long"], "default" :

null},

{"name":"time", "type":["null", "long"], "default" : null}

]}'

)

STORED AS

INPUTFORMAT

'org.apache.hadoop.hive.ql.io.avro.AvroContainerInputFormat'

OUTPUTFORMAT

'org.apache.hadoop.hive.ql.io.avro.AvroContainerOutputForma

t';

Note:  You must create an external table only if you are using any other table. For
example, if you are using any other table apart from AVRO_COUNT then you must
drop the table and create an external table.

Note: Points to remember when you create a table:
- Dropping a 'non-external' table deletes the data. 
- The  table is partitioned on a single column called partition_id and this is the
standard column for Reporting Engine.
- The default value of any column is null as the AVRO file may not contain the
specified column.
- The column names should be in the lowercase as HIVE is case insensitive
but AVRO is case sensitive.
- You must specify avro.schema.literal in the SERDEPROPERTIES .

For more information on the rule syntax, please refer to Apache HIVE. 

3. Add partitions:
Once you define a table, you must specify the HDFS locations from where the data needs to
be queried before you execute the HIVE statements.The location parameter specifies the
data to be fetched depending on the specified date. The data is spread across multiple
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locations or directories in HDFS. For each location you need to add a partition with unique
values assigned to the partition column. The locations can be any directory in the HDFS
ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=0) LOCATION

'/rsasoc/v1/sessions/data/2015/07/22/8';

ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=1)

LOCATION '/rsasoc/v1/sessions/data/2015/07/22/9';

ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=2)

LOCATION '/rsasoc/v1/sessions/data/2015/07/22/10/';

ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=3)

LOCATION '/rsasoc/v1/sessions/data/2015/07/22/11/';

ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=4)

LOCATION '/rsasoc/v1/sessions/data/2015/07/22/12/';

Note: HIVE reads each file in these locations as AVRO. Incase if there is a non-
AVRO file available in one of these locations then the query may fail.

4. Run the query
SELECT COUNT(*) as TOTAL FROM AVRO_COUNT WHERE time >=

${report_starttime} AND time

<= ${report_endtime};

When a table is created, you can execute specific queries to filter the data. For example,
after you create the table you can filter the data as shown in the below examples: 
Sessions with a specific Source IP Address:
SELECT * FROM AVRO_COUNT WHERE time >= ${report_starttime}

AND time <= ${report_endtime} AND ip_src = '127.0.0.1';
Group by based on user destination:
SELECT * FROM AVRO_COUNT WHERE time >= ${report_starttime}

AND time <= ${report_endtime} GROUP BY usr_dst;

Automated Partition using Custom function

In 10.5.1, you can use the custom function to automate the addition of partitions to a user defined
table in the expert mode.

General syntax

RE WH CUSTOM ADDPARTITIONS(table, namespace, rollup, [starttime,
endtime])

The following table describes the custom function syntax:
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S.No Name Description

1 table The table name for which the partition has to be added.

2 namespace The namespace can be sessions or logs.

3 rollup

This value determines the level of directory path to be included in
partitions. The
value can be HOUR, DAY, or MINUTE. If Warehouse Connector is
configured for Day rollup, setting this value as HOUR produces ZERO
results. The number and location of each partition is based on time
range used to run the rule and the rollup value.

4 (Optional)

starttime,

endtime
To generate partitions for a specific time range other than the time
range mentioned in the rule, you must specify the starttime and
endtime in Epoch Seconds.

Note: Expressions are not supported for the starttime and endtime.

The custom function is invoked when Reporting Engine executes the rule either during test rule
or scheduled report. While running a expert rule, whenever Reporting Engine identifies the
function declaration, it extracts the required
arguments and insert n number of ADD PARTITION HiveQL statements and executes them on
the Hive Server.

The location and directory structure is determined by the argument passed in the
rule and the Hive datasource configuration
in Reporting Engine. The number of partitions depends on the rollup specified and the time
range used while executing the rule. For example, with the rollup as HOUR and the time range
as PAST 2 Days results in 48 partitions for 48 Hours while
with the rollup as DAY, Reporting Engine creates 2 partitions, one for each day.

The partition query is generated by the Syntax Template as set in Reporting Engine's Hive
Configuration attribute AlterTableTemplate.

Note: By default, this function starts adding partitions to a table with partition id from 0 to N-
1. Hence this requires that the table must be partitioned by single integer column named
partition id.
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The following is an example of automated partition using custom function:
set mapred.input.dir.recursive=true;
set hive.mapred.supports.subdirectories=true;
DROP TABLE IF EXISTS AVRO_COUNT;

CREATE EXTERNAL TABLE AVRO_COUNT
PARTITIONED BY (partition_id int)
ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avro.AvroSerDe'
WITH SERDEPROPERTIES (
'avro.schema.literal'='{ 
"name": "my_record", "type": "record", 
"fields": [ 
{"name":"sessionid", "type":["null", "long"], "default" :

null} 
,{"name":"time", "type":[ "null" , "long"], "default" : null} 
,{"name":"unique_id", "type":["null", "string"], "default" :

null} 
]}'

)
STORED AS 
INPUTFORMAT 
'org.apache.hadoop.hive.ql.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT 
'org.apache.hadoop.hive.ql.io.avro.AvroContainerOutputFormat';

RE_WH_CUSTOM_ADDPARTITIONS(AVRO_COUNT, 'sessions', 'DAY');
SELECT COUNT(*) as TotalSessions FROM AVRO_COUNT
WHERE time >= ${report_starttime} AND time <= ${report_

endtime};

Creating Custom Tables Report

In 10.6.1, you can use and create Custom Tables on the Hive Server. Reporting Engine supports
running queries on user defined tables and the ability to create a new table from a Single Rule
output. When this feature is enabled in the Warehouse Rule Builder UI, user can see a list of
custom tables available in Hive Server.
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To enable this feature set customTablesEnabled to TRUE by navigating to Reporting Engine
-> Explore ->Hive Config.
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Creating Custom Table from Regular Rules

To schedule a report which contains a single SAW rule, a new text input with a Warehouse
CTAS Name is added.The user can now specify a Custom Table name that will be created out
of the output of the rule in Report.

Note: This feature is available only if the Report contains a single SAW rule on the Schedule
page. Otherwise, this option is hidden.

The process to use the feature is explained below:

1. Create a rule to filter with data in SAW.

2. Create a Report with the above rule.
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3. Create a Schedule and enter the CTAS Table Name.
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4. Run the Report and Reporting Engine will create the Result Summary as below for the
Schedule.

5. On the next schema refresh or restart of Reporting Engine, the CTAS Table is listed.

Warehouse DB Simple Rules

This topic provides examples of Warehouse Data source rules. You can define Warehouse DB
rules using HIVE queries. You can define simple and advanced rules for the Warehouse Data
source using the following modes:
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l Default Mode 

l Expert Mode

In the Default mode, simple rules are defined using clauses like Select, Where, Group by, and
Having to query the data source. By default, you can create rules to query sessions or raw logs.

The following examples illustrate simple rules in the default mode:

l All Event Categories Report

l Attacks Event Categories Report

l Source: China Event Categories Report

l IP Source and Destination Event Categories Report

l by Time Threat Categories Report

l Array Query Report

l Raw Log Query Report

All Event Categories Report

This rule fetches all event categories, source country, and destination country from
the sessions table by defining alias names (temporary column names) for each of the fields to be
fetched from the table, that is, country_src for the source country, and country_dst for the
destination country.
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The following figure shows the result set of the All Event Categories rule.
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Attacks Event Categories Report

This rule fetches the event categories, source country, and destination country from
the sessions table by defining alias names (temporary column names) for each of the fields to be
fetched from the table and selecting only those columns whose event category name like
'Attacks.%'.  
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The following figure shows the result set of the Attacks Event Categories rule.
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Source: China Event Categories Report

This rule fetches the event categories, source country, and destination country from
the sessions table by defining alias names (temporary column names) for each of the fields to be
fetched from the table and selecting only those columns whose source country is 'China'. 
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The following figure shows the result set of the Source: China Event Categories rule.
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IP Source and Destination Event Categories Report

This rule fetches the IP address of source and destination country from the sessions table by
defining alias names (temporary column names) for each of the fields to be fetched from the
table and selecting only those columns whose destination country is NOT NULL. 
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The following figure shows the result set of the IP Source and Destination Event Categories
rule.
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by Time Threat Categories Report

This rule fetches the threat category events, the time the log or event was ingested into Log
Decoder/Decoder, and the source IP addresses from the sessionstable by defining alias names
(temporary column names) for each of these fields to be fetched from the table. 
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The following figure shows the result set of the by Time Threat Categories rule. The time
displayed in the time field is the UNIX time (For example, 1388743446). 

Note: In the “Select” clause the syntax would be “UNIX time” to convert to UTC time in
report. For example, you can use the Epoch time converter tool to convert UNIX time
(1388743446) to UTC (Coordinated Universal Time) (1/3/2014 3:34:06 PM). 
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Array Query Report

This rule fetches an array of alias host names from the sessionstable which contains the
value 'www.google.com'. 

443 Reporting Module References



Reporting Guide

The following figure shows the result set for querying an array from sessions.
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Raw Log Query Report

Raw logs can be queried either from the logs or sessions table.

This rule uses raw_log as a meta for querying raw log from logs whose packet ID is NOT
NULL.
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The following figure shows the result set for querying raw logs from logs.
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This rule uses ${raw_log} as a meta for querying raw log from sessions whose source IP
address is NOT NULL.
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The following figure shows the result set for querying raw logs from sessions.
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Build Rule View

This topic describes the features of the Build Rule view and the actions that you can perform.
Associated procedures are provided under Rules.

You can perform the following actions using the Rule panel:

l Define and save a rule.

l Reset the values of the rule.

l Test the correctness of the rule.

l Add the rule to a report.

l Add the rule to the alert queue.

l Add the rule to a chart.

To access the Build Rule view:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rule toolbar, click   > NetWitnessDB.

The Build Rule view tab is displayed
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The following figure is an example of the Build Rule view.

Features 

The Build Rule view includes the following panels:

l Rule panel

l Meta panel

l Lists panel
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Rule Panel

The Rule panel allows you to create a rule for the selected database type.

The following figure shows the Rule panel.

The following table describes the features in the Rule panel.

Feature Description

Rule Type A drop-down list of supported database types for which you can create rules. The

options are: Netwitness DB, IPDB, and Warehouse DB.

Name The name of the rule that you are creating or editing.
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Feature Description

Summarize A drop-down list of summarize options. The options are: None, Event Count,

Packet Count, Session Count and Custom.

Select The meta key for which you need the aggregate values; for example, ip.dest.

Where A Where clause that defines the conditions that trigger the rule execution; for

example, ip.dest = 127.0.0.1.

Group By The grouping method for the results. For example, specifying ip.dest produces a

report in which like ip.dest values are grouped.

Then A Then clause that defines the rule actions for additional processing on the out-

put.

Order By The sequencing method used to show results. For example, specifying Order By

the value in the Total column, Ascending, produces a report in which the results

are sorted in ascending order based on the value in the Total column.

Session

Threshold

A selection list for the session threshold, which specifies maximum number of

sessions that should be processed for aggregate functions.

Limit A selection list for the maximum number of result rows to be fetched.

Use Clicking Use enables you to use the Rule to generate a Report, Alert of Chart.

Save Clicking Save saves the rule that you are editing and the Build Rule panel

remains open. Before testing a rule, you must save it if you want to keep your

changes.

Reset Clicking Reset clears all the field information .

Test Rule

Clicking test rule opens the Test Rule dialog.

Test Rule Dialog

To access the Test Rule view:
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1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rule List panel, do one of the following:

l Select a rule and click   in the Rules toolbar.

l Click   > Edit.

The Build Rule view tab is displayed.

3. Click Test Rule.
The Test Rule view is displayed.

The following table describes the features in the Test Rule Dialog.

Feature Description

Data

Source

A drop-down list of data sources for the type of rule you are testing. Possible

data sources are: Concentrator, Broker, Decoder or Log Decoder.
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Feature Description

Format A drop-down list of the formats for displaying results for the rule. Possible

formats are: Tabular, Area, Bar, Bubble, Column, Line, Pie, Step Line, Step

Area, Spline Area, and Spline.

Time

Range A drop-down list of time range specification methods.

l Selecting Past allows you to specify a number of years, months, days, weeks,
or hours. For example, Hours, Days, Weeks, Months, or Years.

l Selecting Range allows you to specify a date range and time period. For
example, start date to end date.

In the user interface, the date or time displayed depends on the time zone profile
selected by the user.

Use rel-

ative time

calculation

Selecting this option calculates the time range relative to the current time.

X Axis

X-Axis and Y-Axis specify the metadata to be plotted in charts.
In the X-Axis drop-down list, the meta types for the Group by setting in the
rule are listed. You can select multiple meta types when the rule has a single
Group by setting.
For Custom Rules with multiple Group by values, you can select only the first
meta type for the  X-Axis.

Y Axis

In the Y-Axis drop-down list, the aggregate functions used in the rule are listed.
Sum, Count, Countdistinct and Average are the supported aggregate functions
for rules.
You can select one or more aggregate functions.
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Feature Description

Run Test Clicking Run Test executes a test of the rule last saved in the Rule Builder dia-

log. When the test is complete, the rule data (if any) for the selected time range

is displayed.

Meta Panel

The Meta panel provides a list of available meta types that you can use to build the rule. You
can use the meta types in the Select, Where, and Then clauses. The Reporting Engine maintains
an active list of the available meta names by continuously synchronizing with the data source to
which it is connected.

The following figure displays the Meta panel.

The following table describes the features in the Meta panel.

Operation Description

Choose Based on the rule type that you have selected, the available data sources are dis-

played in the drop-down list of the Meta panel. Select the required data source.

The available meta types for the data source are displayed. Select a meta.

Filter Filter the meta for a specific meta value.

Lists Panel

A List is a placeholder for a set of values that you can use in a meta or a variable. For example,
you can define a list with all the whitelisted event source IP addresses. Once the List is defined
then you can use the List name in the rule. This provides the flexibility of adding, modifying, and
deleting the list values.
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The Lists panel is a collection of Lists. The Reporting Engine maintains an active list of the
available list names by continuously synchronizing with the collection to which it is connected.

The following figure displays the Lists panel.

The following table describes the features in the Lists panel.

Operation Description

Import or Export a list.

If you select the NetWitness DB rule type, the options Where and Then are

displayed. Insert the list in the Where or Then clause in the rule.

If you select the IPDB rule type, the options Where and Event Source are dis-

played. Insert the list in the Where or Event Source clause in the rule.

If you select the Warehouse DB rule type, the option Where is displayed.

Insert the list in the Where clause in the rule.

Query Aggregates

This topic describes the scenarios for NWDB Query Aggregates. To use Query Aggregates an
understanding of Rule Syntax for NWDB is required. For more information, see NWDB Rule
Syntax.
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Supported Aggregate Functions

The following table lists the supported Aggregate Functions.

Aggregate
Function

Description
Input
data
types

Output
data
types

count Returns the count of meta values, which includes duplic-

ate values as well.

Numeric Numeric

countdistinct Returns the total number of distinct or unique values. Numeric Numeric

distinct Returns all the unique values. Any Any

first Returns the first occurrence of the meta value. Any Same as

input

last Returns the last occurrence of the meta value. Any Same as

input

sum Returns a sum of all non-NULL values of metaKey in a

group.

Numeric Numeric

avg (Aver-

age)

Returns the average value of all non-NULL values of

the metaKey within a group.

Numeric Numeric

min (Min-

imum)

Returns the minimum for all values of metaKey in each

group. This value is based on order by field.

Any Any

max (Max-

imum)

Returns the maximum for all values of metaKey in each

group. The maximum value is the value that is returned

by order by field.

Any Any

length Returns the length of the values of metakey. This is

called a "scalar function" in SQL.

Any Numeric
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Examples of Queries and Results per Function

Count

This function returns the number of values for a specified meta key, that exclude null values but
include duplicate ones. .

Example

The following figure shows a sample query for count function used for the destination IP and the
respective source IP.
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The following figure shows the result for the above query.
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Here, for each unique ip.src (source IP), the page returns the total number or count of ip.dst
(destination IP) values, which include the duplicate values as well.

Note: If your RSA Security Analytics is currently on 10.5 or newer version and any of the
Security Analytics Core devices are on 10.3 or 10.4 versions, then some of the aggregate
functions may display unexpected errors. However, aggregate functions such as sum() and
count() are supported in 10.4 version.

Countdistinct

The countdistinct function returns the count of unique or distinct values for the metakey. In other
words, countdistinct function can be used to retrieve a number of distinct values for the specified
metakey.

The following figure shows a sample query where the countdistinct function is used along with
IP source (ip.src) and data size(size).
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Example

The following figure shows the result for the above query.
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Here, the page displays the data size along with the total number or count of distinct filenames
from the respective IP source. Unlike the count function, the countdistinct excludes the duplicate
values from the result.

Distinct

This function returns all the unique or distinct values of the metakey.

Example

The following figure shows a sample query for distinct function used to retrieve e-mails,
between various source and destination IP (ip.dst).
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The following figure shows the result for the above query.
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Here, the page displays the the list of unique e-mails that were exchanged between the
respective IP source and destination.

First

This function is used to retrieve the first value from an ordered sequence of values for a
specified metakey.

Example

The following figure shows a sample query for first function used to retrieve the first destination
city name.
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The following figure shows the result for the above query.

465 Reporting Module References



Reporting Guide

Here, the page displays the the first destination city for the corresponding source and destination
IP. You can use the first function to isolate a particular value from a search result.

Last

This function is used to retrieve the last value from an ordered sequence of values for a
specified metakey.

Example

The following figure shows a sample query for last function used to retrieve the most recent user
name.
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The following figure shows the result for the above query.
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Here, the page displays the list of most recent or last usernames in full, that were exchanged
between the source and destination IP.

Sum

This function returns the total of the non-NULL values of the metaKey within a group.

Example

The following figure shows the query for the Sum function used for packets.
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The following figure shows the result of the above query.
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Here the page displays the total or sum of the packets along with the size of the data for the
respective destination country.

Avg

The average function returns the average of non-NULL values of the meta within a group.

Example

The following figure shows a sample query for average data size transmitted between a source
and destination IP.

Reporting Module References 470



Reporting Guide

The following figure shows the result for the above query.
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Here, the page displays the average size of data exchanged between source and destination IP:

Max and Min

Max and Min functions provide the maximum and minimum for given values of a meta
respectively.

The following figure shows a sample query for max and min functions for various data sizes, for
source IP and destination country.

Reporting Module References 472



Reporting Guide

Example

The following figure shows the result for the above query.
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Here, the page displays the max(size) and min(size) columns, along with the list of source IP
and destination country. The max(size) column lists the maximum data sizes exchanged while
the min(size) column lists the minimum data sizes that were exchanged.

Filter aggregate meta results with Max_threshold

You can further filter the results of any function by using the threshold rule action.

Example
Following is a sample query for max_threshold used along with the Max function in the Then
field is:
max_threshold(5000,max(size))

The following figure shows the Build Rule screen for the above query.
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Here the max_threshold is applied for data size with an upper limit of 5000. The following figure
shows the result.
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Here, the result page displays the max(size) column, that lists the data sizes lesser than 5000 as
this is the maximum threshold in the query, along with the corresponding IP source and the
respective directory.

Filter aggregate meta results withMin_threshold

Similarly, min_threshold is used to filter the results for any function. A similar scenario as max_
threshold is considered to explain this.

Example
Query for min_threshold used along with the Max function in the Then field is:
min_threshold(5000,max(size))

The following figure shows the Build Rule screen for the above query.
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Here the min_threshold is applied for data size with a lower limit of 5000. The following figure
shows the result.
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Here, the result page displays the max(size) column, that lists the data sizes greater than 5000 as
this is the minimum threshold in the query, along with the corresponding IP source and the
respective directory.

Note: Max_threshold and Min_threshold rule actions are common across all the functions, and
can be used along with the other queries in the Then field to retrieve the respective output.

Length

This function returns the length of a meta value. In other words, Length function returns the
number of bytes used to store the actual value.
For instance, for the value "Analytics" it returns the length as 9. Similarly, for an IPv4 ip.src, it
returns 4 (representing 4 bytes).

Example

The following figure shows a sample query for the length function used for usernames.
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The following figure shows the result for the above query.
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Here, the page displays the length of the usernames associated with the user account and their
respective source IP.

Additional Information

When you query for aggregates (E.g. sum(size)) with Group By on a meta which has multiple
values in a session, then the session with multiple values is accounted for aggregate calculation
for each value of that meta.

Example

When you query for the Count aggregate function with Group By on Alias.host and if the column
has multiple values in a session, then the session is counted for each occurrence, including the
duplicate values.

Consider the following table.

SessionID Alias.host Ip.src Size

1 host-a, host-b, host-a a 10

2 host-b, host-c, host-a, host-c c 20

3 host-b, host-c, host-d b 30

4 host-c, host-a a 40
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In the above table, alias.host for host-a and host-c has duplicate values listed for a single
session. Let us consider the following query:

Select : alias.host, count(ip.src), sum(size)
Group By : alias.host

Here, host-a and host-c are present in 3 sessions and they are duplicated for two different
sessions. However, the output is as shown below.

Alias.host count(Ip.src) Sum (size)

host-a 4 80

host-b 3 60

host-c 4 110

host-d 1 30

Output table shows that the count for host-a and host-c is 4. This is because for each alias.host
value, the entire session is considered. Similarly to calculate sum (size), the same sessions are
considered for each alias.host value.

In the report output if the number of rows has reached NWDB maximum aggregate rows
defined in RE configuration, then a message Max Aggregate Row Limit Reached is displayed
to indicate that there is more information to be displayed. The default limit is 1000, and you can
change this value as per your requirement, in the Reporting Engine Configuration page .
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In the report output if the number of rows has reached NWDB maximum aggregate rows defined
in RE configuration, then a message Max Aggregate Row Limit Reached is displayed to indicate
that there is more information to be displayed. The default limit is 1000, and you can change this
value as per your requirement, in the Reporting Engine Configuration page.

Rule Permissions Dialog

This topic describes the features of the Rules Permissions dialog.The Reporting module provides
access control at the rule level. Only a user who has the right set of permissions can perform
tasks on the rule. When creating user roles, the administrator must ensure that the roles created
for specific tasks have access to all the permissions higher in the hierarchy of roles.

Procedures related to this dialog are described in Manage Access for a Rule or Rule Group

The dialog has a different appearance for rule groups versus rules. To access the dialog:

1. In the Security Analytics menu, click Administration > Reports.
The Manage tab is displayed.

2. In the Rules list panel, select one or more rules or a rule group.

3. Click  > Permissions in the toolbar.

The Rules Permissions dialog is displayed.
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This figure shows the Rules Permissions dialog for a single rule.

This figure shows the Rules Permissions dialog when multiple rules are selected.
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Feature Description

Roles column

Lists the Security Analytics user roles, both built-in and custom roles.
Each user who is logged in to Security Analytics has user roles assigned.

When multiple rules are selected, the asterisk beside the role name, for
example, Security*, indicates there are other permissions available on
that user role. To change the other permissions, you must select the user
role and change the access permission.

Read & Write

column

When the checkbox in this column is selected, the corresponding user

role has permission to view, edit, delete, import, and export rules in the

Rules view. The user can also change the permission on the rule.

Read Only column When the checkbox in this column is selected, the corresponding user

role has permission to view the rules in the rule group.

No Access column When the checkbox in this column is selected, the corresponding user

role cannot view or edit the rules in the rule group.

Before applying rule permissions, this is the default permission set for all
the user roles though the checkbox is unchecked.

Apply these per-

missions to sub-

groups and Rules

in this group check-

box

When checked, Security Analytics applies permissions to sub-groups and
rules in the group.

Cancel option Clicking Cancel closes the dialog without saving any changes made.
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Feature Description

Save option Clicking Save closes the dialog and updates the rule group permissions

for user roles.

If specified, the access permissions are applied to subgroups and child
objects of this group. 

When multiple rules are selected, the access permission is applied to all
the selected rules.

Rule View

The Rule view is the user interface for managing rules. Associated procedures are under Define
Rule Groups and Rules, Manage Access for a Rule or Rule Group, Create a Chart Using a Rule, Create
a Report Using a Rule, and Create an Alert Using a Rule.

You can perform the following actions using the Rule view:

l Add a rule or rule group.

l Delete rules and rule groups.

l Set access permissions for rules and rule groups.

l Import rules and rule groups.

l Export rules and rule groups.

l Edit a rule.

l Duplicate a rule.

l Create an alert.

l Create a chart.

l Create a report.

l View dependents of a rule.

l Refresh the rules in a group.

l Change the group of a rule by dragging and dropping the rule on the new group in the Rule
Group panel.

To access the Rule view:

1. In the Security Analytics menu, click Reports.
The Manage tab is displayed.
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2. Click Rules.

The Rule view is displayed.

The Rule view includes the following panels:

l Rule Groups

l Rule List

l Rule Toolbar

Rule Groups Panel

The Rule Groups panel allows you to organize rules into groups using the options in the toolbar.
You can create groups and sub-groups and add rules to them. You can also group and move rules
between different groups. 

The following figure shows the groups in the Rule Groups panel:
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The following table describes the features in the Rule Groups Panel.

Feature Description

This option allows you to add a new rule group to the Reporting module.

This option allows you to delete one or more rule groups.

This option refreshes the rule group list.

The actions menu has the following options: Import, Export and Permissions.

All Displays a list of all the rule groups.

Rule Toolbar

The Rule toolbar allows you to add, delete, edit, and duplicate a rule. The following figure
shows the toolbar.

The following table describes the features in the Rule Toolbar
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Feature Description

This option allows you to add a new rule to the Reporting module.

This option allows you to delete one or more selected rules.

This option allows you to edit a rule.

This option allows you to duplicate a rule.

The actions menu has the following options: Use, Import, Export and Permissions.

This option allows you to select the rule type.

Rule List Panel

The following figure shows the list of rules in the Rule List panel.

The following table describes the features in the Rule List Panel.

Feature Description

Name Displays the name of the rule that you are created or edited.

Note: For the Name field, the icon to extend the column size is not displayed at
the end of the column field. You have to hover the mouse a little to the left side
to see the icon for extending the column.

Type Displays the supported database type for the rule you created. 
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Feature Description

Group Displays the values which are grouped.

Date

Modified

Displays the date when the rule was last modified.

Actions Displays the actions menu has the following options: Create Alert, Create Chart,

Create Report, Delete, Edit, Export, and Dependents.

IPDB Event Source Specification

This topic describes the IPDB event sources that you can specify. You can specify IPDB event
sources either using wildcards or by specifying the complete address of the event source. The
following table lists the supported IPDB event source specifications.

Event Source Description

*:*:*:*:* All domains, sites, nodes, Device

Types (Event Source Types) and event

source IP addresses. Security Ana-

lytics supports a single site wildcard

for domain and site. 

domain:site:*:*:* All nodes, device types, and event

source IP addresses for the specified

site.

domain:site:node:*:* All device types and event source IP

addresses for the specified node.

domain:site:node:devicetype:* All event source IP addresses for the

specified domain, site, node, and

device type.

domain:site:node:devicetype:event-source-address1,-

domain:site:node:devicetype:event-source-

address2,...domain:site:node:devicetype:event-

source-addressN.

Comma-separated list of event sources.
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Warehouse Database Rule Definition Modes

This topic describes Warehouse DB rule definition modes. You can generate reports of the
Warehouse data source by creating rules to query the data source. The rules can be defined in
two modes:

l Default Mode

l Expert Mode

Default Mode

In Default Mode, you can create rules containing simple SQL like HIVE queries that
contain clauses like Select, Where, Group By, and Having. By default, you can create rules to
query sessions or raw logs. For more information on Simple query syntax and examples, see All
Event Categories Report.

The following figure is an example of the Build Rule view that displays when you
select Warehouse DB for Rule Type without the Expert Mode selected.

Querying Raw Logs

The raw log format is used in the select or where clause to query for raw logs.
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Note: The time range that you can specify in your query is a day (24 hours). If you have
specified a time range less than a day in your query, the result set contains data of at least a
day (24 hours).

The following figure is an example of the Build Rule view that displays when you
select Warehouse DB for Rule Type and create a rule for querying raw logs.

Expert Mode

The following figure is an example of the Build Rule view that displays when you
select Warehouse DB for Rule Type with Expert Mode selected.
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If you want to generate a report for a specific time range, you need to manually define the time
range in the query using the following two variables:

l ${report_starttime} - The starting time of the range in seconds.

l ${report_endtime} - The ending time of the range in seconds.

For example, SELECT col1, col2 FROM custom_table WHERE timecol >= ${report_
starttime} AND timecol <= ${report_endtime};

Note: By default, Reporting Engine treats ${keyword} as a variable. If you want to specify
HIVE variables, you must mention the complete syntax of a variable. For example,
${hiveconf:hive.exec.scratchdir}.

Topics:

l General Syntax of an Advanced Rule

l All Event Categories Report
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